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3 1章　概要

本機の特長
新開発8.6K 36mm×24mmフルフ
レームCMOSイメージセンサーを搭載

（MPC‑3628）

MPC‑3628は、新開発36mm×24mmフルフ
レームの8.6K CMOSイメージセンサーを搭載
し、最大8640画素×5760画素で記録するこ
とが可能*です。イメージャーモードを切り替え
ることにより、標準的なSuper35mm 24.1mm
×12.7mmで、5792画素×3056画素はもち
ろんのこと、6:5アナモフィックに対応する
Super35mm 24.1mm×20.2mm、5792画素
×4854画素*をサポートします。8Kコンテンツ制
作のみならず、VFX合成でも効果を発揮し、また
8.6K画素からのオーバーサンプリングによる高画
質な4Kコンテンツ制作が可能です。
* フルフレームおよびアナモフィックモードは別売りライセ

ンスが必要です。

VENICE（MPC‑3610）と同じ6K 
36mm×24mmフルフレームCMOSイ
メージセンサーを搭載（MPC‑3626）

MPC‑3626は、VENICE（MPC‑3610）と同じセ
ンサーを搭載しており、最大6048画素×4032
画素の解像度でキャプチャーすることが可能*

で、イメージャーモードを切り替えることにより、
標準的なSuper35mm 24.3mm×12.8mm、
4096画素×2160画素（3パーフォレーションに相
当）はもちろんのこと、4:3アナモフィックに対応
するSuper35mm 24.3mm×18.3mm、4096
画素×3024画素（4パーフォレーションに相当）*を
サポートします。
* フルフレームおよびアナモフィックモードは別売りライセ

ンスが必要です。

2つのイメージセンサーを交換して運
用が可能

8.6Kイメージセンサーと6Kイメージセンサーは
システムの互換性を兼ね備えており、ユーザー
がイメージセンサーを取り外し交換して運用す
ることが可能です。またVENICE（MPC‑3610）
のイメージャーブロックも互換性をもち、
MPC‑3628/3626に装着して使用することが可
能です。

ワイドラチチュード

MPC‑3628は16ストップ、MPC‑3626は15ストッ
プ＋の広大なラチチュードを実現。ハイライト部
から暗部まで幅広い輝度条件の下で、低ノイズ
で美しい映像をキャプチャーすることができ、グ
レーディング作業において高い自由度をもたらし
ます。

広色域キャプチャーが可能

DCI‑P3を越える色域でのキャプチャーが可能
です。ソニーが定義するワイドカラースペース
S‑Gamut3とS‑Gamut3.Cineを搭載しS‑Log3
と一緒に活用することにより、グレーディング時
の自由度が飛躍的に向上します。

Dual Base ISO

2種類の基準感度を有しており、通常の照明下
ではLow側のBase ISO（MPC‑3628：ISO 800、
MPC‑3626：ISO 500）を、低照度の条件では、
High側のBase ISO（MPC‑3628：ISO 3200、
MPC‑3626：ISO 2500）を使用することにより、
ノイズ感を粗くせず、ハイライトとローライトの
ラチチュードバランスを保ったまま撮影が可能と
なります。

PLレンズマウント

標準でPLレンズマウントが装着されていま
す。レンズマウントはCooke /iに対応してお
り、レンズ情報はフレームごとにメタデータと
して記録されます。また、Cooke’s /i third 
generation metadata Technology, /i3と
ZEISS eXtended Data technologyに対応し、
レンズ歪やシェーディングメタデータを記録しま
す。

Eマウントレンズ対応

PLレンズアダプターを取り外すことにより、Eマウ
ントレンズが使用可能です。PLレンズと比較して
小型・軽量であり、またEマウントレンズの多彩
なラインナップにより更なる映像表現の幅を広げ
ます。

イメージャーブロックの延長

6Kイメージセンサーを搭載したMPC‑3626は、
カメラエクステンションシステムCBK‑3610XSを
接続することでイメージャーブロックを約2.7mま
たは約5.5mに延長することができ、より小型な
カメラヘッドブロックで撮影が可能です。

8ポジション光学式NDフィルター

8ポジション光学式NDフィルターを採用していま
す。0.3ND（1/2=1ストップ）から2.4ND（1/256=8
ストップ）の広範囲のNDを備えており、外部ND
フィルターを交換する手間を省きます。このND
フィルターはサーボ制御され、PCやタブレット、
RM/RCPコントローラーからも制御が可能です。

ハイフレームレート（HFR）撮影

8.6Kイメージセンサーは最大90FPS、6Kイメー
ジセンサーは最大120FPSでのX‑OCN記録が可
能です。

X‑OCNと4K ProResの2つのレコー
ディングフォーマット

標準レコーディングフォーマットとして、16ビット
X‑OCNまたは4K ProResをAXSメモリーカード
に収録することができます。X‑OCNは、すでに
多くのNLEやグレーディングツールでネイティブ
に扱うことができるフォーマットであり、各イメー
ジセンサー、各モードの解像度をそのまま記録
します。4K ProResは、4Kビデオフォーマットと
して広く普及しており、各イメージセンサー、各
モードで撮像した映像を4K ProResにオーバー
サンプリング*して記録します。
* 6Kイメージセンサー（MPC‑3626）において4K 17:9、

4K 16:9、4K 2.39:1イメージャーモード時は4K撮像し
た映像をそのまま記録します。

コンパクトなボディと直感的な操作感

ソニー独自の小型化技術によりフルフレーム大型
イメージセンサーを搭載しながらコンパクトなサ
イズを実現しており、狭いスペースでの撮影やド
ローン搭載時の利便性を向上させています。操
作ボタンは直観的な操作を実現するために場所、
形状、サイズを徹底的に検討して配置されてお
り、また暗所撮影を考慮しバックライトを備えて
います。

高い堅牢性

筐体は高い堅牢性を誇るマグネシウム合金製。
吸排気機構はすべての電子部品から完全に隔離



1章　概要：本機の特長4

されていて、砂や埃、水滴の侵入を防ぎます*。
静粛性に優れたファンは取り外し可能で清掃する
ことができ、過酷な映画制作の現場で高い可用
性を保つことができます。
* 防塵・防滴に配慮された構造になっていますが埃や水滴

の侵入を完全に防ぐものではありません。

モジュラー構造

撮影用途に合わせさまざまなリグや周辺機器と
の組み合わせに柔軟に対応することができます。
レンズとのバランスや使いかたに合わせて、トッ
プハンドルとビューファインダーは簡単に調整で
きます。

現場での運用を考えた、シンプルで直
感的なメニュー操作

メニュー画面をカメラの両側に、メイン操作部は
カメラのアシスタントサイドに配置しています。こ
れにより撮影現場でカメラアシスタントが設定操
作をすばやく行うことができます。オペレーター
サイドの有機ELミニディスプレイは、NDポジショ
ン、シャッター、ホワイトバランス、EI値、FPSなど、
頻繁に使う設定を簡単に操作でき、またカメラオ
ペレーターの方がステータスを確認するのにも便
利です。

RM/RCPおよび本機からのペイントコ
ントロールに対応

本機は、ブロードキャストカムコーダーやシステ
ムカメラで使用可能なRM/RCPリモートコント
ロールユニットからの制御にも対応しています。
各種ペイント項目の調整も可能です。また、本
機のフルメニューからペイントコントロールの操
作が可能です。

有効画サイズについて

本機では、以下の有効画サイズでの撮影が可能です。

MPC‑3628

[ご注意]
8.6K 3:2、8.2K 17:9、7.6K 16:9および5.8K 6:5で撮影するためにはソフトウェアライセンスが必要です。

8.6K 3:2 

5.8K 6:5

5.8K 17:9

5.4K 16:9 

7.6K 16:9

8.2K 17:9
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MPC‑3626

[ご注意]
6K 3:2、6K 1.85:1、6K 17:9、6K 2.39:1、5.7K 16:9、4K 6:5、4K 4:3および4K 4:3 Surround Viewで撮影するために
はソフトウェアライセンスが必要です。

6K 3:2

6K 1.85:1

6K 17:9

4K 6:5

4K 4:3

6K 2.39:1

4K 2.39:1

4K 17:9
(DCI 4K)

3.8K 16:9
(Ultra HD)

5.7K 16:9

ソフトウェアライセンスについて

本機の運用状況に応じてソフトウェアライセンス（別売り）を選択できます。
ソフトウェアライセンスのインストールは、フルメニューのMaintenance > License Options（94
ページ）にて行います。

MPC‑3628

ソフトウェアライセンス イメージャー
モード

有効画素 
（撮像画素）

W x H (mm) プロジェクトフレームレート

フルフレームライセンス1) 8.6K 3:2 8640 x 5760 35.9 x 24.0 23、24、25、29
8.2K 17:9 8192 x 4320 34.1 x 18.0 23、24、25、29、47、50、

59
7.6K 16:9 7680 x 4320 32.0 x 18.0 23、24、25、29、50、59

アナモフィックライセンス 5.8K 6:5 5792 x 4854 24.1 x 20.2 23、24、25、29、47
ライセンス不要1) 5.8K 17:9 5792 x 3056 24.1 x 12.7 23、24、25、29、47、50、

59
5.4K 16:9 5434 x 3056 22.6 x 12.7 23、24、25、29、50、59

1） Off(1.0x)以外のデスクイーズ機能を有効にするには、アナモフィックライセンスが必要です。
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MPC‑3626

ソフトウェアライセンス イメージャー
モード

有効画素 
（撮像画素）

W x H (mm) プロジェクトフレームレート

フルフレームライセンス1) 6K 3:2 6048 x 4032 35.9 x 24.0 23、24、25、29、47、50、
59

6K 1.85:1 6054 x 3272 36.0 x 19.4 23、24、25、29、47、50、
59

6K 17:9 6054 x 3192 36.0 x 19.0 23、24、25、29、47、50、
59

6K 2.39:1 6048 x 2534 35.9 x 15.0 23、24、25、29、47、50、
59

5.7K 16:9 5674 x 3192 33.7 x 18.9 23、24、25、29、50、59
アナモフィックライセンス 4K 6:5 4096 x 3432 24.3 x 20.4 23、24、25、29、47、50、

59
4K 4:3 4096 x 3024 24.3 x 18.0 23、24、25、29、47、50、

59
4K 4:3 
Surround 
View

4096 x 3024
(4552 x 3360)

24.3 x 18.0
(27.0 x 20.0)

23、24、25、29

ライセンス不要1) 4K 17:9 4096 x 2160 24.3 x 12.8 23、24、25、29、47、50、
59

4K 17:9 
Surround 
View

4096 x 2160
(4552 x 2400)

24.3 x 12.8
(27.0 x 14.3)

23、24、25、29

4K 2.39:1 4096 x 1716 24.3 x 10.3 23、24、25、29、47、50、
59

3.8K 16:9 3840 x 2160 22.8 x 12.8 23、24、25、29、50、59
3.8K 16:9 
Surround 
View

3840 x 2160
(4268 x 
2400)

22.8 x 12.8
(25.4 x 14.3)

23、24、25、29

1） Off(1.0x)以外のデスクイーズ機能を有効にするには、アナモフィックライセンスが必要です。

使用可能な撮像フレームレートとDe‑Squeeze値について

各イメージャーモードで使用可能な撮像フレームレートとDe‑Squeeze値（74ページ）は以下のと
おりです。

［ご注意］
下記は、ビデオフォーマットがX‑OCNの場合に使用可能な撮像フレームレートです。ProResの場合は、使用可能な最大
撮像フレームレートが異なります（45ページ）。

フルフレームライセンス アナモフィックライセンス

MPC‑3628

イメージャーモード 撮像フレームレート De‑Squeeze
Off(1.0x) 1.25x 1.3x 1.5x 1.65x 1.8x 2.0x

8.6K 3:2 1 ～ 30 ○ ○ ○ ○ ○ ○ ○
8.2K 17:9 1 ～ 60 ○ ○ ○ ― ○ ○ ○
7.6K 16:9 1 ～ 60 ○ ― ― ― ― ― ―
5.8K 6:5 1 ～ 48 ○ ― ― ― ― ― ○
5.8K 17:9 1 ～ 60、66、72、75、88、90 ○ ○ ○ ― ○ ○ ○
5.4K 16:9 1 ～ 60、66、72、75、88、90 ○ ― ― ― ― ― ―
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MPC‑3626

イメージャーモード 撮像フレームレート De‑Squeeze 
Off(1.0x) 1.25x 1.3x 1.5x 1.65x 1.8x 2.0x

6K 3:2 1 ～ 60 ○ ○ ○ ○ ○ ○ ○
6K 1.85:1 1 ～ 60、66、72 ○ ― ― ― ― ― ―
6K 17:9 1 ～ 60、66、72 ○ ○ ○ ― ○ ○ ○
6K 2.39:1 1 ～ 60、66、72、75、88、

90
○ ― ― ― ― ― ―

5.7K 16:9 1 ～ 60、66、72 ○ ― ― ― ― ― ―
4K 6:5 1 ～ 60、66、72 ○ ― ― ― ― ― ○
4K 4:3 Surround 1 ～ 30 ○ ― ○ ― ○ ○ ○
4K 4:3 1 ～ 60、66、72、75 ○ ― ○ ― ○ ○ ○
4K 17:9 Surround 1 ～ 48 ○ ○ ○ ― ○ ○ ○
4K 17:9 1 ～ 60、66、72、75、88、

90、96、100、110
○ ○ ○ ― ○ ○ ○

4K 2.39:1 1 ～ 60、66、72、75、88、
90、96、100、110、120

○ ― ― ― ― ― ―

3.8K 16:9 
Surround

1 ～ 48 ○ ― ― ― ― ― ―

3.8K 16:9 1 ～ 60、66、72、75、88、
90、96、100、110

○ ― ― ― ― ― ―

Surround Viewについて（MPC‑3626）

以下のイメージャーモードにおいて、有効画サイズの上下左右5％外側領域も含めた画像領域をビュー
ファインダーおよびSDIモニター出力で確認しながら撮影できるモードです。記録領域は外側領域を含
みません。
4K 4:3
4K 17:9
3.8K 16:9

［ご注意］
• 本モードでは、プロジェクトフレームレートの上限設定に制限がかかる場合があります。
• 4K 4:3モードのデスクイーズ倍率が2.0xの場合は、上下5％外側領域のみを含む画像領域となります。
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システム構成例

* 6Kイメージセンサーのみ対応

MPC‑3628/
MPC‑3626

ショルダーアダプター 
VCT‑FSA5

ビューファインダー 
DVF‑EL200

（VFケーブルA‑2203‑745‑A（本機に
付属）または1‑912‑598‑21が必要）

マイクロホン 
ECM‑680S、ECM‑678、 
ECM‑674（EC‑0.5X3F5Mが必要）

マイクホルダーベースASSY（A‑2182‑620‑B）
ロッドクランプ（A‑2182‑621‑B）
ロッド（4‑684‑612‑01）
マイクホルダー ASSY（X‑2596‑733‑2）
ネジ P2.6×8（2本）（7‑627‑556‑98）

バッテリーパック 
BP‑GL95B

S35 PL レンズ 
SCL‑PK6 
SCL‑P11X15

アナモフィック 
ライセンス 
CBKZ‑3620A 
CBKZ‑3620AM 
CBKZ‑3620AW

フルフレーム 
ライセンス 
CBKZ‑3620F 
CBKZ‑3620FM 
CBKZ‑3620FW

アナモフィックレンズ
（PLマウント/Eマウント）

カメラエクステンションシステム 
CBK‑3610XS*

5GHz/2.4GHzワイヤレスLAN
アダプター 
CBK‑WA02

フルフレームレンズ
（PLマウント/Eマウント）

Eマウントレンズ 
SELP28135G、SEL1224GM、SEL1635GM、SEL2470GM、SEL70200GM、SEL100400GM、
SEL24F14GM、SEL35F14GM、SEL50F12GM、SEL85F14GM、SEL100F28GM

AXSメモリーカード 
AXS‑A512S24、 
AXS‑A512S48、 
AXS‑A1TS48、 
AXS‑A1TS66

AXSメモリー 
カードリーダー 
AXS‑AR3

リモートコントロールユニット 
RM‑B170/B750 
RCP‑1000/1500/1530/3100/3500 
RCP‑1001/1501/3501
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各部の名称と働き
オペレーターサイド

吸気口

53

8 7910111213

15

16

14

1 2 4

6

吸気口
AXSメモリーカード 
スロット部（10ページ）

［ご注意］
吸気口をふさいだ運用はしないでください。

1.	 ASSIGN	1/2（アサイナブル1/2）ボタン	
（49ページ）

ユーザー機能画面のEDITページで機能を割り当
てます（49ページ）。
押すたびに、割り当てられた機能のオン（有効）と
オフ（無効）を切り換えたり、割り当てられた機能
を起動したりできます。

2.	 ASSIGN	1/2（アサイナブル1/2）ランプ	
（49ページ）

割り当てられた機能がオン（有効）または起動して
いる場合はオレンジ色に点灯し、オフ（無効）ま
たは停止している場合は消灯します。

3.	 内蔵スピーカー
撮像、記録中は収録音を、再生中は再生音をモ
ニターできます。警告ランプや警告表示の点滅・
点灯に合わせて警告音も聞こえます（97ペー
ジ）。
なお、ヘッドホン端子にイヤホンをつなぐと、内
蔵スピーカーからは音が聞こえなくなります。

［ご注意］
内蔵スピーカーから内蔵マイクの収録音が聞こえる設定の
場合は、モニター音量を大きくするとハウリングを起こす
ことがあります。

4.	ミニディスプレイITEMキー1～3
ミニディスプレイで機能の操作を行います（98
ページ）。

5.	 ミニディスプレイ
シャッター開角度などの各種設定を確認・変更
できます（98ページ）。

6.	ACCESSランプ	SLOT(A)/(B)
AXSカードスロットA/Bの記録メディアが記録、
再生の対象となっているとき、およびAXSカード
スロットA/Bの記録メディアに対して書き込みや
読み出しが行われているときに点灯します（26
ページ）。

7.	 CLIPSボタン
押すとミニディスプレイにクリップ画面が表示さ
れ、クリップ操作を有効にします（101ページ）。
同時にサブディスプレイにもクリップリスト画面
が表示され、クリップ操作が可能になります。
再生状態から撮影モードにする場合はHOMEボ
タンを押します。

8.	SLOT	SELECT（AXSメモリーカード選択）ボ
タン

ボタンを押すことで、アクティブなスロットを切
り換えることができます。

9.	電源スイッチ
電源を入れるときは（ON）の位置にします。電源
を切るときは（OFF）の位置にします。

［ご注意］
• 本機は、電源スイッチをOFFにした状態でも、わずかに

待機電力を消費します。本機を長時間使用しないときは、
バッテリーパックを取り外してください。

• バッテリーパックやDC IN電源は、電源スイッチをOFF
にしてから取り外してください。記録中やメモリーカード
アクセス中に電源を遮断すると故障の原因となることが
あります。

10.	HOMEボタン
押すとミニディスプレイ上のアイテム選択表示は
クリアされ、ホーム画面が表示されます。
本機が再生状態のときに押すと、記録操作が可
能な状態になります（98ページ）。

11.	 LOCKスイッチ
オペレーターサイドのボタン操作をロックします。
ロックするとスイッチ背面のLEDがオレンジ色に
点灯します。

12.	ヘッドホン端子（ステレオミニジャック）
音声モニター用のイヤホンを接続します。撮像、
記録中は収録音を、再生中は再生音をモニター
できます（97ページ）。

［ご注意］
• イヤホンはモノラル（2極）またはステレオ（3極）タイプを

使用してください。それ以外を使用すると本機が故障す
ることがあります。

• インピーダンス16Ωのイヤホンを使用してください。

13.	REC	ACTIVEランプ
RECボタンが有効な状態のときに緑色に点灯し
ます。

14.	ASSIGN	3（アサイナブル3）ランプ	
（49ページ）

割り当てられた機能がオン（有効）または起動して
いる場合はオレンジ色に点灯し、オフ（無効）ま
たは停止している場合は消灯します。

15.	REC（記録開始／記録停止）ボタン／ランプ
押すと記録が始まりRECランプが点灯し、もう一
度押すと記録が停止し、RECランプが消灯します

（109ページ）。
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また、機器のエラーやワーニングをRECランプを
点滅させて表示します。

16.	Φ（ファイ）マーク
Φ（ファイ）マークがイメージセンサー面の位置に
なります。
本機から被写体までの距離を正確に測るには、
このマークの位置を参考にしてください。

AXSメモリーカードスロット部 
（26ページ）

AXSメモリーカードスロットはカバー内にありま
す。

1

1.	 AXSメモリーカードスロットA/B

アシスタントサイド

1 2 3 4

6

5

7

8

9

1011

12

13

14
15

16

17

18

19
1 2 3

4 5 6

排気口

1.	 ASSIGN	4（アサイナブル4）ボタン	
（49ページ）

ユーザー機能画面のEDITページで機能を割り当
てます（49ページ）。
押すたびに、割り当てられた機能のオン（有効）と
オフ（無効）を切り換えたり、割り当てられた機能
を起動したりできます。

2.	 ASSIGN	4（アサイナブル4）ランプ	
（49ページ）

割り当てられた機能がオン（有効）または起動して
いる場合はオレンジ色に点灯し、オフ（無効）ま
たは停止している場合は消灯します。

3.	 サブディスプレイ
本機の動作状態の確認や各種設定ができます

（36ページ）。
ホーム画面が表示されている状態でBACKボタン

（11ページ）を押しながらMENUダイヤルを回
すことで、サブディスプレイとミニディスプレイの
明るさを調整することができます。
フルメニューのTechnical > Panel Control > 
Brightness levelでも調整できます（91ページ）。

4.	サブディスプレイITEMキー1～ 6
サブディスプレイで機能の操作を行います

（55ページ）。

5.	 メジャーフック
メジャーフックがイメージセンサー面の位置とな
ります。本機から被写体までの距離を正確に測
るには、メジャーフックの位置を参考にしてくだ
さい。メジャーフックにメジャーの先端をかけて、
被写体からの距離を実測できます。

6.	HOMEボタン
押すとサブディスプレイ上の表示はクリアされ、
ホーム画面が表示されます（38ページ）。
本機が再生状態のときに押すと、記録操作が可
能な状態になります。

7.	 MENU（メニュー表示ON/OFF）ボタン
（55、66ページ）

MENUボタンを押すと、サブディスプレイにメ
ニュー画面が表示されます。MENUボタンを2秒
以上押し続けると、フルメニュー画面がサブディ
スプレイに表示されます。
また、MENUダイヤルと共にMENUボタン押すこ
とにより、すばやくフルメニュー画面を表示する
ことができます。
メニュー画面、フルメニュー画面のときに押すと
元の画面に戻ります。

8.	SEL/SET（選択／確定）ダイヤル（MENUダイ
ヤル）

各メニュー内の項目選択や設定値の変更をするとき
に使います（38、55、66ページ）。

9.	 +48V	Powerランプ
AUDIO INスイッチをMICに設定した場合に、
AUDIO IN端子への+48Vファントム電源を供給
しているときは、緑に点灯します。供給していな
いときは消灯します。
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+48Vファントム電源の重畳のOn/Offは、メ
ニューのAudioカテゴリー > Audio Details 
> Audio Configuration > Phantom Power 
+48Vで設定できます（86ページ）。

10.	AUDIO	IN（オーディオ入力切り換え）スイッチ
AUDIO IN端子に入力される音声の音源に合わ
せて入力信号を切り換えます。
LINE：外部のアナログオーディオ信号源を接続

する場合 
AES/EBU：外部のデジタルオーディオ信号源を

接続する場合
MIC：マイクを接続する場合

11.	 AUDIO	IN端子（XLR	5ピン）
外部マイクや外部オーディオ機器などの信号を入
力します。
AUDIO INスイッチで音源をLINEまたはMICに設
定しているときは、AUDIO IN CH‑1端子、およ
びAUDIO IN CH‑2端子として機能します。
AUDIO INスイッチで音源をAES/EBUに設定し
ているときは、AUDIO IN CH‑1/2端子、および
AUDIO IN CH‑3/4端子として機能します。

12.	BACKボタン
メニュー表示中は、メニューのキャンセルやメ
ニュー階層を1つ上に戻します。実行中表示ま
たは実行指示待ち表示のときは、実行中または
実行指示待ち表示中の処理をキャンセルします

（38、55、66ページ）。

13.	 LOCKスイッチ
アシスタントサイドのボタン操作をロックします。
ロックするとスイッチ背面のLEDがオレンジ色に
点灯します。

14.	ACCESS（SDカードアクセス）ランプ（34
ページ）

15.	REC	ACTIVEランプ
RECボタンが有効な状態のときに緑色に点灯し
ます。

16.	REC（記録開始／記録停止）ボタン／ランプ
押すと記録が始まりRECランプが点灯し、もう一
度押すと記録が停止し、RECランプが消灯します

（109ページ）。
また、機器のエラーやワーニングをRECランプを
点滅させて表示します。

17.	 CLIPSボタン
押すとサブディスプレイにクリップリスト画面が
表示され、クリップ操作を有効にします（95
ページ）。
同時にミニディスプレイにもクリップ画面が表示
されます。
再生状態から撮影モードにする場合はHOMEボ
タンを押します。

18.	USERボタン
押すとサブディスプレイにユーザー機能リストが
表示され、ITEMキー 1 ～ 5がユーザー機能ボタ
ンとなります。
ITEMキー 6はユーザー機能リストのEDITボタン
です。このボタンを押すと、ユーザー機能ボタン
とアサイナブルボタンの機能選択画面が表示さ
れます。ユーザー機能画面状態で押すと元の画
面に戻ります。（49ページ）。

19.	内蔵マイク
音声を収録できます。
Audioメニュー > Audio InputのInternal Mic 
Select（86ページ）で内蔵マイクの入力チャン
ネルを選択できます。

フロント（前面）

1

23

4

5

1.	 ASSIGN	3（アサイナブル3）ボタン	
（49ページ）

ユーザー機能画面のEDITページで機能を割り当
てます（49ページ）。
押すたびに、割り当てられた機能のオン（有効）
とオフ（無効）を切り換えたり、割り当てられた機
能を起動したりできます。

2.	 PLレンズマウントアダプター（21ページ）

3.	 VF（ビューファインダー出力）端子（24ペー
ジ）

4.	 LENS（レンズ接続用）端子（12ピン）
ネットワーク接続されたコンピューターやスマー
トフォン、タブレットよりアイリス、フォーカスお
よびズーム制御が可能です。

5.	 24V	OUT端子（24	V	DC出力、Fischer	3ピ
ン）

24V DC電源出力用端子です（123ページ）。
本機に入力する電圧によって、この端子から出力
する電圧と出力最大電流が異なります。最大電
流は、本機リア（後面）の24V OUT端子（12ペー
ジ）との合計となります。
11	V～ 17	V入力時
出力電圧：24 V
出力最大電流：1.0 A
22	V～ 32	V入力時
出力電圧：入力電圧と同じ
出力最大電流：2.0 A
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リア（後面）

2

1

3

4

5

6

7

8

9

10

11

12

13
14

吸気口

［ご注意］
吸気口をふさいだ運用はしないでください。

1.	 24V	OUT端子（24	V	DC出力、Fischer	3ピ
ン）

24V DC電源出力用端子です（123ページ）。
本機に入力する電圧によって、この端子から出力
する電圧と出力最大電流が異なります。最大電
流は、本機フロント（前面）の24V OUT端子（11
ページ）との合計となります。
11	V～ 17	V入力時
出力電圧：24 V
出力最大電流：1.0 A
22	V～ 32	V入力時
出力電圧：入力電圧と同じ
出力最大電流：2.0 A

2.	 12V	OUT端子（12	V	DC出力、Lemo2ピン）
12V DC電源出力用端子です（123ページ）。

本機に入力する電圧によって、この端子から出力
する電圧と出力最大電流が異なります。
11	V～ 17	V入力時
出力電圧：入力電圧と同じ
出力最大電流：1.0 A
22	V～ 32	V入力時
出力電圧：16.8 V
出力最大電流：1.0 A

3.	 MONITOR	OUT端子（BNC型）
HD SDIモニター信号を出力する端子です（123
ページ）。

4.	GENLOCK（ゲンロック入力）端子（BNC型）
外部から本機にゲンロックをかけるとき、または
本機のタイムコードを外部ロックさせるとき、基
準信号を入力する端子です。

デジタル信号とアナログ信号を入力できます。
デジタル信号：1.5G HDSDI Interlace/
Progressive信号
アナログ信号：HD sync、SD sync

5.	 TC	IN(タイムコード入力)端子（BNC型）
本機のタイムコードを外部ロックさせるとき、基
準となるタイムコード信号を入力する端子です。

6.	AUX端子（BNC型）
タイムコード信号を出力する端子です（123ペー
ジ）。

7.	 ネットワーク端子（RJ-45）
LANケーブル（別売り）を接続することで、有線
LAN接続により、本機をリモートコントロールで
きます（102ページ）。

8.	REMOTE（リモートコントロール）端子	
（8ピン）

リモートコントロールユニットなどの外部コント
ロール機器を接続します。

9.	 12V/24V	（DC電源入力）端子（17ページ）
本機に外部電源を供給するためのDC電源入力
端子です。入力電圧は12Vと24Vに対応していま
す。

No. 信号
1 GND
2 NC
3 NC
4 DC IN（11V ～ 17V または 22V ～ 32V）

10.	バッテリー取り付け端子（17ページ）

11.	 SDI	OUT	1 ～ 4（シリアルデジタル出力）端子
（BNC型）（123ページ）

12.	バッテリーパック取り付け部（17ページ）

13.	バッテリーリリースレバー（17ページ）

14.	HDMI	OUT端子（123ページ）
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トップ（上面）

2 3 41 5

1.	 外部機器接続端子
ワイヤレスLANアダプター CBK‑WA02（別売り）
を接続することで、カメラワイヤレスリモートコン
トロールする（102ページ）際に使用します。

2.	製造調整用端子
製造調整、サービス専用端子です。 
(使用できません)

3.	 リリースボタン（20ページ）

4.	ハンドル/VFアタッチメント取り付け部
（20ページ）

5.	 アクセサリー取り付けねじ穴
ネジ種：1/4‑20UNC（×8）
ネジ種：3/8‑16UNC（×10）
ネジ勘合長：10 mm 以下

ボトム（底面）

2

1

排気口

1.	 三脚プレート取り付け穴
ネジ種：1/4‑20UNC（×2）
ネジ種：3/8‑16UNC（×4）
ネジ勘合長：9 mm 以下

2.	 SDカードスロット（34ページ）
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ビューファインダー・モニター画面

撮影中（記録中／記録待機中）および再生中は、Monitoringメニュー > Overlays/Frame Lineの
Overlay A/B Setup（81ページ）で選択された情報が表示されます。

撮影中の画像に表示される情報

29

1 2 3 64 5 7 8

22232526 242728

10
9

11

14
15
16
17
18
19

21

12 13

20

35

30
31
32

34
33

36

37

1.	 撮影フレームレート設定表示
撮影フレームレートとプロジェクトフレームレート
が表示されます。

2.	シャッター開角度／スピード表示
Technicalメニュー > System Configuration

（89ページ）の設定に従って、電子シャッター
の開角度またはスピードが表示されます。

3.	 NDフィルター表示
NDフィルターの濃度が表示されます。表示値は
LOG指標値です。（68ページ）。
CLEAR
0.3（1/2）
0.6（1/4）

0.9（1/8）
1.2（1/16）
1.5（1/32）
1.8（1/64）
2.1（1/128）
2.4（1/256）

4.	温度計アイコン
温度上昇に関する警告メッセージがあるときに表
示されます。
メニューのInfoカテゴリーに内容が表示されま
す。

5.	 警告アイコン
温度上昇を除く警告メッセージがあるときに表示
されます。
メニューのInfoカテゴリーに内容が表示されま
す。

6.	感度（Exposure	Index）／ゲイン表示
EI値またはRM‑B170などのリモートコントロール
ユニットで設定したゲイン値（dB単位）が表示さ
れます。

［ご注意］
ゲイン値は、Technicalメニュー > Special 
Configuration > RM/RCP Paint Control（93ページ）
がOnに設定されている場合のみ表示されます。

7.	 色温度表示
ホワイトバランスの色温度とTint値が表示されま
す。

8.	バッテリー残量／電圧表示
本機を駆動している電源の種類に応じて次のよう
に表示されます。

電源の種類 表示
インフォバッテリー バッテリー残量と記録可能

な残り時間
アントンバウアー社
製バッテリー

バッテリー残量（%表示）

その他の電源 入力電圧

9.	タイムコード外部ロック／ゲンロック状態表
示

タイムコードが外部ロックすると、ロック状態で
あることが表示されます。ゲンロックがかかって
いる場合、ロック状態であることが表示されます。

10.	VF	LUT表示
ビューファインダーのLUTが表示されます（72
ページ）。

11.	 VF	Double	Speed	Scan表示
ビューファインダー表示のフレームレートを倍速
にする機能の有効／無効状態が表示されます。

12.	VF	Peaking表示
ビューファインダー表示のピーキング機能の有効
／無効状態が表示されます。

13.	VF	Zebra表示
ビューファインダー表示のゼブラ機能の有効／無
効状態が表示されます（53ページ）。

14.	SDI	OUT	1/2端子	LUT表示
SDI OUT 1/2端子のLUT設定が表示されます

（70ページ）。

15.	SDI	OUT	3/4端子	LUT表示
SDI OUT 3/4端子のLUT設定が表示されます

（71ページ）。

16.	Monitor	LUT表示
Monitor出力のLUT設定が表示されます（71
ページ）。

17.	 HDMI	LUT表示
HDMI出力のLUT設定が表示されます（72
ページ）。
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18.	SDI出力RECトリガー表示
SDI出力のRECトリガーの状態が表示されます。

条件 表示
フルメニューのTechnical > System Configuration >  
SDI Rec Remote Trigger

SDI出力への 
記録コマンドの重畳

Off － （空欄）
HD SDI Remote I/F Stopコマンド送信 上段：SDI

下段：Stop
Recコマンド送信 上段：SDI

下段：REC
Parallel Rec Stopコマンド送信 上段：SDI‑P

下段：Stop
Recコマンド送信 上段：SDI‑P

下段：REC

19.	ネットワーク接続状態表示
ネットワークの接続状態（LANまたはWi‑Fi）が表
示されます。

条件 表示
ネットワーク接続設定状態で接続断など
のエラー時

点滅

ネットワーク接続設定状態で接続時 点灯
ネットワーク接続機能を使用していない 空欄

20.	High	Key/Low	Key表示（Monitor出力）
Monitor出力がHigh Key（高輝度の白飛び確認
画面）、またはLow Key（低輝度の暗部の確認画
面）であることを表示します（Monitor Out出力
の場合に表示）。

21.	オーディオレベルメーター表示
撮影中の音声チャンネル1、2のレベルが表示さ
れます。

22.	各メディアスロットの記録メディア状態／残
量表示

AXSメモリーカードスロットA/B内のメディアの
状態と残量が表示されます。

AXSの左に （記録アクティブ）アイコンがある：
記録対象メディア
AXSの右のスロットA/Bアイコン右上の緑ランプ
点灯時 （アクティブスロット）アイコン：再生
対象メディア（ランプが点灯している方のメディア
を再生）
また、記録に影響のあるメディアに対しては （警
告）アイコンが表示されます。

23.	水準器グラフィカル表示
本機の水平方向の傾きが±0.1°刻みで±10°まで
表示されます。
Technicalメニュー > Special Configuration > 
Level Gauge Adjust（89ページ）を実行する
と、水準器のゼロ調整を行うことができます。

24.	クリップ名表示
記録待機中は、次に記録されるクリップに付けら
れるクリップ名の前8文字が表示されます。
記録中は、記録中のクリップに付けられるクリッ
プ名の前8文字が表示されます。

25.	記録動作状態表示
本機の記録動作状態が次のように表示されます。

表示 説明

● Rec  （Rec） 記録中

 Stby  （Stby） 記録待機中

● Cache  （Cache） ピクチャーキャッシュ
レック記録待機中

 CALL  （CALL） CALLコマンド受信中

Monitoringメニュー > Overlays/Frame Line
のVF、SDI 1/2、SDI 3/4、Monitor、HDMIの
Overlay設定（81ページ）をRec Ind.にすると、
設定した出力先の映像情報表示を記録動作状態
表示のみにすることができます。

26.	Look情報表示
選択したLookが表示されます（69ページ）。

27.	High	Key/Low	Key表示（ビューファイン
ダー出力）

ビューファインダー出力がHigh Key（高輝度の白
飛び確認画面）、またはLow Key（低輝度の暗部
の確認画面）であることを表示します（ビューファ
インダー出力の場合に表示）。

28.	タイムデータ表示
メニューのTC/Mediaカテゴリー > TC Display
の設定に従って、デュレーションまたはタイムコー
ドが表示されます（57ページ）。

29.	アイリスポジション表示
アイリスの位置が表示されます。（アイリス設定
表示対応レンズ装着時のみ） 
Eマウントレンズ使用時のアイリス表示値は
1/3stop刻みとなります。

［ご注意］
T値が取得できない場合など、T値ではなくF値が表示され
る場合があります。

30.	フォーカスポジション表示
フォーカスの位置を表示します。（フォーカス設
定表示対応レンズ装着時のみ）

31.	ズームポジション表示
ズームの焦点距離が表示されます。（ズーム設定
表示対応レンズ装着時のみ）

32.	水準器表示
水準器の情報が数値で表示されます。
R（Roll）は本機の水平方向の傾きです。
T（Tilt）は本機の上下方向の傾きです。
Technicalメニュー > Special Configuration > 
Level Gauge Adjust（89ページ）を実行する
と、水準器のゼロ調整を行うことができます。

33.	記録LUT表示
記録のLUT設定が表示されます。

34.	記録メディアフォーマット（コーデック）表示
AXSメモリーカードに記録されるフォーマット名
称が表示されます。

35.	Base	ISO表示
設定された基準感度が表示されます。

36.	有効画サイズ表示
メニューのProjectカテゴリー > Imager Mode
の設定に従って、有効撮像画サイズとデアナモ
変換の有無が表示されます。Surround View
モードの場合は、デアナモ変換倍率アイコンの下
にSur.Vアイコンが表示されます（56ページ）。
メニューのProjectカテゴリー > Zoom to Fit

（57ページ）が17:9の場合は、Z 17:9アイコン
が表示されます。Zoom to Fitが16:9の場合は、
Z 16:9アイコンが表示されます。

37.	Camera	ID表示
Camera IDの設定が表示されます（78ページ）。
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ビューファインダー画面のメニュー表
示と設定

本機にDVF‑EL200が装着されている場合、
DVF‑EL200のMenuボタンを長押しすると、
ビューファインダー画面にMonitoringメニュー
のVF Display（80ページ）とVF Function

（80ページ）の設定メニューが表示されます。
ビューファインダー画面を見ながら、これらの機
能を設定できます。

再生中の画像に表示される情報

再生画像には、次の情報が表示されます。

98

7

6

1

2 4 53

1.	 再生メディアフォーマット（コーデック）表示
再生中のクリップの記録フォーマット（コーデック）
が表示されます。

2.	タイムデータ表示
メニューのTC/Mediaカテゴリー > TC Display
の設定に従って、デュレーションまたはタイムコー
ドが表示されます（57ページ）。

3.	 再生動作状態表示
再生動作の状態が表示されます。
CALLコマンドを受信すると、「CALL」が表示さ
れます。

4.	再生クリップ名表示
再生画像のクリップ名の前8文字が表示されま
す。

5.	 再生メディア表示
再生中の記録メディアが表示されます。

メモリーカードがプロテクトされている場合は、
右に （プロテクト）アイコンが表示されます。

6.	オーディオレベルメーター表示
再生中の音声チャンネル1、2のレベルが表示さ
れます。

7.	 ネットワーク接続状態表示
ネットワークの接続状態（LANまたはWi‑Fi）が表
示されます。

条件 表示
ネットワーク接続設定状態で接続断など
のエラー時

点滅

ネットワーク接続設定状態で接続時 点灯
ネットワーク接続機能を使用していない 空欄

8.	温度計アイコン
温度上昇に関する警告メッセージがあるときに表
示されます。

メニューのInfoカテゴリーに内容が表示されま
す。

9.	警告アイコン
温度上昇を除く警告メッセージがあるときに表示
されます。
メニューのInfoカテゴリーに内容が表示されま
す。
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電源の準備
バッテリーパック、またはACアダプターを介して
AC電源を使用できます。
安全のため、下記ソニー純正以外のバッテリーを
使用しないでください。

リチウムイオンバッテリーパック
BP‑GL95B

ACアダプター
供給電力120W以上を目安とします。

バッテリーパックを使用する

バッテリーパックをバッテリーパック取り付け部
（12ページ）に差し込んで、下にスライドさせ
てロックします。
取り外すときは、バッテリーリリースレバー（12
ページ）を押しながらバッテリーパックを上にスラ
イドさせてロックを外し、取り外します。

［ご注意］
• 装着する前に、バッテリーチャージャーを使用して充電

してください。
• 使用直後でバッテリーパックの温度が上昇した状態で充

電すると、完全に充電されないことがあります。
• バッテリーアダプターを取り外す際は、必ず手で支えな

がら外してください。

残量を確認する

バッテリーパックを使用して撮影・再生している
ときは、サブディスプレイ画面（36ページ）お
よびビューファインダー・モニター画面（14ペー
ジ）にバッテリー残時間またはバッテリー電圧が
表示されます。
残り時間は、現在の消費電流のペースで本機を
継続使用した場合のバッテリーパックの使用可能
時間を計算して分単位で表示されます。

バッテリーパックの容量が低下すると

使用中にバッテリーパックの容量が一定の値まで
低下すると、バッテリー残量表示が点滅し、REC
ランプの点滅で警告します。
さらに容量が減り、動作が継続不可能な状態に
なると、バッテリーパックの残りがないことを知
らせるメッセージが表示されます。
充電されたバッテリーパックに交換してください。

警告残量を変更する

フルメニューのTechnical > Batt./Voltage 
Alarm（91ページ）で変更します。

AC電源を使用する（DC IN電
源） 

本機は120WのACアダプターを使用することに
よって、AC電源に接続して動作させることがで
きます。
入力電圧範囲は11 V ～ 17 Vと22 V ～ 32 Vに対
応しています。

［ご注意］
• バッテリー運用時にDC IN電源へ切り換える際には、 

12 V ～ 17 Ｖの電圧の電源を使用することで、より安全
に電源を切り換えることができます。

• 22 V ～ 32 V電圧を使用する場合は、本機の電源スイッ
チをOFFの状態で電源接続（給電）することを推奨しま
す。

• DC IN電源電圧を11 V ～ 17 V電圧使用状態から22 V ～
32 V電圧使用状態に直接切り換える、またはその逆の
状態に直接切り換えることはしないでください。故障の
原因となります。

バッテリーパックとDC IN 電
源の併用について

バッテリーパックおよびDC IN電源がどちらも給
電可能な電圧の場合は、DC IN電源側から優先
的に給電状態となります。

［ご注意］
バッテリー運用時にDC IN電源からの給電状態に切り換え
ると、以下の要因等により本機の動作が停止する場合があ
りますのでご注意ください。
• DCコネクター挿抜時のコネクター部のチャタリング（コ

ネクターこじり等）
• 電源供給元が切り換わったときの電圧ドロップ（外部負

荷状態が重いほど大きい）
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時計を合わせる
本機を初めて使用するとき、電源を入れるとサブ
ディスプレイ画面に初回設定画面が表示されま
す。
この画面を使用して内蔵時計の日付／時刻を設
定してください。

Time Zone について

UTC（協定世界時）からの時差を設定します。必
要に応じて変更してください。

［ご注意］
Time Zoneを変更すると時差に合わせて時刻設定が変更
されます。

日付/時刻を設定する

MENUダイヤル（10ページ）を回して項目や数
値を選び、MENUダイヤルを押して決定します。
最後にカーソルをSetに合わせてMENUダイヤル
を押すと、設定画面が消えて時計合わせが完了
します。
初回設定画面が消えた後は、フルメニューの
Maintenance > Clock Set（94ページ）を使
用してTime Zoneおよび日時の設定を変更でき
ます。

［ご注意］
• 動作電源が供給されていない（バッテリーパックもDC IN

電源も接続されていない）状態でバックアップ電池が消
耗するなどして現在日時の情報が失われた場合は、次に
電源を入れると初回設定画面が表示されます。

• 初回設定画面が表示されている状態では、この画面で
の設定が完了するまで電源を切る以外の操作はできま
せん。
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イメージャーブロックを交換する
イメージャーブロックを交換します。
8Kイメージャーブロックを6Kイメージャーブロッ
クに交換する手順を例に説明します。
6Kイメージャーブロック取り付けるときは、6Kイ
メージャーブロック用カバー（MPC‑3628：付属品、
MPC‑3626：装着品）を取り付けてください。

［ご注意］
イメージャーブロックを交換するときは、10分以上電源を
OFFにして十分に冷えた状態で交換してください。また、
交換の際はシャープエッジにご注意ください。

1 底面の六角ネジ（2本）と前面の六角ネジ（4本）
を外して8Kイメージャーブロックを取り外す。

イメージャー
ブロック

2 文字が刻印されている面を前にして6Kイ
メージャーブロック用カバーを取り付け、ネ
ジ（2本）で締め付ける（締め付けトルク0.19N・
m）。

6Kイメージャーブ
ロック用カバー

 ［ご注意］
• 6Kイメージャーブロック用カバーを取り付けない

と、6Kイメージャーブロックの放熱が悪くなります。
• 8Kイメージャーブロックを取り付けるときは、6Kイ

メージャーブロック用カバーを取り外してください。

3 6Kイメージャーブロックを取り付ける。

真っ直ぐに取り付け、六角レンチを使用して、
手順1で外した六角ネジ（6本）を締め付けま
す（締め付けトルク1.4N・m）。

イメージャーブロック交換後
の起動動作について

イメージャーブロック交換後の初回起動時は、セ
ンサー固有データを読み直すため起動に時間が
かかります。
電源を入れてから数分程度で自動的に再起動さ
れ、センサー固有データの読み直しが完了します。
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VFアタッチメントを取り付け
る

1 VFアタッチメントを矢印の方向にスライドさ
せて取り付ける。

2 VFアタッチメントの前後位置を決め、ロック
レバーを回して締める。

1

2

ロック
レバー

 ［ご注意］
• VFアタッチメントを前後逆および左右方向に取り

付けることもできます。
• ロックレバーが締めにくい場合や緩む場合は、ロッ

クレバー上にあるロックネジを六角レンチ（3 mm）
で回して固定することができます。

VFアタッチメントを取り外すには

ロックレバーを回して緩め、リリースボタンを押
してVFアタッチメントを取り付けたときと逆の方
向にスライドさせて抜き取ります。

ハンドルを取り付ける

1 ハンドルを矢印の方向にスライドさせて取り
付ける。

2 ハンドルの前後位置を決め、ロックレバーを
回して締める。

2

1

ロックネジ

六角穴付き
ボルト

ロック
レバー

 ［ご注意］
• 六角レンチ（5 mm）でロックネジを回して固定する

こともできます。
• 使用時にハンドルのロックレバーが緩む場合は、

ロックネジの隣にある六角穴付きボルト（2 mm）を
締めると緩まなくすることができます。

• ハンドルを前後逆方向に取り付けることもできま
す。

ハンドルを取り外すには

ロックレバーを回して緩め、リリースボタンを押
してハンドルを取り付けたときと逆の方向にスラ
イドさせて抜き取ります。

VFアタッチメントとハンドルの取り付け
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推奨PLマウントレンズ（Super 35mmサイ
ズ用）
SCL‑PK6/F、SCL‑PK6/M（6本セット、
20 mm/25 mm/35 mm/50 mm/85 mm/ 
135 mm）
SCL‑PK3/F、SCL‑PK3/M（3本セット、
20 mm/25 mm/135 mm）
SCL‑P11X15

推奨Eマウントレンズ
SELP28135G、SEL1635GM、SEL2470GM、
SEL70200GM、SEL100400GM、SEL1224G、
SEL35F14Z、SEL50F14Z、SEL85F14GM、
SEL90M28G、SEL100F28GM

［ご注意］
一部のEマウントレンズでは制御できない場合があります。
推奨レンズをご使用ください。

˜˜ 本機で使用できるレンズについて詳しくは、ソニーの
サービス窓口にご相談ください。

レンズを太陽に向けて放置しないでください。太
陽光がレンズを通して機器内部に焦点を結び、
火災の原因となることがあります。

［ご注意］
• レンズおよびアダプターの取り付け／取り外しは、本機

の電源を切った状態で行ってください。
• レンズは精密部品です。レンズは、マウント部側を下に

して直に置かないでください。必ず付属のキャップをか
ぶせてください。

• 本機のレンズインターフェースは、工場出荷時にSCL‑
P11X15およびCooke型コネクター付きレンズ用に合
わせて設定されています。SCL‑PK6、SCL‑PK3や
それ以外のCooke型コネクターを持たないレンズを
使用する場合は、フルメニュー > Technical > Lens 
Configuration > PL‑Mt Interface Position（89
ページ）をOffに設定します。

PLマウントレンズを取り付け
る

1 PLマウントレバーを反時計方向に回して、レ
ンズマウントからマウントキャップを外す。

PLマウント
レバー

 ［ご注意］
PLマウントレバーを反時計回りにストッパーの位置ま
で回してください。

2 レンズマウント上面右の位置決めピンに、レ
ンズの凹部を合わせ、レンズをマウントに差
し込む。

3 レンズを支えながら、PLマウントレバーを時
計方向に回して、レンズを固定する。

 ［ご注意］
PLレンズを装着の際は、レンズを回さないでください。
レンズを回すと、ホットシューピン折れの原因となり
ます。

Cooke /i レンズを取り付けるには

レンズ側のコンタクトと本機側のホットシューの
位置を合わせてください。レンズアダプター側の
コネクターは2か所ありますが、どちらも使用で
きます。

レンズを取り外すには

1 レンズを下から支えて、PLマウントレバーを
反時計方向に回す。

2 レンズを前方に引き抜く。

 ［ご注意］
• 別のレンズをすぐに取り付けないときは、マウント

キャップの凹部を確実に合わせて、PLマウントレ
バーを時計方向に回して固定してください。

• レンズとのIF通信を正しく行うために、フルメニュー 
> Technical > Lens Configuration（89ペー
ジ）の設定を、使用するレンズに合わせて設定して
ください。

フランジバックを調整する

本機はフランジバックを調整した状態で出荷して
います。フランジバックの調整を行いたい場合は、
レンズマウントを取り外し、シムを適切な厚みの
ものと交換してください。0.01 mm単位で±0.1 
mmの調整ができます。

シムについて

本機には以下のシムが同梱されています
0.05 mm ×1（円弧型）
0.01 mm ×15（1/3円弧型）
1/3円弧型シムは3枚組でご使用ください。フラ
ンジバックを長く調整する場合は、シムを挿入し
てください。本機は出荷時に以下の3種類のシム
によってフランジバックを調整した状態で出荷し
ています。
0.10 mm（円弧型）
0.05 mm（円弧型）
0.01 mm（1/3円弧型）
また、出荷時のシム厚みを示すシールが貼られて
います。

レンズの取り付けとフランジバックの調整
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フランジバックの調整

1 トルクスネジ（6本）を外してPLマウントフラ
ンジを取り外す。

1

PLマウントフランジ

2 PLコネクター（2か所）の両側の十字ネジ 
（4本）を緩めてPLコネクターとPLコネクター
台を取り外す。

3 PLマウントアダプター（3か所）にシムを取り
付ける。

33

33
33

22
22

PLコネクター

PLコネクター台

1/3円弧型のシムを使用する場合
3か所とも同じ厚みになるようにシムを取り
付けます。

シム

円弧型のシムを使用する場合
刻印がある面を表にして取り付けます。

刻印

刻印

4 PLコネクター（2か所）を元の位置に戻し、
締め付けトルク0.18N・mで十字ネジ（4本）
を締め付ける。

5 PLマウントフランジを元の位置に戻し、トル
クスレンチ T8を使用して、締め付けトルク
0.35N・mでトルクスネジ（6本）を締め付け
る。

フィルターのお手入れについ
て

フィルターを掃除するときは、アダプターを外し
て拭いてください。アダプター中央部（網掛け部）
をクロスなどで拭くと、繊維が付着する場合があ
りますので注意してください。繊維が付着した場
合は、ソフトブラシで掃除してください。

アダプター
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PLレンズアダプターを取り外
す

本機にEマウントレンズを取り付ける場合、PLレ
ンズアダプターを取り外します。取り付け／取り
外しは、本機後面を下にした状態で行います。
六角ネジ（2.5 mm、6本）を緩めて、PLレンズア
ダプターを取り外します。

PLレンズアダ
プター

［ご注意］
• バッテリーを取り付けて本機後面を下にして置くと、安

定した状態で作業できます。
• 取り付け／取り外し作業時、本機とPLレンズアダプター

の端子接点に触れないようにご注意ください。

PLレンズアダプターを取り付けるには

1 マウントレバーがロック位置になっているこ
とを確認する。

マウント
レバー

2 PLレンズアダプターを元の位置に戻し、六角
レンチ（2.5 mm）を使用して、締め付けトル
ク0.8±0.12N・mで六角ネジ（2.5 mm、6本）
を締め付ける。

Eマウントレンズを取り付ける

1 PLレンズアダプターを取り外す（23ペー
ジ）。

2 ロックスイッチを上方向に押してから、マウ
ントレバーを時計方向に回してロックを解除
する。

マウントレバー

ロックスイッチ

3 本体とレンズのマウント標点（白色）を合わせ、
レンズをマウントに差し込む。

4 レンズを支えながら、マウントレバーを反時
計方向に回して、レンズを固定する。

 

マウント標点（白色）

［ご注意］
Eマウントレンズ接続時は、12pinレンズコネクターの動作
は保証できません

レンズを取り外すには

1 ロックスイッチを上方向に押してから、マウ
ントレバーを時計方向に回してロックを解除
する。

2 レンズを前方に引き抜く。

 ［ご注意］
別のレンズをすぐに取り付けないときは、マウント
キャップの凹部を確実に合わせて、マウントレバーを
反時計方向に回して固定してください。
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ビューファインダーの取り付け
本機で使用できるビューファインダー
DVF‑EL200：OLEDカラービューファインダー

ビューファインダーは別売りです。
ここではDVF‑EL200を取り付ける場合を例に示
します。

˜˜ 各ビューファインダーの取り扱いについて詳しくは、使
用するビューファインダーの取扱説明書をご覧くださ
い。

接眼レンズを太陽に向けて放置しないでくださ
い。太陽光が接眼レンズを通してビューファイン
ダー内部に焦点を結び、火災の原因となること
があります。

［ご注意］
ビューファインダーの取り付け／取り外しは、本機の電源
を切った状態で行ってください。

ビューファインダーを取り付
ける

1 VFアタッチメントのビューファインダー取り
付け部の溝に、ビューファインダーのシュー
を合わせて取り付ける。

2 ビューファインダーのロックレバーをLOCK方
向に回して固定する。

2

1

ロックレバー

3 ビューファインダーと本機をVF接続ケーブル
で接続する。
ビューファインダー側：
コネクターの標点（赤色）を上側にして、奥ま
で差し込んでください。
本機側：
コネクターの標点（赤色）とVF端子の凹部を
合わせて、奥まで差し込んでください。

クランパー

 ［ご注意］
必要に応じて、クランパーでケーブルを固定してくだ
さい。

ビューファインダーを取り外すには

1 ビューファインダーと本機からVF接続ケーブ
ルを引き抜く。

2 ロックレバーをLOCKと反対方向に回して
ロックを解除し、ビューファインダーをVFア
タッチメントから取り外す。

位置を調整する

前後の位置を調整するには

1 VFアタッチメントの前後のロッドロックレ
バーを両方、またはどちらか一方を緩める。

2 VFアタッチメントを前後にスライドさせて、
ビューファインダーの位置を調整する。

11
11

22

ロッドロック
レバー

3 ロッドロックレバーを締める。

 ［ご注意］
ロッドロックレバーが回しにくい場合は、レバーを引
き出してから操作しやすい位置まで回転させ、押して
もとに戻してください。
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左右の位置と高さ（角度）を調整するに
は

1 VFアタッチメントの前面のロッドロックレ
バーを緩める。

2 VFアタッチメントのロッドを左右にスライド
させたり、上下に回して、ビューファインダー
の位置を調整する。

11

22
22

ロックネジ

ロッドロック
レバー

3 ロッドロックレバーを締める。

 ［ご注意］
ロッドロックレバーを緩めたときにビューファインダー
が下に回ってしまう場合は、6角レンチ（3 mm）でロッ
クネジを調節してください。

角度を調整するには

主に撮影中にビューファインダーの角度を調整し
ます。

1 ビューファインダー取り付け部の回転ロック
レバーを緩める。

2 ビューファインダーを上下に回して角度を調
整する。

11

22

回転ロックレバー

3 回転ロックレバーを締める。
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本機では、撮影した映像・音声を、カードスロッ
ト内のAXSメモリーカード（別売り）に記録します。

AXSメモリーカードについて

本機では、下記のソニー製AXSメモリーカードを
ご使用ください。

S24

AXS‑A1TS24（1 TB/2.4 Gbps）
AXS‑A256S24（256 GB/2.4 Gbps）
AXS‑A512S24（512 GB/2.4 Gbps）

S48

AXS‑A1TS48（1 TB/4.8 Gbps）
AXS‑A512S48（512 GB/4.8 Gbps）

S66

AXS‑A1TS66（1 TB/6.6 Gbps）

AXSメモリーカードを入れる

1 カードスロット部（10ページ）のカバーを
開ける。

2 AXSメモリーカードを、ラベルを右にして
カードスロットに差し込む。
ACCESSランプ（9ページ）が赤く点灯し、
使用可能な状態になると緑で点灯します。

3 カバーを閉める。

ACCESSランプによる状態表示

AとBのカードスロットの状態を示すために、そ
れぞれにACCESSランプがあります。

ランプ スロットの状態
赤で点灯 装着されているAXSメモリー

カードにアクセス中（データの書
き込み／読み出し中）

緑で点灯 スタンバイ状態（装着されている
AXSメモリーカードを使用して
記録・再生を行います。）

消灯 • AXSメモリーカードが装着さ
れていない。 

• 使用できないカードが装着さ
れている。 

• AXSメモリーカードは装着さ
れているが、別のスロットの
カードが選択されている。

AXSメモリーカードを取り出
す

1 カードスロット部のカバーを開ける。

2 AXSメモリーカードカードを抜く。

［ご注意］
メモリーカードにアクセス中に本機の電源を切ったりメモ
リーカードを抜いた場合はデータは保証されません。カー
ドに記録されたすべてのデータが壊れる可能性があります。
電源を切ったり、カードを抜くときは、必ず使用するメモリー
カードのACCESSランプが緑で点灯または消灯していること
を確認してから操作してください。

使用するAXSメモリーカード
を切り換える

カードスロットAとBの両方にAXSメモリーカード
が装着されているときは、SLOT SELECTボタン

（9ページ）を押して使用するカードを切り換
えることができます。
記録実行中にカードがフルになったときは、自動
的にもう1枚のカードに切り換わります。

［ご注意］
記録中および再生中は、SLOT SELECTボタンは無効にな
ります。ボタンを押しても切り換わりません。

AXSメモリーカードをフォー
マット（初期化）する

フォーマットされていないAXSメモリーカード、
または別の仕様でフォーマットされたAXSメモ
リーカードを装着すると、ファイルシステムが異
なることを知らせるメッセージが表示されます。
その場合は、以下の操作を行ってメモリーカード
をフォーマットします。

1 メニューのTC/Mediaカテゴリー > Format 
Mediaを選択する。

2 AXS Slot A（スロットA）またAXS Slot B（ス
ロットB）を選択し、MENUダイヤルを押す。
フォーマットを実行するかどうかの確認画面
が表示されます。

3 実行する場合はITEMキー 1とITEMキー 3を
同時に3秒間押す。
フォーマットが始まり実行中メッセージが表
示され、ACCESSランプが赤く点灯します。
フォーマットが終了すると、完了メッセージ
が表示されます。MENUダイヤルを押して
メッセージを消します。

フォーマットできなかったときは

プロテクトされたAXSメモリーカードや本機で使
用できないメモリーカードはフォーマットされま
せん。
警告メッセージが表示されますので、メッセージ
に従って、使用できるAXSメモリーカードに交換
してください。

AXSメモリーカードの取り扱い
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［ご注意］
メモリーカードをフォーマットすると、記録された映像デー
タ、セットアップファイルなどを含む、すべてのデータが消
去されます。

残りの記録可能時間を確認
する

撮影中（記録中／記録待機中）は、サブディスプ
レイのホーム画面（36ページ）およびビューファ
インダー・モニター画面（14ページ）の記録メ
ディア残量表示部で、各スロットに装着したAXS
メモリーカードの残量を確認することができま
す。
現在設定されているビデオフォーマット（記録ビッ
トレート）で撮影した場合に記録可能な時間を、
それぞれのスロット内のメディアの残量から計算
して分単位で表示します。

［ご注意］

メモリーカードがプロテクトされている場合は、  （プロテ
クト）マークが表示されます。

AXSメモリーカードの交換時期

• 記録中に挿入されているメモリーカードの残
記録可能時間の合計が、Technicalメニュー 
> Alerts & Tally > Media Near Full Alarm

（91ページ）で設定されている時間をきる
と、記録メディア残量表示が点滅し、RECラン
プの点滅とブザー音で警告します。空きのある
メディアに交換してください。

• 記録を継続して、残記録可能時間の合計が0
になると、メッセージがMedia Fullに変わり
記録が停止します。

［ご注意］
• 1枚のAXSメモリーカードに記録可能なクリップ数は以下

のとおりです。
 S24/S48：約600個
 S66：約430から440個
• 記録できるクリップ数の上限に達すると、残時間表示が

「0」になり、メッセージMedia Fullが表示されます。

AXSメモリーカードを修復す
る

何らかの原因でメモリーカード内のデータに異常
が発生した場合は、メモリーカードの修復が必
要になります。
修復が必要なAXSメモリーカードを挿入したとき
は、修復を実行するかどうかを確認するメッセー
ジがサブディスプレイに表示されます。
修復を実行するには、MENUダイヤルを回して
Runを選択し、MENUダイヤルを押します。
修復が始まります。
実行中メッセージが表示され、ACCESSランプが
赤く点灯します。
修復が終了すると、完了メッセージが表示されま
す。MENUダイヤルを押してメッセージを消しま
す。

修復できなかったときは

• プロテクトされたAXSメモリーカードや、エ
ラーが発生したAXSメモリーカードは修復でき
ません。警告メッセージが表示されますので、
メッセージに従って、プロテクトを解除するか、
別のAXSメモリーカードに交換してください。

• エラーが発生したAXSメモリーカードは、
フォーマットをし直すと再利用できる場合があ
ります。

• 一部のクリップのみが修復できない場合もあり
ます。修復できたクリップは再生可能になりま
す。

［ご注意］
本機で記録されたメディアは、本機で修復してください。
本機以外で記録されたメディアや、本機と同一機種であっ
てもバージョンが異なる機器で記録されたメディアは、本
機では修復できない場合があります。
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AXSメモリーカードに記録する

メニューのProjectカテゴリー > Recording Format（56ページ）で、AXSメモリーカードに記録するフォーマットを選択できます。
AXSメモリーカードは、AXS単独記録実行中にカードがフルになったときは、もう1枚のカードに自動的に切り換わります。

S24、S48またはS66 AXSメモリーカード使用時、Recording FormatとImager Modeの設定によって以下の制限があります。S24またはS48 AXSメモリーカードが使用できない状態のときに、S24または
S48 AXSメモリーカードが検出されると、S66 AXSメモリーカードの使用を促す注意メッセージが表示されます。

MPC‑3628

Recording 
Format

Imager Mode 撮像フレームレートと対応S24/S48/S66 AXSメモリーカード
24 25 30 48 50 60 66 72 75 88 90 96 100 110 120

X‑OCN XT 8.6K 3:2 S66 S66 S66 － － － － － － － － － － － －
8.2K 17:9
7.6K 16:9

S48/S66 S48/S66 S48/S66 －1) －1) －1) － － － － － － － － －

5.8K 6:5 S48/S66 S48/S66 S48/S66 S66 － － － － － － － － － － －
5.8K 17:9
5.4K 16:9

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 S48/S66 S48/S66 S66 S66 S66 －1) －1) － － － －

X‑OCN ST 8.6K 3:2 S48/S66 S48/S66 S48/S66 － － － － － － － － － － － －
8.2K 17:9
7.6K 16:9

S48/S66 S48/S66 S48/S66 S66 S66 S66 － － － － － － － － －

5.8K 6:5 S24/
S48/S66

S24/
S48/S66

S48/S66 S48/S66 － － － － － － － － － － －

5.8K 17:9
5.4K 16:9

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 S48/S66 S48/S66 S48/S66 S48/S66 S48/S66 S66 S66 － － － －

X‑OCN LT 8.6K 3:2 S24/
S48/S66

S24/
S48/S66

S48/S66 － － － － － － － － － － － －

8.2K 17:9
7.6K 16:9

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 S48/S66 S48/S66 － － － － － － － － －

5.8K 6:5 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

－ － － － － － － － － － －

5.8K 17:9
5.4K 16:9

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 S48/S66 － － － －
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Recording 
Format

Imager Mode 撮像フレームレートと対応S24/S48/S66 AXSメモリーカード
24 25 30 48 50 60 66 72 75 88 90 96 100 110 120

4K ProRes 
4444

8.2K 17:9 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 S48/S66 S48/S66 － － － － － － － － －

5.8K 6:5 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 － － － － － － － － － － －

5.8K 17:9 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 S48/S66 S48/S66 － － － － － － － － －

4K ProRes 
422 HQ

8.2K 17:9 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

－ － － － － － － － －

5.8K 6:5 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

－ － － － － － － － － － －

5.8K 17:9 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 S48/S66 － － － － － －

QFHD 
ProRes 
4444

7.6K 16:9 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 － － － － － － － － －

5.4K 16:9 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 － － － － － － － － －

QFHD 
ProRes 422 
HQ

7.6K 16:9 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

－ － － － － － － － －

5.4K 16:9 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

－ － － － － －

1) S66 AXSメモリーカード使用時は記録フォーマットをX‑OCN STまたはLTに変更すれば記録可能。S48 AXSメモリーカード使用時は記録フォーマットをX‑OCN LTに変更すれば記録可能。
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MPC‑3626

Recording 
Format

Imager Mode 撮像フレームレートと対応S24/S48/S66 AXSメモリーカード
24 25 30 48 50 60 66 72 75 88 90 96 100 110 120

X‑OCN XT 6K 3:2 S48/S66 S48/S66 S48/S66 S66 S66 S66 － － － － － － － － －
6K 1.85:1 S24/

S48/S66
S24/
S48/S66

S48/S66 S48/S66 S48/S66 S66 S66 S66 － － － － － － －

6K 17:9
5.7K 16:9

S24/
S48/S66

S24/
S48/S66

S48/S66 S48/S66 S48/S66 S66 S66 S66 － － － － － － －

6K 2.39:1 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 S48/S66 S48/S66 S48/S66 S66 S66 S66 S66 － － － －

4K 6:5 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 S48/S66 S48/S66 S48/S66 S48/S66 － － － － － － －

4K 4:3 
Surround 
View

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

－ － － － － － － － － － － －

4K 4:3 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 S48/S66 S48/S66 S48/S66 S48/S66 S48/S66 － － － － － －

4K 17:9 
Surround 
View
3.8K 16:9 
Surround 
View

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

－ － － － － － － － － － －

4K 17:9
3.8K 16:9

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 S48/S66 S48/S66 S48/S66 S48/S66 S48/S66 S48/S66 S48/S66 －

4K 2.39:1 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 S48/S66 S48/S66 S48/S66 S48/S66 S48/S66
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Recording 
Format

Imager Mode 撮像フレームレートと対応S24/S48/S66 AXSメモリーカード
24 25 30 48 50 60 66 72 75 88 90 96 100 110 120

X‑OCN ST 6K 3:2 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 S48/S66 S48/S66 － － － － － － － － －

6K 1.85:1 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 S48/S66 S48/S66 S48/S66 S48/S66 － － － － － － －

6K 17:9
5.7K 16:9

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 S48/S66 S48/S66 S48/S66 S48/S66 － － － － － － －

6K 2.39:1 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 S48/S66 S48/S66 S48/S66 S48/S66 S48/S66 － － － －

4K 6:5 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 S48/S66 S48/S66 － － － － － － －

4K 4:3 
Surround 
View

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

－ － － － － － － － － － － －

4K 4:3 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 S48/S66 S48/S66 － － － － － －

4K 17:9 
Surround 
View
3.8K 16:9 
Surround 
View

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

－ － － － － － － － － － －

4K 17:9
3.8K 16:9

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 S48/S66 S48/S66 －

4K 2.39:1 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66
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Recording 
Format

Imager Mode 撮像フレームレートと対応S24/S48/S66 AXSメモリーカード
24 25 30 48 50 60 66 72 75 88 90 96 100 110 120

X‑OCN LT 6K 3:2 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 － － － － － － － － －

6K 1.85:1 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 － － － － － － －

6K 17:9
5.7K 16:9

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 － － － － － － －

6K 2.39:1 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 － － － －

4K 6:5 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

－ － － － － － －

4K 4:3 
Surround 
View

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

－ － － － － － － － － － － －

4K 4:3 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

－ － － － － －

4K 17:9 
Surround 
View
3.8K 16:9 
Surround 
View

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

－ － － － － － － － － － －

4K 17:9
3.8K 16:9

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

－

4K 2.39:1 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

4K ProRes 
4444

6K 17:9 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 S48/S66 S48/S66 － － － － － － － － －

6K 2.39:1 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 S48/S66 S48/S66 － － － － － － － － －

4K 6:5 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 S48/S66 S48/S66 － － － － － － － － －

4K 17:9 
Surround 
View

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 － － － － － － － － － － －

4K 17:9 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 S48/S66 S48/S66 － － － － － － － － －

4K 2.39:1 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 S48/S66 S48/S66 － － － － － － － － －
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Recording 
Format

Imager Mode 撮像フレームレートと対応S24/S48/S66 AXSメモリーカード
24 25 30 48 50 60 66 72 75 88 90 96 100 110 120

4K ProRes 
422 HQ

6K 17:9 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 － － － － － － －

6K 2.39:1 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 S48/S66 － － － － － －

4K 6:5 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 － － － － － － －

4K 17:9 
Surround 
View

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

－ － － － － － － － － － －

4K 17:9 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 S48/S66 S48/S66 S48/S66 － － － －

4K 2.39:1 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 S48/S66 S48/S66 S48/S66 － － － －

QFHD 
ProRes 
4444

5.7K 16:9 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 － － － － － － － － －

3.8K 16:9 
Surround 
View

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

－ － － － － － － － － － －

3.8K 16:9 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 － － － － － － － － －

QFHD 
ProRes 422 
HQ

5.7K 16:9 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

－ － － － － － －

3.8K 16:9 
Surround 
View

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

－ － － － － － － － － － －

3.8K 16:9 S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S24/
S48/S66

S48/S66 S48/S66 － － － －



2章　準備34

設定データ保存用SDカードの取り扱い
本機では、カメラの設定値ファイルをSDカード（別
売り）に保存することができます。保存したファ
イルはSDカードから読み込んで使用できます。

本機で使用可能なSDカード

SDXCメモリーカード*（File System: exFAT/
Speed Class：4 ～ 10/UHS非対応/容量: 
64 GB ～ 2 TB）
SDHCメモリーカード*（File System: FAT32/
Speed Class：4 ～ 10/UHS非対応/容量: 4 GB
～ 32 GB）
SDメモリーカード*（File System: FAT16/容量：
2 GBまで）
* 本書ではSDカードと表現しています。

SDカードを入れる

SDカードスロット（13ページ）にSDカードを
差し込みます。
ACCESSランプ（11ページ）が赤く点灯し、使
用可能な状態になると緑で点灯します。

ACCESS ランプによる状態表示

ランプ スロットの状態
赤で点灯 装着されているSDカードにアク

セス中（データの書き込み／読
み出し中）

消灯 • SDカードが装着されていな
い。

• 使用できないカードが装着さ
れている。

SDカードを取り出す

SDカードを軽く1回押して取り出します。

［ご注意］
• メモリーカードにアクセス中に本機の電源を切ったりメ

モリーカードを抜いた場合はデータは保証されません。
カードに記録されたすべてのデータが壊れる可能性があ
ります。電源を切ったり、カードを抜くときは、必ず使
用するメモリーカードのACCESSランプが緑で点灯また
は消灯していることを確認してから操作してください。

• 出し入れ時にはメモリーカードの飛び出しにご注意くだ
さい。

SDカードをフォーマット（初期
化）する

本機で初めてSDカードを使用するときは、フォー
マットが必要です。
本機で使用するSDカードは、本機のフォーマッ
ト機能を使用してフォーマットしてください。SD
カードを装着したときに注意メッセージが表示さ
れた場合も、フォーマットして使用してください。
本機が対応していないフォーマットで初期化され
たSDカードを装着すると、ファイルシステムが異
なることを知らせるメッセージが表示されます。

1 メニューのTC/Mediaカテゴリー > Format 
Media > SD Cardを選択し、MENUダイヤ
ルを押す。
フォーマットを実行するかどうかの確認画面
が表示されます。

2 実行する場合はITEMキー 1とITEMキー 3を
同時に3秒間押す。
フォーマットが始まり実行中メッセージが表

示され、ACCESSランプが赤く点灯します。
フォーマットが終了すると、完了メッセージ
が表示されます。MENUダイヤルを押して
メッセージを消します。

［ご注意］
SDカードをフォーマットすると、すべてのデータが消去さ
れ、復元できません。

本機でフォーマットしたメディアを他
の機器のスロットで使用するには

あらかじめバックアップを取り、お使いになる機
器でフォーマットし直して使用してください。
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サブディスプレイ
サブディスプレイにはホーム画面、クリップリスト画面、再生画面、メニュー画面、フルメニュー画面、ユーザー機能画面の6種類の画面が表示されます。
アシスタントサイドの各ボタンを操作して、サブディスプレイの各画面が下図のように遷移します。

ユーザー機能画面

ホーム画面 クリップリスト画面

メニュー画面 フルメニュー画面

再生画面

USERボタン

USERボタン

MENUボタン

HOMEボタン

HOMEボタン

HOMEボタン

CLIPSボタン

CLIPSボタン

CLIPSボタン

USERボタン

MENUボタン

MENUボタン
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ホーム画面

アシスタントサイドのHOMEボタンを押すとホーム画面が表示されます。ホーム画面では本機の状態
の確認や基本的な項目の設定ができます。

項目名／設定値／
機能表示部

ステータス
表示部

項目名／設定値／機能表示部

1 2 3

4 5 6

ITEMキー 4 ITEMキー 5 ITEMキー 6

ITEMキー 3ITEMキー 2ITEMキー 1

［ご注意］
1 ～ 6に表示される各項目はITEMキー 1 ～ 6（49ページ）
にそれぞれ対応しています。ITEMキーを押すと、対応する
項目の操作ができます。オレンジ文字色で表示している機
能に対してITEMキーは有効となります。

1.	 FPS
撮像フレームレートの表示／設定

2.	 Exposure	Index/Gain
Exposure Indexの表示／設定またはRM‑B170
などのリモートコントロールユニットで設定したゲ
イン値の表示（上部アイコンには基準感度を表示）

［ご注意］
ゲイン値は、Technicalメニュー > Special 
Configuration > RM/RCP Paint Control（93ページ）
がOnに設定されている場合のみ表示されます。

3.	 Shutter
電子シャッターの開角度／スピードの 
表示／設定

4.	ND	Filter
NDフィルターのポジションの表示／設定

5.	 LUT
モニター LUTの表示／設定

6.	WB（White	Balance）
ホワイトバランスの表示／設定
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ステータス表示部

1 2 3 4 6 7

91011

5

8
14
13
12

1.	 タイムデータ表示
メニューのTC/Mediaカテゴリー > TC Display
の設定に従って、デュレーションまたはタイムコー
ドが表示されます（57ページ）。
タイムデータに現在表示しているデータの種類
は、次のように表示されます。
TCG：記録タイムコード
TCR：再生タイムコード
Dur：デュレーション

2.	 Ext-LKアイコン
内蔵のタイムコードジェネレーターがTC IN 端子
に接続した外部信号にロックしているときに表示
されます。

3.	 フレームレート表示
メニューのProjectカテゴリー > Project Frame 
Rateの設定値が表示されます（56ページ）。

4.	ゲンロックアイコン
ゲンロックがかかっている場合、ロック状態であ
ることが表示されます。

5.	 イメージャーモード表示
メニューのProjectカテゴリー > Imager Mode
の設定値、およびデスクイーズ情報が表示されま
す。

6.	電源電圧／バッテリー残量表示
電源電圧またはバッテリー残量が表示されます。

7.	 クリップ名表示
「Reel：Camera ID + Reel Number」と
「ShotNumber」が表示されます。

8.	音声レベルメーター
音声記録レベルまたは再生レベルが表示されま
す。「1」、「2」は音声チャンネル1、2を示します。

9.	記録フォーマット（コーデック）表示
AXSメモリーカードに記録されるフォーマット名
称が表示されます（61ページ）。

10.	Zoom	to	Fit設定表示
Projectメニュー > Basic Setting > Zoom to 
Fitの設定値が表示されます（75ページ）。

［ご注意］
Zoom to FitがOffまたは設定不可の場合は空欄になりま
す。

11.	 メディア残量表示
記録アクティブアイコン、メディア種類、スロッ
ト種類（A/B）、残時間（現在の記録フォーマットで
記録できる時間）が表示されます。
また、再生中のクリップ名が表示されます。

12.	記録動作状態表示
本機の記録動作状態が次のように表示されます。

表示 説明

　Stby 記録待機中

●Rec 記録中

●Cache ピクチャーキャッシュレック記録
待機中

　CALL CALLコマンド受信中

13.	温度計アイコン
温度上昇に関する警告メッセージがあるときに表
示されます。
メニューのInfoカテゴリーに内容が表示されます。

14.	警告アイコン
温度上昇を除く警告メッセージがあるときに表示
されます。
メニューのInfoカテゴリーに内容が表示されます。
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サブディスプレイのホーム画面の操作方法
基本操作

1 HOMEボタンを押す。
ホーム画面が表示されます。

2 ITEMキー 1 ～ 6で設定したい項目を選ぶ。
設定を変更できる項目は、設定値がオレン
ジ色になっています。
下図はITEMキー 3を押した場合の表示例で
す。

3 （ITEMキー 2）ボタン、 （ITEMキー 5）
ボタンまたはMENUダイヤルで、選択項目ま
たは設定値にカーソルを合わせる。

4 MENUダイヤルまたはSetボタン（ITEM 
キー 3）を押して決定する。

サブディスプレイの明るさを変更する

サブディスプレイの明るさは、フルメニューの
Technical > Panel Control > Brightness level

（91ページ）で変更できます。
また、ホーム画面で、BACKボタンを押しながら
MENUダイヤルを時計方向に回すと、サブディス
プレイの明るさが、その時点での設定を基点に
Minimum→Low→Mid→Highの順で変わりま
す。
ホーム画面で、BACKボタンを押しながらMENU
ダイヤルを反時計方向に回すと、サブディスプ
レイの明るさが、その時点での設定を基点に
High→Mid→Low→Minimumの順で変わりま
す。

［ご注意］
ディスプレイの明るさの設定はサブディスプレイとミニディ
スプレイ共通で、設定が両画面に同時に反映されます。

RM/RCP Paint Control有効時の表
示と動作について

• Technicalメニュー > Special Configuration 
> RM/RCP Paint Control（93ページ）が
Onに設定されている場合は、EI操作部には
ゲイン値が表示されます。この場合、EI値は
変更できませんが、ゲイン値を変更できます

（39ページ）。ただし、Base ISOの切り換
えは可能です。

• Technicalメニュー > Special Configuration 
> RM/RCP Paint Control（93ページ）が
Onで、RM‑B170などのリモートコントロール
ユニット接続時は、以下の操作部はグレーアウ
トされ操作できません。リモートコントロール
ユニットで設定してください（118ページ）。

• シャッター操作部

• WB操作部
• Gain操作部

Step Edit操作

基本操作の手順2でITEMキー 4の位置に「Step 
Edit」が表示されていた場合は、選択できる設定
値を変更することができます。設定値編集画面
で設定値の追加と削除が行えます。

1 設定値選択画面で、変更または削除したい
設定値にカーソルを合わせ、Step Editボタ
ン（ITEMキー 4）を押す。
設定値編集画面が表示されます。

2 設定値を削除する場合は、Delete（ITEMキー
4）を押す。

 ［ご注意］
Deleteの文字がオレンジ色の場合に、選択している
設定値を削除できます。

3 （ITEMキー 2）ボタン、 （ITEMキー 5）
ボタンまたはMENUダイヤルで、設定値を変
更する。

4 設定値が決まったら、Addボタン（ITEMキー
4）を押す。

設定値が追加され、設定値選択画面に戻り
ます。

 ［ご注意］
Addの文字がオレンジ色の場合に、設定値を追加で
きます。

White Balance設定時の操作につい
て

White Balanceの設定値編集画面では、
Coarse/Fineボタン（ITEMキー 1）を押すと、1ス
テップの可変量を「粗い」（Coarse）または「細か
い」（Fine）に切り換えることができます。また、
Temp/Tintボタン（ITEMキー 3）を押すと、変更
する値の色温度（Temp）と色合い（Tint）を切り
換えることができます。
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FPS操作

ホーム画面でITEMキー 1を押してFPS操作画面
表示時、Variable/Fixedボタン（ITEMキー 4）
を押すと、Project Frame Rateに対して等速撮
影を行う「Fixed」と可変速撮影を行う「Variable

（Select FPS）」を切り換えることができます。

［ご注意］
Select FPS時は音声記録されません。

EI操作/Gain操作

EI値を変更できます。また、Technicalメニュー 
> Special Configuration > RM/RCP Paint 
Control（93ページ）がOnの場合は、EI値の
代わりにゲイン値が表示されます。RM‑B170な
どのリモートコントロールユニットが接続されて
いないときに、ゲイン値設定を変更できます。

EI値またはゲイン値を変更する

［ご注意］
ここではEI値を変更する場合の画面を例に示します。

ホーム画面でITEMキー 2を押すと、EI値または
ゲイン値を変更できます。

1 ホーム画面でITEMキー 2を押す。
EI操作画面またはGain操作画面が表示され
ます。

2 （ITEMキー 2）ボタン、 （ITEMキー 5）
ボタンまたはMENUダイヤルで設定値を変更
する。

3 MENUダイヤルまたはSetボタン（ITEMキー
3）を押して決定する。

Base ISOを切り換える

EI操作画面またはGain操作画面でITEMキー 4
を押すと、Base ISOを切り換えることができま
す。

1 EI操作画面またはGain操作画面でITEM
キー 4を押す。
Base ISOの切り換え画面が表示されます。

2 2つのChangeボタン（ITEMキー 1とITEM
キー 3）を同時に押す。

Base ISOが切り換わります（46ページ）。

AWB操作

ホーム画面でITEMキー 6を押してホワイトバラ
ンス操作画面表示時、Auto White Bal.ボタン

（ITEMキー 1）を押すとオートホワイトバランスを
実行します。実行後、Addボタン（ITEMキー 4）
を押して設定値をステップに追加します。また、
設定値をステップに追加する前に、Temp/Tint
ボタン（ITEMキー 3）を押して色温度（Temp）と
色合い（Tint）を切り換えることにより各値を微調
整できます。

［ご注意］
AWB操作を行う場合は、均一適正輝度のホワイトチャー
トを撮像してください。

LUT操作

LUTを設定する

ホーム画面でITEMキー 5を押すと、各出力系統
のLUTを設定できます。

1 ホーム画面でITEMキー 5を押す。
LUT選択画面が表示されます。

 ［ご注意］
Projectメニュー > Basic Setting > Input Color 
Space（74ページ）がRec.2020/User Gammaま
たはRec.709/User Gammaに設定されている場合
は、LUT選択画面にはユーザーガンマの情報が表示
されます。

2 ITEMキー 1、2、3、6で設定したい出力を
選ぶ。
設定値変更画面が表示されます。

3 （ITEMキー 2）ボタン、 （ITEMキー 5）
ボタンまたはMENUダイヤルで、設定値を変
更する。

4 MENUダイヤルまたはSetボタン（ITEMキー
3）を押して決定する。
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LUT選択画面の表示項目

Output Formatの設定によって表示される項目が次のように変わります。

1 2 3

54 6

ITEMキー 5ITEMキー 4 ITEMキー 6

ITEMキー 3ITEMキー 2ITEMキー 1

Output Format 表示内容
SDI1/2 SDI3/4 Monitor HDMI VF ITEMキー 1 ITEMキー 2 ITEMキー 3 ITEMキー 5 ITEM

キー 6
4K/QFHD
12G/6G

FHD FHD 4K/
QFHD

FHD SDI 1/2, 
HDMI

SDI 3/4, 
Monitor

Viewfinder 空欄 ProRes1)

FHD SDI 1/2 SDI 3/4, 
Moni, 
HDMI

Viewfinder 空欄 ProRes1)

4K/QFHD Square 
Quad

FHD SDI 
1/2/3/4

空欄 Viewfinder Monitor,  
HDMI

ProRes1)

4K/QFHD 2SI 
Quad

4K/
QFHD

SDI 1‑4, 
HDMI

空欄 Viewfinder Monitor ProRes1)

FHD SDI 
1/2/3/4

空欄 Viewfinder Monitor,  
HDMI

ProRes1)

Output Format 表示内容
SDI1/2 SDI3/4 Monitor HDMI VF ITEMキー 1 ITEMキー 2 ITEMキー 3 ITEMキー 5 ITEM

キー 6
4K/QFHD 
Square 
Dual

FHD FHD FHD FHD SDI 1/2 SDI 3/4, 
Moni, 
HDMI

Viewfinder 空欄 ProRes1)

4K/QFHD 
2SI Dual

FHD 4K/
QFHD

SDI 1/2, 
HDMI

SDI 3/4, 
Monitor

Viewfinder 空欄 ProRes1)

FHD SDI 1/2 SDI 3/4, 
Moni, 
HDMI

Viewfinder 空欄 ProRes1)

2K/FHD FHD FHD SDI 1/2 SDI 3/4 Viewfinder Monitor,  
HDMI

ProRes1)

FHD FHD － SD SDI 1/2 SDI 3/4 Viewfinder Monitor HDMI

1) Projectメニュー > Basic Setting > Recording FormatがX‑OCNフォーマットのときは空欄になります。

Preset Lookを変更する

LUT選択画面のEdit Lookボタン（ITEMキー 4）
を押すと、LUT選択画面でLookを選択したとき
のLUTを設定できます。

1 LUT選択画面でEdit Lookボタン（ITEMキー
4）を押す。
Look選択画面が表示されます。

2 CategoryでPreset Lookを選択して、
（ITEMキー 5）ボタンまたはMENUダイヤ
ルでPreset Lookにカーソルを移動し、
Selectボタン（ITEMキー 3）を押す。
選択可能な値が表示されます。

3 （ITEMキー 2）ボタン、 （ITEMキー 5）
ボタンまたはMENUダイヤルで、設定値を変
更する。

4 MENUダイヤルまたはSetボタン（ITEMキー
3）を押して決定する。

LUT操作のカテゴリーを変更する

LUT操作の対象となるカテゴリーを、User 3D 
LUT、ART、ACESまたはPreset Lookのいずれ
かに変更できます（68ページ）。

1 LUT選択画面でEdit Lookボタン（ITEMキー
4）を押す。
Look選択画面が表示されます。

2 Categoryにカーソルを移動し、MENUダイ
ヤルまたはSelectボタン（ITEMキー 3）を押
す。
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3 （ITEMキー 2）ボタン、 （ITEMキー 5）
ボタンまたはMENUダイヤルで、カテゴリー

（User 3D LUT、ART、ACESまたはPreset 
Look）を選択する。

 ［ご注意］
Projectメニュー > Basic Setting > Input Color 
Space（74ページ）の設定によって選択肢が以下の
ように変わります。
 ‒ S‑Gamut3.Cine/SLog3またはS‑Gamut3/

SLog3：Preset Look / User 3D LUT / ART
 ‒ ACEScct：Preset Look / ACEScct with User 

3D / ACESproxy with User 3D / ACES with 
ART

4 MENUダイヤルまたはSetボタン（ITEMキー
3）を押して決定する。

User 3D LUTファイルを読み込む

SDカードに保存されているUser 3D LUTファイ
ルを本機に読み込むことができます。
ネットワーク経由でUser 3D LUTファイルを本機
に読み込むこともできます（106ページ）。

［ご注意］
User 3D LUTファイルは、SDカードの以下の階層に保存し
てください（112ページ）。
PRIVATE\SONY\PRO\LUT\

1 SDカードスロット（13ページ）にSDカー
ドを差し込む。

2 LUT選択画面でEdit Lookボタン（ITEMキー
4）を押す。
Look選択画面が表示されます。

3 Load Fileボタン（ITEMキー 4）を押す。
読み込むファイルの種類を選択する画面が
表示されます。

4 （ITEMキー 2）ボタン、 （ITEMキー 5）
ボタンまたはMENUダイヤルで、Load User 
3D LUT Fileを選択する。

5 MENUダイヤルまたはSelectボタン（ITEM
キー 3）を押す。
読み込み先の番号（01 ～ 16）が表示されま
す。
読み込み済みの番号にはファイル名が表示
されます。

6 （ITEMキー 2）ボタン、 （ITEMキー 5）
ボタンまたはMENUダイヤルで、読み込み先
の番号を選択する。

7 MENUダイヤルまたはSelectボタン（ITEM
キー 3）を押す。
SDカードに保存されているUser 3D LUTの
ファイル名が表示されます。

8 （ITEMキー 2）ボタン、 （ITEMキー 5）
ボタンまたはMENUダイヤルで、ファイルを
選択する。

9 MENUダイヤルまたはLoadボタン（ITEM
キー 3）を押す。
ファイルの読み込みが完了すると、

「Successfully loaded」が表示されます。

10 OKボタン（ITEMキー 6）を押す。

ARTファイルを読み込む

SDカードに保存されているARTファイルを本機
に読み込むことができます。
ネットワーク経由でARTファイルを本機に読み込
むこともできます（107ページ）。

［ご注意］
ARTファイルは、SDカードの以下の階層に保存してくださ
い（112ページ）。
MPC‑3628： 
PRIVATE\SONY\PRO\CAMERA\MPC3628
MPC‑3626： 
PRIVATE\SONY\PRO\CAMERA\MPC3626

1 SDカードスロット（13ページ）にSDカー
ドを差し込む。

2 LUT選択画面でEdit Lookボタン（ITEMキー
4）を押す。
Look選択画面が表示されます。

3 Load Fileボタン（ITEMキー 4）を押す。
読み込むファイルの種類を選択する画面が
表示されます。
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4 （ITEMキー 2）ボタン、 （ITEMキー 5）
ボタンまたはMENUダイヤルで、Load ART 
Fileを選択する。

5 MENUダイヤルまたはSelectボタン（ITEM
キー 3）を押す。
読み込み先の番号（01 ～ 16）が表示されま
す。
読み込み済みの番号にはファイル名が表示
されます。

6 （ITEMキー 2）ボタン、 （ITEMキー 5）
ボタンまたはMENUダイヤルで、読み込み先
の番号を選択する。

7 MENUダイヤルまたはSelectボタン（ITEM
キー 3）を押す。
SDカードに保存されているARTのファイル
名が表示されます。

8 （ITEMキー 2）ボタン、 （ITEMキー 5）
ボタンまたはMENUダイヤルで、ファイルを
選択する。

9 MENUダイヤルまたはLoadボタン（ITEM
キー 3）を押す。
ファイルの読み込みが完了すると、

「Successfully loaded」が表示されます。

10 OKボタン（ITEMキー 6）を押す。

ASC CDLファイルを読み込む

SDカードに保存されているASC CDLファイルを
本機に読み込むことができます。
ネットワーク経由でASC CDLファイルを本機に読
み込むこともできます（107ページ）。

［ご注意］
ASC CDLファイルは、SDカードの以下の階層に保存してく
ださい（112ページ）。
PRIVATE\SONY\PRO\CDL\

1 SDカードスロット（13ページ）にSDカー
ドを差し込む。

2 LUT選択画面でEdit Lookボタン（ITEMキー
4）を押す。
Look選択画面が表示されます。

3 Load Fileボタン（ITEMキー 4）を押す。
読み込むファイルの種類を選択する画面が
表示されます。

4 Load ASC CDL Fileを選択し、MENUダイ
ヤルまたはSelectボタン（ITEMキー 3）を押
す。

SDカードに保存されているASC CDLのファ
イル名が表示されます。

5 （ITEMキー 2）ボタン、 （ITEMキー 5）
ボタンまたはMENUダイヤルで、ファイルを
選択する。

6 MENUダイヤルまたはLoadボタン（ITEM
キー 3）を押す。
Load All Filesボタン（ITEMキー 1）を押す
と、すべてのファイルを読み込むことができ
ます。
ファイルの読み込みが完了すると、

「Successfully loaded」が表示されます。

7 OKボタン（ITEMキー 6）を押す。
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User 3D LUTファイルを変更
する

現在選択されているUser 3D LUTファイルを変
更できます。

1 LUT選択画面でEdit Lookボタン（ITEMキー
4）を押す。
Look選択画面が表示されます。

2 Categoryにカーソルを移動し、MENUダイ
ヤルまたはSelectボタン（ITEMキー 3）を押
して、User 3D LUTを選択する。

3 User 3D LUTにカーソルを移動し、MENU
ダイヤルまたはSelectボタン（ITEMキー 3）
を押す。

4 （ITEMキー 2）ボタン、 （ITEMキー 5）
ボタンまたはMENUダイヤルで、User 3D 
LUTファイルを変更する。

5 MENUダイヤルまたはSetボタン（ITEMキー
3）を押して決定する。

ARTファイルを変更する

現在選択されているARTファイルを変更できます。

1 LUT選択画面でEdit Lookボタン（ITEMキー
4）を押す。
Look選択画面が表示されます。

2 Categoryにカーソルを移動し、MENUダイ
ヤルまたはSelectボタン（ITEMキー 3）を押
して、ARTを選択する。

3 ARTにカーソルを移動し、MENUダイヤルま
たはSelectボタン（ITEMキー 3）を押す。

4 （ITEMキー 2）ボタン、 （ITEMキー 5）
ボタンまたはMENUダイヤルで、ARTファイ
ルを変更する。

5 MENUダイヤルまたはSetボタン（ITEMキー
3）を押して決定する。

ARTファイルの情報を表示する

現在選択されているARTファイルの情報を表示
できます。

1 LUT選択画面でEdit Lookボタン（ITEMキー
4）を押す。
Look選択画面が表示されます。

2 ARTにカーソル移動し、CDL / ART Infoボ
タン（ITEMキー 1）を押す。

ARTファイルの情報が表示されます。

ASC CDLファイルを変更する

現在選択されているASC CDLファイルを変更で
きます。

1 LUT選択画面でEdit Lookボタン（ITEMキー
4）を押す。
Look選択画面が表示されます。

2 ASC CDL Selectを選択し、MENUダイヤル
またはSelectボタン（ITEMキー 3）を押す。
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3 （ITEMキー 2）ボタン、 （ITEMキー 5）
ボタンまたはMENUダイヤルで、ASC CDL
ファイルを変更する。

 ［ご注意］
本機に適用できないファイルはグレーアウト表示され
ます。

4 MENUダイヤルまたはSetボタン（ITEMキー
3）を押して決定する。

ASC CDLファイルの処理順を指定す
る

Look選択画面のASC CDL ProcessでASC CDL
の処理の順番を指定することができます。

ASC CDLファイルの情報を表示する

現在選択されているASC CDLファイルの情報を
表示できます。

1 LUT選択画面でEdit Lookボタン（ITEMキー
4）を押す。

Look選択画面が表示されます。

2 ASC CDL Selectにカーソルを移動し、 
CDL / ART Infoボタン（ITEMキー 1）を押す。
ASC CDLファイルの情報画面が表示されま
す。

ASC CDLファイルの情報画面では、
Saturationの設定を変更することができま
す。

Saturationを変更する

1 ASC CDLファイルの情報画面でEditボタン
（ITEMキー 4）を押す。
Saturationの編集画面が表示されます。

2 MENUダイヤルで変更する桁にカーソルを移
動し、MENUダイヤルを押す。

3 MENUダイヤルで設定値を変更し、MENU
ダイヤルを押す。
Saturationの設定可能範囲は0.000 ～ 
3.999です。

 ［ご注意］
設定可能範囲を超えた値を入力してMENUダイヤル
を押すと、変更前の値に戻ります。

4 MENUダイヤルでSetボタンにカーソルを移
動し、MENUダイヤルを押して決定する。

ASC CDLファイルの設定可能範囲に
ついて

ASC CDLファイルの設定可能範囲は以下のとおり
です。範囲を超えたファイルは読み込めません。
Slope：0.000 ～ 3.999
Offset：‑1.000 ～ 1.000
Power：0.400 ～ 4.000
Saturation：0.000 ～ 3.999
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サブディスプレイのホーム画面設定項目一覧

各項目名称と設定内容は次のとおりです。
太字とアンダーラインで表示されている設定値は、出荷時の設定です。

項目 内容
FPS 撮像フレームレートを設定する。

Variable/Fixed：等速撮影と可変速撮影を切り換えます。
「Fixed」を選択した場合、メニューのProjectカテゴリー > Project Frame 
Rate（56ページ）の設定で値が決まります。

Project Frame Rate 表示
23.98 Fix 23.98

24 Fix 24.00
25 Fix 25.00
29.97 Fix 29.97
47.95 Fix 47.95
50 Fix 50.00
59.94 Fix 59.94

項目 内容
「Variable」を選択した場合、Projectカテゴリー > Imager Mode（74ペー
ジ）とRecording Format（74ページ）の設定によって、設定値が次のよう
に異なります。
X-OCN記録時
MPC‑3628

Imager Mode 撮像フレームレート
8.6K 3:2 1 ～ 30 FPS

8.2K 17:9
7.6K 16:9

1 ～ 60 FPS

5.8K 6:5 1 ～ 48 FPS
5.8K 17:9
5.4K 16:9

1 ～ 60、66、72、75、88、
90 FPS

MPC‑3626

Imager Mode 撮像フレームレート
6K 3:2 1 ～ 60 FPS

6K 1.85:1
6K 17:9
5.7K 16:9

1 ～ 60、66、72 FPS

6K 2.39:1 1 ～ 60、66、72、75、88、
90 FPS

4K 6:5 1 ～ 60、66、72 FPS
4K 4:3 1 ～ 60、66、72、75 FPS
4K 4:3 Surround View 1 ～ 30 FPS
4K 17:9
3.8K 16:9

1 ～ 60、66、72、75、88、90、
96、100、110 FPS

4K 17:9 Surround View
3.8K 16:9 Surround View

1 ～ 48 FPS

4K 2.39:1 1 ～ 60、66、72、75、88、90、
96、100、110、120 FPS
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項目 内容
ProRes記録時
MPC‑3628

Imager Mode 撮像フレームレート
ProRes 4K / QFHD
4444 422 HQ

8.2K 17:9
7.6K 16:9

1 ～ 60 FPS 1 ～ 60 FPS

5.8K 6:5 1 ～ 48 FPS 1 ～ 48 FPS
5.8K 17:9
5.4K 16:9

1 ～ 60 FPS 1 ～ 60、66、72、
75 FPS

MPC‑3626

Imager Mode 撮像フレームレート
ProRes 4K / QFHD
4444 422 HQ

6K 17:9
5.7K 16:9

1 ～ 60 FPS 1 ～ 60、66、72 FPS

6K 2.39:1 1 ～ 60 FPS 1 ～ 60、66、72、
75 FPS

4K 6:5 1 ～ 60 FPS 1 ～ 60、66、72 FPS
4K 17:9
3.8K 16:9

1 ～ 60 FPS 1 ～ 60、66、72、75、
88、90 FPS

4K 17:9 Surround View
3.8K 16:9 Surround 
View

1 ～ 48 FPS 1 ～ 48 FPS

4K 2.39:1 1 ～ 60 FPS 1 ～ 60、66、72、75、
88、90 FPS

［ご注意］
以下に設定されている場合は、7以下の撮像フレームレートを設定できません。

 ‒ Base ISOがISO 3200 
 ‒ Base ISOがISO 2500かつ記録フォーマットがProRes

項目 内容
Exposure Index EI値を設定する。Change Baseボタン（ITEMキー 4）を押して、次の画面で2

つのChangeボタン（ITEMキー 1とITEMキー 3）を同時に押すと、Base ISOを
切り換えることができます。Base ISOの設定によって、設定値が次のように異
なります。
MPC‑3628

Base ISO 800：
200EI/250EI/320EI/400EI/500EI/640EI/800EI/1000EI/1250EI/
1600EI/2000EI/2500EI/3200EI

Base ISO 3200：
800EI/1000EI/1250EI/1600EI/2000EI/2500EI/3200EI/4000EI/ 
5000EI/6400EI/8000EI/10000EI/12800EI

MPC‑3626
Base ISO 500：

125EI/160EI/200EI/250EI/320EI/400EI/500EI/640EI/800EI/ 
1000EI/1250EI/1600EI/2000EI

Base ISO 2500：
640EI/800EI/1000EI/1250EI/1600EI/2000EI/2500EI/3200EI/ 
4000EI/5000EI/6400EI/8000EI/10000EI

Gain 基準感度を設定する。
－6dB/－3dB/0dB/3dB/6dB/9dB/12dB/15dB/18dB

［ご注意］
Technicalメニュー > Special Configuration > RM/RCP Paint Control（93ページ）
がOnで、RM‑B170などのリモートコントロールユニットが接続されていない場合のみ設
定できます。
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項目 内容
Shutter 電子シャッターの開角度／スピードを設定する。

Step/Cont.ボタン（ITEMキー 1）を押して、StepとCont.を切り換えることで選
択方法が変えられます。
Step：ステップシャッターとして登録されている最大16種類のプリセット値か
ら選択する。（選択後、Step Editボタンを（ITEMキー 4）を押すと、任意の設
定値をプリセット値から変更することができます。）

フルメニューのTechnical > System Configuration > Shutter Mode
（89ページ）の設定によって次のように選択肢が表示される。
Angle：開角度表示
工場出荷時の選択肢

360/180/172.8/144/90/45/22.5/11.2/5.6
Speed：スピード表示
工場出荷時の選択肢

1/24、1/25、1/30、1/50、1/60、1/100、1/120、1/250、1/500、
1/1000、1/20001)

[ご注意]
スピードの初期値はProject Frame Rate（56ページ）の設定によって次のよう
になります。
23.98/24：1/24, 25：1/25, 29.97：1/30, 47.95：1/48, 50：1/50, 59.94：
1/60

Cont.：設定可能な任意の開角度／スピードを選択する。
ND Filter NDフィルターのポジションを設定する。設定値は以下のとおりです。

Clear/0.3/0.6/0.9/1.2/1.5/1.8/2.1/2.4

項目 内容
LUT 各種出力映像に適用するLUTに関する設定を行う。Technicalメニュー > 

Special Configuration > RM/RCP Paint Control（93ページ）の設定に
よって設定値が異なる。
SDI 1/2

RM/RCP Paint ControlがOffのとき：Log/Look
SDI 1/2出力映像に適用するLUTを選択する。

RM/RCP Paint ControlがOnのとき：Log/HLG(Natural)/HLG(Live)/
User Gamma

SDI 1/2出力映像の設定値は、メニューのProjectカテゴリー > Input 
Color Spaceの設定で決まるため表示のみ。

SDI 3/4
RM/RCP Paint ControlがOffのとき：Log/Look

SDI 3/4出力映像に適用するLUTを選択する。
RM/RCP Paint ControlがOnのとき：Log/HLG(Natural)/HLG(Live)/

User Gamma
SDI 3/4出力映像の設定値は、メニューのProjectカテゴリー > Input 
Color Spaceの設定で決まるため表示のみ。

Monitor
RM/RCP Paint ControlがOffのとき：

Monitor出力映像に適用するLUTを選択する。
メニューのProjectカテゴリー > Input Color Spaceの設定によって、設定
値が次のように異なります。

S‑Gamut3.Cine/SLog3またはS‑Gamut3/SLog3：Log/s709/
R709(800%)/Look

ACEScct：Log/s709/R709(800%)/Look
RM/RCP Paint ControlがOnのとき：

Monitor出力映像の種類を選択する。
メニューのProjectカテゴリー > Input Color Spaceの設定によって、設定
値が次のように異なります。

S‑Gamut3.Cine/SLog3またはS‑Gamut3/SLog3：Log/
R709(800%)

HLG(Natural)：HLG(Natural)/R709(800%)
HLG(Live)：HLG(Live)/R709(800%)
Rec.2020/User Gamma：User	Gamma/R709‑Like
Rec.709/User Gamma：User Gamma
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項目 内容
Viewfinder

RM/RCP Paint ControlがOffのとき：
ビューファインダー・モニター画面出力映像に適用するLUTを選択する。
メニューのProjectカテゴリー > Input Color Spaceの設定によって、設定
値が次のように異なります。

S‑Gamut3.Cine/SLog3またはS‑Gamut3/SLog3：Log/s709/
R709(800%)/Look

ACEScct：Log/s709/R709(800%)/Look
RM/RCP Paint ControlがOnのとき：

ビューファインダー・モニター画面出力映像の種類を選択する。
メニューのProjectカテゴリー > Input Color Spaceの設定によって、設定
値が次のように異なります。

S‑Gamut3.Cine/SLog3またはS‑Gamut3/SLog3：Log/
R709(800%)

HLG(Natural)：HLG(Natural)
HLG(Live)：HLG(Live)
Rec.2020/User Gamma：User Gamma/R709-Like
Rec.709/User Gamma：User Gamma

ProRes(Recording)
RM/RCP Paint ControlがOffのとき：Log/Look

ProRes記録映像に適用するLUTを選択する。
RM/RCP Paint ControlがOnのとき：Log/HLG(Natural)/HLG(Live)/

User Gamma
ProRes記録映像の設定値は、メニューのProjectカテゴリー > Input 

Color Spaceの設定で決まるため表示のみ。

 ［ご注意］
Projectメニュー > Basic Setting > Recording Format（74ページ）がProRes
フォーマットの場合に表示され、設定できます。

Edit Look
Lookとして使用するLUTを設定する。
s709 / R709(800%) / S‑Gamut3.Cine/SLog3 / S‑Gamut3/SLog3 / 
User 3D LUT

WB（White Balance） ホワイトバランスの色温度／色合いを設定する。
工場出荷時の選択肢
3200K+00/4300K+00/5500K+00

（Step Editボタン（ITEMキー 4）を押すとホワイトバランスのプリセット値と
Tint値を変更できます。）
Auto White Bal.：オートホワイトバランスを実行する。

1) プロジェクトフレームレートが59.94の場合は1/60以降の値、50.0の場合は1/50以降の値、29.97の場合は1/30以降
の値、25.0の場合は1/25以降の値が選択肢となります。
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ユーザー機能画面
USERボタン（11ページ）を押すと、サブディ
スプレイにユーザー機能画面が表示され、ITEM
キー 1 ～ 5をアサイナブルボタン（User 1 ～ 5）と
して機能させることができます。
また、機能を割り当てて使用できるアサイナブル
ボタン（1 ～ 4）が4個（9ページ、10ページ、
11ページページ）と、ビューファインダー

（DVF-EL200）アサイナブルボタン（VF A ～ VF C）
があります。
これらのボタンへの機能の割り当てはユーザー機
能画面で行えるほか、フルメニューのProjectメ
ニュー > Assignable Buttonで行えます。
 

ITEMキー 4 ITEMキー 5 ITEMキー 6

ITEMキー 3ITEMキー 2ITEMキー 1

［ご注意］
アイリス設定表示対応レンズ装着時は、ユーザー機能画面
の左側中央にアイリスの位置が表示されます。

ボタンの機能を変更する

ユーザー機能画面のEdit（ITEMキー 6）を押すと
ユーザー機能選択画面が表示されます。ユーザー
機能選択画面で、User 1 ～ 5とアサイナブルボ
タン1 ～ 4、ビューファインダーアサイナブルボタ
ンA ～ Cの機能を設定します。

1 ユーザー機能選択画面で、変更したいボタ
ンにカーソルを合わせ、Select（ITEMキー 3）
を押す。
選択可能な機能が表示されます。

2 （ITEMキー 2）ボタン、 （ITEMキー 5）
ボタンまたはMENUダイヤルで、設定値を変
更する。

3 設定値が決まったら、Setボタン（ITEMキー 3）
を押す。
画面がユーザー機能画面に切り換わり、変
更した機能が表示されます。

工場出荷時には、それぞれ下表に示す機能が割り当てられています。

ボタン 機能 Assignable Buttonの設定
アサイナブル1 高輝度のためクリップされた箇所を赤色にして

ビューファインダーに表示する。
VF Highlight Clip Ind

アサイナブル2 未設定 Not Assigned
アサイナブル3 未設定 Not Assigned
アサイナブル4 未設定 Not Assigned
ITEMキー 1 未設定 Not Assigned
ITEMキー 2 未設定 Not Assigned
ITEMキー 3 未設定 Not Assigned
ITEMキー 4 高輝度のためクリップされた箇所を赤色にして

Monitor出力に表示する。
Monitor Highlight Clip Ind

ITEMキー 5 ファンの回転方法を設定する。 Fan Mode
ビューファインダーア
サイナブルA

ビューファインダーのピント拡大機能をオン／オ
フする。

VF Focus Magnifier

ビューファインダーア
サイナブルB

ビューファインダーに表示するフォルスカラー機
能をオン／オフする。

VF False Color

ビューファインダーア
サイナブルC

ビューファインダー・モニター画面出力映像への
情報の表示をオン／オフする。

VF Overlay

ITEMキー 1 ～ 5に割り当て可能な機能

Assignable Button
の設定

機能 再起動後の状態

No Assign 未設定 －
Fan Mode ファンの回転方法を選択する。

キーを押すたびにAuto→Max→Off in Rec/
Auto→Off in Rec/Maxと切り換わる。

設定を保持する

Auto Pixel 
Restoration

Auto Pixel Restorationを実行する。 －

PL-Mt Interface 
Position

PLマウントレンズのインターフェース位置を設定
する。
キーを押すたびにTop→Side→Offと切り換わ
る。

設定を保持する

SDI 1/2 Frame Line SDI 1/2出力映像へのフレームラインの重畳をオ
ン／オフする。

設定を保持する
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Assignable Button
の設定

機能 再起動後の状態

SDI 3/4 Frame Line SDI 3/4出力映像へのフレームラインの重畳をオ
ン／オフする。

設定を保持する

SDI Overlay SDI出力映像への情報の表示をオン／オフする。 設定を保持する
Press&Hold for 
SDI12 Log

押している間だけSDI 1/2出力映像に適用してい
るLUTをOffにして、LUTを適用しないLogの画
質にする。

設定を保持しない

Press&Hold for 
SDI34 Log

押している間だけSDI 3/4出力映像に適用してい
るLUTをOffにして、LUTを適用しないLogの画
質にする。
SDI 3/4出力とMonitor出力が連動している場
合は、Press & Hold for Moni Logも有効にな
る。

設定を保持しない

Monitor Frame Line Monitor出力映像へのフレームラインの重畳を
オン／オフする。

設定を保持する

Monitor Overlay Monitor出力映像への情報の表示をオン／オフ
する。

設定を保持する

Press & Hold for 
Moni Log4)

押している間だけMonitor出力映像に適用して
いるLUTをOffにして、LUTを適用しない画質に
する。
SDI 3/4出力とMonitor出力が連動している場
合は、Press&Hold for SDI34 Logも有効にな
る。
また、HDMI出力とMonitor出力が連動してい
る場合は、HDMI出力も有効になる。

設定を保持しない

Monitor Focus 
Magnifier2)3)

Monitor出力映像のピント拡大機能をオン／オ
フする。

設定を保持しない

Monitor Highlight 
Clip Ind1)

高輝度のためクリップされた箇所を赤色にして
Monitor出力映像に表示する機能をオン／オフ
する。

設定を保持する

Monitor False 
Color1)

モニターに表示するフォルスカラー機能をオン／
オフする。

設定を保持する

Line A: Aspect 
Ratio Disp.

Line AのAspect Ratioの表示をオン／オフす
る。

設定を保持する

Line B: Aspect 
Ratio Disp.

Line BのAspect Ratioの表示をオン／オフす
る。

設定を保持する

Assignable Button
の設定

機能 再起動後の状態

Line A: User Frame 
Disp.

Line AのUser Frame Line 1およびUser 
Frame Line 2の表示をオン／オフする。
キーを押すたびにUser Frame Line 1と2を表
示→User Frame Line 1を表示→User Frame 
Line 2を表示→User Frame Line 1と2を非表
示と切り換わる。

設定を保持する

Line B: User Frame 
Disp.

Line BのUser Frame Line 1およびUser 
Frame Line 2の表示をオン／オフする。
キーを押すたびにUser Frame Line 1と2を表
示→User Frame Line 1を表示→User Frame 
Line 2を表示→User Frame Line 1と2を非表
示と切り換わる。

設定を保持する

H & V Flip7) 撮影モード時の画像の反転状態を切り換える。 設定を保持する
Anamorphic De‑
Squeeze

Projectメニュー > Basic Setting > Anamo. 
De‑Squeezeの設定を変更する。
キーを押すたびに、メニュー選択肢の並び順で
現在設定されている選択肢より1つ下位の選択
肢に設定変更する。

設定を保持する

Auto White 
Balance5)

オートホワイトバランスを実行する。 －

Color Bars5) カラーバーをオン／オフする。 設定を保持する
Picture Cache Rec ピクチャーキャッシュレック機能をオン／オフす

る。
設定を保持する

AXS Slot Change AXSメモリーカードが2枚挿入されているときの
アクティブスロットを切り換える。
キーを押すたびにAとBが切り換わる。

設定を保持する

Format Media AXS 
Slot A

AXS Slot Aをフォーマットする。 －

Format Media AXS 
Slot B

AXS Slot Bをフォーマットする。 －

Iris Open (1/16 
stop)6)

レンズのアイリスをOpen側に動かす。
押し続けると連続的にOpen端まで動き続ける。
電動アイリス対応のEマウントレンズ装着時に有
効な機能です。
1/16 stop刻みの設定に対して、アイリス表示は
1/3stop単位になります。

－
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Assignable Button
の設定

機能 再起動後の状態

Iris Close (1/16 
stop)6)

レンズのアイリスをClose側に動かす。
押し続けると連続的にClose端まで動き続ける。
電動アイリス対応のEマウントレンズ装着時に有
効な機能です。
1/16 stop刻みの設定に対して、アイリス表示は
1/3stop単位になります。

－

1） Technicalメニュー > Special Configuration > RM/RCP Paint Control（93ページ）がOnに設定されている場合
は、キーを押しても何も動作しません。

2) HDMI出力がMonitor出力と同じ出力フォーマットの場合、HDMI出力も連動します。Monitoringメニュー > 
Overlays/Frame Line > HDMI（81ページ）で設定を確認できます。HDMIがSame as Monitorに設定されている
場合、HDMI出力はMonitor出力と同じです。

3) SDIの出力フォーマットが1920x1080iの場合は、ピント拡大機能がオフになり、キーを押しても何も動作しません。
4) 押している間だけ、Projectメニュー > Basic Setting > Input Color Space（74ページ）で選択した本線と同じ映像

に切り換わります。
5） Technicalメニュー > Special Configuration > RM/RCP Paint Control（93ページ）がOnで、RM‑B170などのリ

モートコントロールユニット接続時は、キーを押しても何も動作しません。
6） RM‑B170などのリモートコントロールユニット接続時は、キーを押しても何も動作しません。
7) Monitoringメニュー > Output Display > Flip Image（79ページ）のH & V Flipがグレーアウトされているときは、

キーを押しても何も動作しません。

アサイナブル1 ～ 4ボタンに割り当て可能な機能

Assignable Button
の設定

機能 再起動後の状態

No Assign 未設定 －
SDI 1/2 Frame Line SDI 1/2出力映像へのフレームラインの重畳をオ

ン／オフする。
設定を保持する

SDI 3/4 Frame Line SDI 3/4出力映像へのフレームラインの重畳をオ
ン／オフする。

設定を保持する

SDI Overlay SDI出力映像への情報の表示をオン／オフする。 設定を保持する
Press&Hold for 
SDI12 Log

押している間だけSDI 1/2出力映像に適用してい
るLUTをOffにして、LUTを適用しないLogの画
質にする。

設定を保持しない

Press&Hold for 
SDI34 Log

押している間だけSDI 3/4出力映像に適用してい
るLUTをOffにして、LUTを適用しないLogの画
質にする。
SDI 3/4出力とMonitor出力が連動している場
合は、Press & Hold for Moni Logも有効にな
る。

設定を保持しない

Monitor Frame Line Monitor出力映像へのフレームラインの重畳を
オン／オフする。

設定を保持する

Monitor Overlay Monitor出力映像への情報の表示をオン／オフ
する。

設定を保持する

Press & Hold for 
Moni Log4)

押している間だけMonitor出力映像に適用して
いるLUTをOffにして、LUTを適用しない画質に
する。
SDI 3/4出力とMonitor出力が連動している場
合は、Press&Hold for SDI34 Logも有効にな
る。
また、HDMI出力とMonitor出力が連動してい
る場合は、HDMI出力も有効になる。

設定を保持しない

Monitor Focus 
Magnifier2)3)

Monitor出力映像のピント拡大機能をオン／オ
フする。

設定を保持しない

Monitor Highlight 
Clip Ind1)

高輝度のためクリップされた箇所を赤色にして
Monitor出力映像に表示する機能をオン／オフ
する。

設定を保持する
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Assignable Button
の設定

機能 再起動後の状態

Monitor High/Low 
Key1)

Monitor出力の状態を選択する。
ボタンを押すたびにHigh Key（高輝度の白飛び
確認画面）→Low Key（低輝度の暗部の確認画
面）→Off（通常画面）と切り換わる。

設定を保持しない

Monitor False 
Color1)

モニターに表示するフォルスカラー機能をオン／
オフする。

設定を保持する

VF Frame Line ビューファインダー・モニター画面出力映像への
フレームラインの重畳をオン／オフする。

設定を保持する

VF Overlay ビューファインダー・モニター画面出力映像への
情報の表示をオン／オフする。

設定を保持する

Press & Hold for VF 
Log6)

押している間だけビューファインダー・モニター
画面出力映像に適用しているLUTをOffにして、
LUTを適用しない画質にする。

設定を保持しない

VF Focus Magnifier ビューファインダーのピント拡大機能をオン／オ
フする。

設定を保持しない

VF Highlight Clip 
Ind1)

高輝度のためクリップされた箇所を赤色にして
ビューファインダーに表示する機能をオン／オフ
する。

設定を保持する

VF High/Low Key1) ビューファインダー出力の状態を選択する。
ボタンを押すたびにHigh Key（高輝度の白飛び
確認画面）→Low Key（低輝度の暗部の確認画
面）→Off（通常画面）と切り換わる。

設定を保持しない

VF False Color1) ビューファインダーに表示するフォルスカラー機
能をオン／オフする。

設定を保持する

VF Zebra ビューファインダー・モニター画面出力映像のゼ
ブラ機能をオン／オフする。

設定を保持する

Line A: Aspect 
Ratio Disp.

Line AのAspect Ratioの表示をオン／オフす
る。

設定を保持する

Line B: Aspect 
Ratio Disp.

Line BのAspect Ratioの表示をオン／オフす
る。

設定を保持する

Line A: User Frame 
Disp.

Line AのUser Frame Line 1およびUser 
Frame Line 2の表示をオン／オフする。
ボタンを押すたびにUser Frame Line 1と2を表
示→User Frame Line 1を表示→User Frame 
Line 2を表示→User Frame Line 1と2を非表
示と切り換わる。

設定を保持する

Assignable Button
の設定

機能 再起動後の状態

Line B: User Frame 
Disp.

Line BのUser Frame Line 1およびUser 
Frame Line 2の表示をオン／オフする。
ボタンを押すたびにUser Frame Line 1と2を表
示→User Frame Line 1を表示→User Frame 
Line 2を表示→User Frame Line 1と2を非表
示と切り換わる。

設定を保持する

H & V Flip8) 撮影モード時の画像の反転状態を切り換える。 設定を保持する
Anamorphic 
De‑Squeeze

Projectメニュー > Basic Setting > Anamo. 
De‑Squeezeの設定を変更する。
ボタンを押すたびに、メニュー選択肢の並び順
で現在設定されている選択肢より1つ下位の選
択肢に設定変更する。

設定を保持する

Auto White 
Balance5)

オートホワイトバランスを実行する。 －

Color Bars5) カラーバーをオン／オフする。 設定を保持する
Rec 記録を開始／停止する。 －
Rec Review レックレビュー機能の実行。 設定を保持しない
Picture Cache Rec ピクチャーキャッシュレック機能をオン／オフす

る。
設定を保持する

AXS Slot Change AXSメモリーカードが2枚挿入されているときの
アクティブスロットを切り換える。
ボタンを押すたびにAとBが切り換わる。

設定を保持する

ND +1stop NDフィルターを濃度の濃い側に切り換える。 －
ND ‑1stop NDフィルターを濃度の薄い側に切り換える。 －
Iris Open (1/16 
stop)7)

レンズのアイリスをOpen側に動かす。
押し続けると連続的にOpen端まで動き続ける。
電動アイリス対応のEマウントレンズ装着時に有
効な機能です。
1/16 stop刻みの設定に対して、アイリス表示は
1/3stop単位になります。

－

Iris Close (1/16 
stop)7)

レンズのアイリスをClose側に動かす。
押し続けると連続的にClose端まで動き続ける。
電動アイリス対応のEマウントレンズ装着時に有
効な機能です。
1/16 stop刻みの設定に対して、アイリス表示は
1/3stop単位になります。

－

1） Technicalメニュー > Special Configuration > RM/RCP Paint Control（93ページ）がOnに設定されている場合
は、ボタンを押しても何も動作しません。
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2) HDMI出力がMonitor出力と同じ出力フォーマットの場合、HDMI出力も連動します。Monitoringメニュー > 
Overlays/Frame Line > HDMI（81ページ）で設定を確認できます。HDMIがSame as Monitorに設定されている
場合、HDMI出力はMonitor出力と同じです。

3) SDIの出力フォーマットが1920x1080iの場合は、ピント拡大機能がオフになり、ボタンを押しても何も動作しません。
4) 押している間だけ、Projectメニュー > Basic Setting > Input Color Space（74ページ）で選択した本線と同じ映像

に切り換わります。
5） Technicalメニュー > Special Configuration > RM/RCP Paint Control（93ページ）がOnで、RM‑B170などのリ

モートコントロールユニット接続時は、ボタンを押しても何も動作しません。
6) Technicalメニュー > Special Configuration > RM/RCP Paint Control（93ページ）がOnで、Shootingメニュー 

> LUT Select > VF LUT（72ページ）がR709(800%)またはR709‑Likeに設定されている場合は、押している間だけ
本線と同じ映像に切り換わります。または、RM/RCP Paint ControlがOffで、VF LUTがLog以外に設定されている場
合は、押している間だけ本線と同じ映像に切り換わります。

7） RM‑B170などのリモートコントロールユニット接続時は、ボタンを押しても何も動作しません。
8) Monitoringメニュー > Output Display > Flip Image（79ページ）のH & V Flipがグレーアウトされているときは、

ボタンを押しても何も動作しません。

ビューファインダー（DVF‑EL200）アサイナブルA ～ Cボタン
に割り当て可能な機能

Assignable Button
の設定

機能 再起動後の状態

No Assign 未設定 －
VF Frame Line ビューファインダー・モニター画面出力映像への

フレームラインの重畳をオン／オフする。
設定を保持する

VF Overlay ビューファインダー・モニター画面出力映像への
情報の表示をオン／オフする。

設定を保持する

Press & Hold for VF 
Log2)

押している間だけビューファインダー・モニター
画面出力映像に適用しているLUTをOffにして、
LUTを適用しない画質にする。

設定を保持しない

VF Focus Magnifier ビューファインダーのピント拡大機能をオン／オ
フする。

設定を保持しない

VF Highlight Clip 
Ind3)

高輝度のためクリップされた箇所を赤色にして
ビューファインダーに表示する機能をオン／オフ
する。

設定を保持する

VF High/Low Key3) ビューファインダー出力の状態を選択する。
ボタンを押すたびにHigh Key（高輝度の白飛び
確認画面）→Low Key（低輝度の暗部の確認画
面）→Off（通常画面）と切り換わる。

設定を保持しない

Assignable Button
の設定

機能 再起動後の状態

VF False Color3) ビューファインダーに表示するフォルスカラー機
能をオン／オフする。

設定を保持する

VF Zebra ビューファインダー・モニター画面出力映像のゼ
ブラ機能をオン／オフする。

設定を保持する

Line A: Aspect 
Ratio Disp.

Line AのAspect Ratioの表示をオン／オフす
る。

設定を保持する

Line B: Aspect 
Ratio Disp.

Line BのAspect Ratioの表示をオン／オフす
る。

設定を保持する

Line A: User Frame 
Disp.

Line AのUser Frame Line 1およびUser 
Frame Line 2の表示をオン／オフする。
ボタンを押すたびにUser Frame Line 1と2を表
示→User Frame Line 1を表示→User Frame 
Line 2を表示→User Frame Line 1と2を非表
示と切り換わる。

設定を保持する

Line B: User Frame 
Disp.

Line BのUser Frame Line 1およびUser 
Frame Line 2の表示をオン／オフする。
ボタンを押すたびにUser Frame Line 1と2を表
示→User Frame Line 1を表示→User Frame 
Line 2を表示→User Frame Line 1と2を非表
示と切り換わる。

設定を保持する

H & V Flip5) 撮影モード時の画像の反転状態を切り換える。 設定を保持する
Anamorphic 
De‑Squeeze

Projectメニュー > Basic Setting > Anamo. 
De‑Squeezeの設定を変更する。
ボタンを押すたびに、メニュー選択肢の並び順
で現在設定されている選択肢より1つ下位の選
択肢に設定変更する。

設定を保持する

Color Bars1) カラーバーをオン／オフする。 設定を保持する
Rec 記録を開始／停止する。 －
Rec Review レックレビュー機能の実行。 設定を保持しない
Picture Cache Rec ピクチャーキャッシュレック機能をオン／オフす

る。
設定を保持する

AXS Slot Change AXSメモリーカードが2枚挿入されているときの
アクティブスロットを切り換える。
ボタンを押すたびにAとBが切り換わる。

設定を保持する

ND +1stop NDフィルターを濃度の濃い側に切り換える。 －
ND ‑1stop NDフィルターを濃度の薄い側に切り換える。 －
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Assignable Button
の設定

機能 再起動後の状態

Iris Open (1/16 
stop)4)

レンズのアイリスをOpen側に動かす。
押し続けると連続的にOpen端まで動き続ける。
電動アイリス対応のEマウントレンズ装着時に有
効な機能です。
1/16 stop刻みの設定に対して、アイリス表示は
1/3stop単位になります。

－

Iris Close (1/16 
stop)4)

レンズのアイリスをClose側に動かす。
押し続けると連続的にClose端まで動き続ける。
電動アイリス対応のEマウントレンズ装着時に有
効な機能です。
1/16 stop刻みの設定に対して、アイリス表示は
1/3stop単位になります。

－

1） Technicalメニュー > Special Configuration > RM/RCP Paint Control（93ページ）がOnで、RM‑B170などのリ
モートコントロールユニット接続時は、ボタンを押しても何も動作しません。

2) 押している間だけ、Projectメニュー > Basic Setting > Input Color Space（74ページ）で選択した本線と同じ映像
に切り換わります。

3） Technicalメニュー > Special Configuration > RM/RCP Paint Control（93ページ）がOnに設定されている場合
は、ボタンを押しても何も動作しません。

4） RM‑B170などのリモートコントロールユニット接続時は、ボタンを押しても何も動作しません。
5) Monitoringメニュー > Output Display > Flip Image（79ページ）のH & V Flipがグレーアウトされているときは、

ボタンを押しても何も動作しません。
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メニューの操作方法
撮影中（記録中/記録待機中）および再生中に
MENUボタンを押すと、サブディスプレイにメ
ニュー画面が表示され、操作することができます。
• Projectカテゴリー：基本設定、記録フォーマッ

トの設定
• TC/Mediaカテゴリー：タイムコードの値やTC

フォーマットの設定
• Monitoringカテゴリー：SDI、HDMI、

Monitorの各外部出力の信号フォーマットや
OSDやマーカーの重畳状態の設定

• Audioカテゴリー：オーディオのソースやレベ
ルなどの設定

• Infoカテゴリー：カメラやメディア、バッテリー
などの状態確認

操作部

MENUボタン（10ページ）
サブディスプレイにメニューが表示されます。

ITEMキー 1 ～ 6（10ページ）
メニューのカテゴリーを選びます。

SEL/SET ダイヤル（MENUダイヤル） 
（10ページ）

回すとカーソルが上下に移動して、設定項目や設
定値を選択できます。
MENUダイヤルを押すと、選択している項目を決
定します。

BACKボタン（11ページ）
1つ前の階層に戻ります。確定前の変更はキャン
セルされます。

基本操作

1 MENUボタンを押す。
メニュー画面が表示されます。

2 ITEMキー 1 ～ 6で設定したいカテゴリーを
選ぶ。

3 MENUダイヤルで、選択項目にカーソルを合
わせる。
各設定項目には、設定値が表示されていま
す。

˜˜「メニュー設定項目一覧」（56ページ）

4 MENUダイヤルを押す。
選んだ項目の横に、設定値の選択画面が表
示されます。

5 MENUダイヤルで設定値にカーソルを合わせ
る。

6 MENUダイヤルを押して決定する。



3章　カメラ操作：メニューの操作方法56

メニュー設定項目一覧

各カテゴリーの設定内容は以下のとおりです。

Projectカテゴリー

太字とアンダーラインで表示されている設定値は、出荷時の設定です。

項目 設定値 内容
Imager Mode MPC-3628

8.6K 3:2/8.2K 17:9/ 
7.6K 16:9/5.8K 6:5/ 
5.8K	17:9/5.4K 16:9
MPC-3626
6K 3:2/6K 1.85:1/6K 17:9/ 
6K 2.39:1/5.7K 16:9/ 
4K 6:5/4K 4:3/4K 4:3 
Surround View/4K	17:9/ 
4K 17:9 Surround View/ 
4K 2.39:1/3.8K 16:9/3.8K 
16:9 Surround View

有効画サイズを設定する。

［ご注意］
• 5.8K 6:5はアナモフィックライセンスインストール

時のみ表示されます。
• 7.6K 16:9/8.2K 17:9/8.6K 3:2はフルフレームラ

イセンスインストール時のみ表示されます。
• 6K 3:2/6K 1.85:1/6K 17:9/6K 2.39:1/5.7K 16:9

はフルフレームライセンスインストール時のみ表示
されます。

• 4K 6:5/4K 4:3/4K 4:3 Surround Viewはアナモ
フィックライセンスインストール時のみ表示されま
す。

Project Frame Rate 23.98/24/25/29.97/47.95/ 
50/59.94

プロジェクトフレームレートを設定する。

Input Color Space RM/RCP Paint Control
（93ページ）がOffのとき：

S-Gamut3.Cine/
SLog3 / S‑Gamut3/
SLog3 / ACEScct

RM/RCP Paint Controlが
Onのとき：
S-Gamut3.Cine/
SLog3 / S‑Gamut3/
SLog3 / ACEScct 
/ HLG(Natural) / 
HLG(Live) / Rec.2020/
User Gamma / 
Rec.709/User Gamma

色域を設定する。

［ご注意］
HLG(Natural)はHLG BT.2100と同等です。

Recording Format1) X‑OCN XT/X-OCN	ST/
X‑OCN LT/ProRes 4444 
4K/ProRes 4444 QFHD/
ProRes 422 HQ 4K/ProRes 
422 HQ QFHD

AXSメモリーカードに記録するフォーマットを
設定する。

項目 設定値 内容
Anamo. De‑Squeeze Off(1.0x)/1.25x/1.3x/1.5x/

1.65x/1.8x/2.0x
ProRes記録信号およびビデオ出力信号のデス
クイーズ変換処理を行うかを設定する。
アナモフィックライセンスがインストールされ
ていて、Imager Modeの設定が4K 4:3/4K 
4:3 Surround View/4K 6:5/4K 17:9/4K 
17:9 Surround View/5.8K 6:5/5.8K 17:9、
またはアナモフィックライセンスとフルフレーム
ライセンスがインストールされていて、Imager 
Modeの設定が6K 3:2/6K 17:9/8.2K 
17:9/8.6K 3:2のときに設定できます。ただし、
画サイズによって選択肢が異なります。

MPC‑3628

Imager Mode Anamo. De‑Squeeze
Off(1.0x) 1.25x 1.3x 1.5x 1.65x 1.8x 2.0x

8.6K 3:2 ○ ○ ○ ○ ○ ○ ○
8.2K 17:9 ○ ○ ○ － ○ ○ ○
7.6K 16:9 ○ － － － － － －
5.8K 6:5 ○ － － － － － ○
5.8K 17:9 ○ ○ ○ － ○ ○ ○
5.4K 16:9 ○ － － － － － －
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項目 設定値 内容
MPC‑3626

Imager Mode Anamo. De‑Squeeze
Off(1.0x) 1.25x 1.3x 1.5x 1.65x 1.8x 2.0x

6K 3:2 ○ ○ ○ ○ ○ ○ ○
6K 1.85:1 ○ － － － － － －
6K 17:9 ○ ○ ○ － ○ ○ ○
6K 2.39:1 ○ － － － － － －
5.7K 16:9 ○ － － － － － －
4K 6:5 ○ － － － － － ○
4K 4:3 Surround ○ － ○ － ○ ○ ○
4K 4:3 ○ － ○ － ○ ○ ○
4K 17:9 Surround ○ ○ ○ － ○ ○ ○
4K 17:9 ○ ○ ○ － ○ ○ ○
4K 2.39:1 ○ － － － － － －
3.8K 16:9 
Surround

○ － － － － － －

3.8K 16:9 ○ － － － － － －

Zoom to Fit Off/17:9/16:9 ビューファインダー画面、またはMonitor出力
に対して、記録映像を切り出して拡大表示する
かを設定する。

［ご注意］
• 以下の条件で設定できます 

Imager Mode：8K 3:2/6K 3:2 
Recording Format：X‑OCN 
Anamo. De‑Squeeze：Off(1.0x)

• Project Frame Rateが47.95のときは、16:9を
選択できません。

• 17:9または16:9からOffに変更した場合は、SDI
出力フォーマットが初期値に戻ります。

Project Details（ITEM
キー 6）

フルメニューのProjectメニュー（74ページ）
の内容が表示されます。

1) 有効画サイズやプロジェクトフレームレートの組み合わせによって、設定可能な記録フォーマットは異なります。「記録
フォーマット設定表」（61ページ）を参照し、設定してください。

TC/Mediaカテゴリー

太字とアンダーラインで表示されている設定値は、出荷時の設定です。

項目 設定値 内容
TC Mode Preset F‑Run (Ext‑Lk)/

Preset	R-Run/Int Regen
タイムコードの歩進モードを設定する。
Preset F‑Run (Ext‑Lk)：記録に関係な
く設定された状態から常に歩進する。
Preset R‑Run：記録時のみ設定され
た状態から歩進する。
Int Regen：前のクリップのタイムコー
ドに続けて歩進する。

TC Display Timecode/Duration タイムデータの表示を切り換える。

TC Setting
（別画面に移行して
設定）

Setting 
(H、M、S、F)

タイムコードを任意の値に設定する。

Reset タイムコードを00:00:00:00にリセッ
トする。

TC Format DF/NDF タイムコードのフォーマットを設定す
る。
DF：ドロップフレーム
NDF：ノンドロップフレーム

TC Source Internal/External 表示のみ。

Camera ID A～ Z クリップ名の生成時のカメラIDを設定
する。
クリップ名：Camera ID + Reel 
Number + Shot Number + 年月日 + 
ランダム文字列

Reel Number 001～ 999 クリップ名の生成時のReel Numberの
数字部分を設定する。
クリップ名：Camera ID + Reel 
Number + Shot Number + 年月日 + 
ランダム文字列

Camera Position C/L/R クリップ名の生成時のShot Number
の先頭文字部分を設定する。
クリップ名：Camera ID + Reel 
Number + Shot Number + 年月日 + 
ランダム文字列
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項目 設定値 内容
Format Media

（別画面に移行して
実行）

AXS Slot A スロットAのAXSメモリーカードを初期
化する。

AXS Slot B スロットBのAXSメモリーカードを初期
化する。

SD Card SDカードを初期化する。
Media Details

（ITEMキー 6）
フルメニューのTC/Mediaメニュー

（78ページ）の内容が表示されます。

Monitoringカテゴリー

太字とアンダーラインで表示されている設定値は、出荷時の設定です。

[ご注意]
• 本機では、Status InfoとFrame Lineの2種類を系統別に設定できます。AとBの出力映像の表示情報は、Monitoring

メニュー（79ページ）で設定してください。
• Output Formatの設定によってInfoおよびFrame Lineが表示できない場合があります。その際は「‑」が表示され、設

定値の変更ができません。

項目 設定値 内容
VF Overlay Info	A/Info B/Rec Ind./

Off
ビューファインダーの映像に重畳して表
示する情報を選択する。

Frame Line Line A/Line B/Off ビューファインダーの映像に重畳して表
示するフレームラインを選択する。

SDI 1/2 Output 
Format

Imager Mode、プロ
ジェクトフレームレート、
Recording Formatの設定
に応じて変わる。

SDI 1/2出力フォーマットを選択する。1)

Overlay Info A/Info	B/Rec Ind./
Off

SDI 1/2出力には情報表示は重畳され
ません。

Frame Line Line A/Line B/Off SDI 1/2出力に重畳して表示するフレー
ムラインを選択する。

［ご注意］
出力フォーマットが4K/QFHD以外のときは
フレームラインは重畳されません。

項目 設定値 内容
SDI 3/4

[ご注意]
SDI 1/2のOutput 
Formatの設定に
よっては、SDI 3/4
のOutput Format、
Info、Frame Lineが
空欄となり、設定値の
変更ができません。

Output 
Format

SDI 1/2の設定に応じて変わ
る。

SDI 3/4出力フォーマットを選択する。1)

Overlay Info A/Info	B/Rec Ind./
Off

SDI 3/4出力に重畳して表示する情報
を選択する。

Frame Line Line A/Line B/Off SDI 3/4出力に重畳して表示するフレー
ムラインを選択する。

Monitor Output 
Format

SDI 1/2の設定に応じて変わ
る。

Monitor出力フォーマットを選択する。2)

Overlay Info A/Info	B/Rec Ind./
Off

Monitor出力に重畳して表示する情報
を選択する。

Frame Line Line A/Line B/Off Monitor出力に重畳して表示するフ
レームラインを選択する。

HDMI Output 
Format

SDI 1/2の設定に応じて変わ
る。

HDMI出力フォーマットを選択する。2)

Overlay Info A/Info	B/Rec Ind./
Off

HDMI出力に重畳して表示するフレーム
ラインを選択する。

Frame Line Line A/Line B/Off HDMI出力に重畳して表示する情報を
選択する。

Moni. Details
（ITEMキー 6）

フルメニューのMonitoringメニュー
（79ページ）の内容が表示されます。

1) 選択可能なフォーマットは「SDI OUT端子の出力フォーマット」（128ページ）を参照してください。
2) 選択可能なフォーマットは「MONITOR OUT端子/HDMI OUT端子の出力フォーマット」（133ページ）を参照してくだ

さい。

Audioカテゴリー

太字とアンダーラインで表示されている設定値は、出荷時の設定です。

項目 設定値 内容
Source Switch LINE / AES/EBU / MIC CH‑1とCH‑2の入力源を設定するAUDIO INス

イッチ（11ページ）の位置が表示される。

［ご注意］
Audioメニュー > Audio InputのInternal Mic 
Select（86ページ）がCH‑1/CH‑2に設定されている
ときは、Source Switchの入力源はCH‑3とCH‑4に
反映されます。
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項目 設定値 内容
XLR Audio L Level Auto/Manual/Fixed

－99 ～±0～＋99
Autoにすると、録音レベルは自動調整される。
Manualを選択時、手動で録音レベルを調整す
る。

［ご注意］
Source Switchの入力源がAES/EBUのときはFixed
固定になります。

XLR Audio R Level Auto/Manual/Fixed
－99 ～±0～＋99

Autoにすると、録音レベルは自動調整される。
Manualを選択時、手動で録音レベルを調整す
る。

［ご注意］
Source Switchの入力源がAES/EBUのときはFixed
固定になります。

XLR Mic Reference －60dB/－50dB/－40dB マイクの基準入力レベルを選択する。

Monitor CH Monitor Output CH Pairが
CH‑1/CH‑2の場合
CH-1/CH-2、CH‑1、
CH‑2

Monitor Output CH Pairが
CH‑3/CH‑4の場合
CH-3/CH-4、CH‑3、
CH‑4

ヘッドホンおよびスピーカーに出力する音声チャ
ンネルを選択する。

Monitor Level 0～ 99 モニター音量を調整する。

CH1 Level Meter － CH1のレベルメーターが表示される。

CH2 Level Meter － CH2のレベルメーターが表示される。

CH3 Level Meter － CH3のレベルメーターが表示される。

CH4 Level Meter － CH4のレベルメーターが表示される。

Audio Details（ITEM
キー 6）

フルメニューのAudioメニュー（86ページ）
の内容が表示されます。

Infoカテゴリーで本機の状態を確認する

Infoカテゴリーでは、メディアやバッテリーなどの状態や、発生している警告やエラーの内容を確認で
きます。本機の状態の変化に応じて、表示内容がリアルタイムに更新されます。
Infoカテゴリーは、次の9種類の情報ページで構成されています。MENUダイヤルを回すと、ページを
移動できます。

No. ページ 内容
1 Camera Condition 警告メッセージとエラーメッセージが表示されます。何もメッ

セージがないときは、一番上の表示エリアに「All Systems 
are OK」が表示されます。

2 Firmware 本機のシリアルナンバーやファームウェアバージョンが表示さ
れます。

3 License 本機のオプションのライセンス名称とインストール状態または
期限が表示されます。オプションを追加していないときは、イ
ンストール状態表示は「Not Installed」または「Expired」とな
ります。

4 System 次のシステム情報が表示されます。
• 設定日時
• ファン回転速度
• センサー検出温度
• アワーズメーター
• IP Address

［ご注意］
• センサー検出温度は、検出温度が65℃以上のときはHigh Tempの

警告状態となります。
• IPアドレスを取得できない場合は「0.0.0.0」が表示されます。

5 Battery 次のバッテリー情報が表示されます。
• 検出されたバッテリーの品名または種類
• 残容量（パーセント）
• 予想残時間
• 残容量（Ah）
• 電圧（V）
• 充電を行った回数
• 電源供給源
• 供給電源電圧

6 Media AXSメモリーカード、SDカードの残量と記録可能時間、寿命
データが表示されます。
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No. ページ 内容
7 Lens 本機に装着されている次のレンズ情報が表示されます。

• レンズの型名
• アイリスのT値
 ［ご注意］

T値が取得できない場合など、T値ではなくF値が表示される場合
があります。

• 焦点距離
• フォーカス距離
• 被写界深度
• シリアルナンバー

8 Network 次のネットワーク接続の設定情報が表示されます。
• 設定状態（LAN/Wireless Access Point/Wireless 

Station/Off）
• IP Address
• SSID
• MAC Address

［ご注意］
IPアドレスを取得できない場合は「0.0.0.0」が表示されます。

9 False Color Setting Table 次のFalse Colorの設定情報が表示されます。
• 設定色
• 設定下限値～上限値
• 説明

［ご注意］
設定下限値～上限値が初期値と異なる場合は、文字の色がグレーにな
ります。
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記録フォーマット設定表

有効画サイズやプロジェクトフレームレートの組み合わせによって、以下の記録フォーマットの設定が可能です。

MPC‑3628

有効画サイズ（Imager Mode） 記録フォーマット Project Frame Rate
23.98 24.00 25.00 29.97 47.95 50.00 59.94

8.6K 3:2 X‑OCN XT ○ ○ ○ ○ － － －
X‑OCN ST ○ ○ ○ ○ － － －
X‑OCN LT ○ ○ ○ ○ － － －
4K ProRes 4444 － － － － － － －
QFHD ProRes 4444 － － － － － － －
4K ProRes 422 HQ － － － － － － －
QFHD ProRes 422 HQ － － － － － － －

8.2K 17:9 X‑OCN XT ○ ○ ○ ○ － － －
X‑OCN ST ○ ○ ○ ○ ○ ○ ○
X‑OCN LT ○ ○ ○ ○ ○ ○ ○
4K ProRes 4444 ○ ○ ○ ○ － ○ ○
QFHD ProRes 4444 － － － － － － －
4K ProRes 422 HQ ○ ○ ○ ○ － ○ ○
QFHD ProRes 422 HQ － － － － － － －

7.6K 16:9 X‑OCN XT ○ ○ ○ ○ － － －
X‑OCN ST ○ ○ ○ ○ － ○ ○
X‑OCN LT ○ ○ ○ ○ － ○ ○
4K ProRes 4444 － － － － － － －
QFHD ProRes 4444 ○ ○ ○ ○ － ○ ○
4K ProRes 422 HQ － － － － － － －
QFHD ProRes 422 HQ ○ ○ ○ ○ － ○ ○
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有効画サイズ（Imager Mode） 記録フォーマット Project Frame Rate
23.98 24.00 25.00 29.97 47.95 50.00 59.94

5.8K 6:5 X‑OCN XT ○ ○ ○ ○ ○ － －
X‑OCN ST ○ ○ ○ ○ ○ － －
X‑OCN LT ○ ○ ○ ○ ○ － －
4K ProRes 4444 ○ ○ ○ ○ － － －
QFHD ProRes 4444 － － － － － － －
4K ProRes 422 HQ ○ ○ ○ ○ － － －
QFHD ProRes 422 HQ － － － － － － －

5.8K 17:9 X‑OCN XT ○ ○ ○ ○ ○ ○ ○
X‑OCN ST ○ ○ ○ ○ ○ ○ ○
X‑OCN LT ○ ○ ○ ○ ○ ○ ○
4K ProRes 4444 ○ ○ ○ ○ － ○ ○
QFHD ProRes 4444 － － － － － － －
4K ProRes 422 HQ ○ ○ ○ ○ － ○ ○
QFHD ProRes 422 HQ － － － － － － －

5.4K 16:9 X‑OCN XT ○ ○ ○ ○ － ○ ○
X‑OCN ST ○ ○ ○ ○ － ○ ○
X‑OCN LT ○ ○ ○ ○ － ○ ○
4K ProRes 4444 － － － － － － －
QFHD ProRes 4444 ○ ○ ○ ○ － ○ ○
4K ProRes 422 HQ － － － － － － －
QFHD ProRes 422 HQ ○ ○ ○ ○ － ○ ○

MPC‑3626

有効画サイズ（Imager Mode） 記録フォーマット Project Frame Rate
23.98 24.00 25.00 29.97 47.95 50.00 59.94

6K 3:2 X‑OCN XT ○ ○ ○ ○ ○ ○ ○
X‑OCN ST ○ ○ ○ ○ ○ ○ ○
X‑OCN LT ○ ○ ○ ○ ○ ○ ○
4K ProRes 4444 － － － － － － －
QFHD ProRes 4444 － － － － － － －
4K ProRes 422 HQ － － － － － － －
QFHD ProRes 422 HQ － － － － － － －
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有効画サイズ（Imager Mode） 記録フォーマット Project Frame Rate
23.98 24.00 25.00 29.97 47.95 50.00 59.94

6K 1.85:1 X‑OCN XT ○ ○ ○ ○ ○ ○ ○
X‑OCN ST ○ ○ ○ ○ ○ ○ ○
X‑OCN LT ○ ○ ○ ○ ○ ○ ○
4K ProRes 4444 － － － － － － －
QFHD ProRes 4444 － － － － － － －
4K ProRes 422 HQ － － － － － － －
QFHD ProRes 422 HQ － － － － － － －

6K 17:9 X‑OCN XT ○ ○ ○ ○ ○ ○ ○
X‑OCN ST ○ ○ ○ ○ ○ ○ ○
X‑OCN LT ○ ○ ○ ○ ○ ○ ○
4K ProRes 4444 ○ ○ ○ ○ － ○ ○
QFHD ProRes 4444 － － － － － － －
4K ProRes 422 HQ ○ ○ ○ ○ － ○ ○
QFHD ProRes 422 HQ － － － － － － －

6K 2.39:1 X‑OCN XT ○ ○ ○ ○ ○ ○ ○
X‑OCN ST ○ ○ ○ ○ ○ ○ ○
X‑OCN LT ○ ○ ○ ○ ○ ○ ○
4K ProRes 4444 ○ ○ ○ ○ － ○ ○
QFHD ProRes 4444 － － － － － － －
4K ProRes 422 HQ ○ ○ ○ ○ － ○ ○
QFHD ProRes 422 HQ － － － － － － －

5.7K 16:9 X‑OCN XT ○ ○ ○ ○ － ○ ○
X‑OCN ST ○ ○ ○ ○ － ○ ○
X‑OCN LT ○ ○ ○ ○ － ○ ○
4K ProRes 4444 － － － － － － －
QFHD ProRes 4444 ○ ○ ○ ○ － ○ ○
4K ProRes 422 HQ － － － － － － －
QFHD ProRes 422 HQ ○ ○ ○ ○ － ○ ○
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有効画サイズ（Imager Mode） 記録フォーマット Project Frame Rate
23.98 24.00 25.00 29.97 47.95 50.00 59.94

4K 6:5 X‑OCN XT ○ ○ ○ ○ ○ ○ ○
X‑OCN ST ○ ○ ○ ○ ○ ○ ○
X‑OCN LT ○ ○ ○ ○ ○ ○ ○
4K ProRes 4444 ○ ○ ○ ○ － ○ ○
QFHD ProRes 4444 － － － － － － －
4K ProRes 422 HQ ○ ○ ○ ○ － ○ ○
QFHD ProRes 422 HQ － － － － － － －

4K 4:3 X‑OCN XT ○ ○ ○ ○ ○ ○ ○
X‑OCN ST ○ ○ ○ ○ ○ ○ ○
X‑OCN LT ○ ○ ○ ○ ○ ○ ○
4K ProRes 4444 － － － － － － －
QFHD ProRes 4444 － － － － － － －
4K ProRes 422 HQ － － － － － － －
QFHD ProRes 422 HQ － － － － － － －

4K 4:3 Surround X‑OCN XT ○ ○ ○ ○ － － －
X‑OCN ST ○ ○ ○ ○ － － －
X‑OCN LT ○ ○ ○ ○ － － －
4K ProRes 4444 － － － － － － －
QFHD ProRes 4444 － － － － － － －
4K ProRes 422 HQ － － － － － － －
QFHD ProRes 422 HQ － － － － － － －

4K 17:9 X‑OCN XT ○ ○ ○ ○ ○ ○ ○
X‑OCN ST ○ ○ ○ ○ ○ ○ ○
X‑OCN LT ○ ○ ○ ○ ○ ○ ○
4K ProRes 4444 ○ ○ ○ ○ － ○ ○
QFHD ProRes 4444 － － － － － － －
4K ProRes 422 HQ ○ ○ ○ ○ － ○ ○
QFHD ProRes 422 HQ － － － － － － －
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有効画サイズ（Imager Mode） 記録フォーマット Project Frame Rate
23.98 24.00 25.00 29.97 47.95 50.00 59.94

4K 17:9 Surround X‑OCN XT ○ ○ ○ ○ － － －
X‑OCN ST ○ ○ ○ ○ － － －
X‑OCN LT ○ ○ ○ ○ － － －
4K ProRes 4444 ○ ○ ○ ○ － － －
QFHD ProRes 4444 － － － － － － －
4K ProRes 422 HQ ○ ○ ○ ○ － － －
QFHD ProRes 422 HQ － － － － － － －

4K 2.39:1 X‑OCN XT ○ ○ ○ ○ ○ ○ ○
X‑OCN ST ○ ○ ○ ○ ○ ○ ○
X‑OCN LT ○ ○ ○ ○ ○ ○ ○
4K ProRes 4444 ○ ○ ○ ○ － ○ ○
QFHD ProRes 4444 － － － － － － －
4K ProRes 422 HQ ○ ○ ○ ○ － ○ ○
QFHD ProRes 422 HQ － － － － － － －

3.8K 16:9 X‑OCN XT ○ ○ ○ ○ － ○ ○
X‑OCN ST ○ ○ ○ ○ － ○ ○
X‑OCN LT ○ ○ ○ ○ － ○ ○
4K ProRes 4444 － － － － － － －
QFHD ProRes 4444 ○ ○ ○ ○ － ○ ○
4K ProRes 422 HQ － － － － － － －
QFHD ProRes 422 HQ ○ ○ ○ ○ － ○ ○

3.8K 16:9 Surround X‑OCN XT ○ ○ ○ ○ － － －
X‑OCN ST ○ ○ ○ ○ － － －
X‑OCN LT ○ ○ ○ ○ － － －
4K ProRes 4444 － － － － － － －
QFHD ProRes 4444 ○ ○ ○ ○ － － －
4K ProRes 422 HQ － － － － － － －
QFHD ProRes 422 HQ ○ ○ ○ ○ － － －
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フルメニューの操作方法
MENUボタンを2秒以上長押しすると、撮影や再
生に必要な各種設定を行うフルメニューがサブ
ディスプレイに表示されます。
または、MENUダイヤルと共にMENUボタン押す
ことにより、フルメニュー画面を表示することも
できます。

メニュー構成

Shootingメニュー

撮影に関する設定をするときに使用するメニュー
です。

Projectメニュー

プロジェクトの基本的な設定をするときに使用す
るメニューです。

TC/Mediaメニュー

タイムコードと記録メディアに関する設定をする
ときに使用するメニューです。

Monitoringメニュー

ビデオ出力やビューファインダー出力に関する設
定をするときに使用するメニューです。

Audioメニュー

オーディオに関する設定をするときに使用するメ
ニューです。

Paintメニュー

ペイント機能に関する設定をするときに使用する
メニューです。

Technicalメニュー > Special Configuration > 
RM/RCP Paint Control（93ページ）がOnに
設定されている場合のみ、Paintメニューを表示・
選択できます。

Technicalメニュー

技術的な内容の設定をするときに使用するメ
ニューです。

Maintenanceメニュー

時計や言語設定などの機器設定をするときに使
用するメニューです。

操作部

MENUボタン（10ページ）
2秒以上長押しすると、サブディスプレイにフル
メニューが表示されます。

SEL/SET ダイヤル（MENUダイヤル） 
（10ページ）

回すとカーソルが上下に移動して、設定項目や設
定値を選択できます。
MENUダイヤルを押すと、選択している項目を決
定します。

BACKボタン（11ページ）
1つ前の階層に戻ります。確定前の変更はキャン
セルされます。

メニューを設定する

MENUダイヤルを回して設定したい項目にカーソ
ルを合わせ、MENUダイヤルを押して決定します。
• 選択項目が表示される選択肢エリアは最大9

行表示です。選択肢が1度に表示できない場
合は、カーソルを上下に移動すると表示がスク
ロールします。

• 選択肢の範囲が大きい項目の場合（例：‒99 ～
+99）は、選択肢エリアは表示されません。文
字がハイライト表示になり設定変更が可能な
状態であることを示します。

• 実行項目でRunを選択した場合は、対応する
機能が実行されます。

• 実行前に確認が必要な項目を選択すると、確
認メッセージが表示されます。メッセージに
従って、実行するかキャンセルするかを選択し
てください。
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Shootingメニュー
各メニュー項目の機能および設定値は次のとおりです。
太字とアンダーラインで表示されている設定値は、出荷時の設定です。
Shooting > FPS

撮像フレームレートを設定します。
メニュー項目 設定値 内容
Fixed/Variable 
Select

Fixed/Variable FPS設定を等速撮影にするか、可変速撮影する
かを選択する。

FPS Select Fixed/Variable SelectがFixed
の場合、次のいずれかの値が表
示されます。

Fixed 23.98/Fixed 
24.00/Fixed 25.00/
Fixed 29.97/Fixed 47.95/
Fixed 50.00/Fixed 59.94

撮像フレームレートを選択する。
Project Frame Rateの設定によって初期値が
次のように異なります。

Project 
Frame 
Rate

Fixed/Variable 
Selectが
Variableの場合
の初期値

Fixed/Variable 
SelectがFixed
の場合の表示値

59.94 60 Fixed 59.94

50 50 Fixed 50.00
47.95 48 Fixed 47.95
29.97 30 Fixed 29.97
25 25 Fixed 25.00
24 24 Fixed 24.00
23.97 24 Fixed 23.98

［ご注意］
以下に設定されている場合は、7以下の撮像フレーム
レートを設定できません。

 ‒ Base ISOがISO 3200 
 ‒ Base ISOがISO 2500かつ記録フォーマットが

ProRes

Shooting > Shutter
電子シャッターに関する設定を行います。

［ご注意］
Technicalメニュー > Special Configuration > RM/RCP Paint Control（93ページ）がOnで、RM‑B170などのリモー
トコントロールユニット接続時は、Shutterはグレーアウトされ設定を変更できません。

メニュー項目 設定値 内容
Shutter Select Shutter Mode（89ページ）

がSpeedの場合
工場出荷時の選択肢

1/24、1/25、1/30、1/48、
1/50、1/60、1/100、
1/120、1/250、1/500、
1/1000、1/20001)

Shutter Mode（89ページ）
がAngleの場合
工場出荷時の選択肢

360.0/180.0/172.8/ 
144.0/90.0/45.0/22.5/ 
11.2/5.6

Step/Cont. Selectで
Continuousを選択すると、
360.0 ～ 4.2（Angleの場合）ま
たは1/241）～ 1/80002）（Speed
の場合）の範囲からの選択とな
ります。

電子シャッターの開角度またはスピードを選択
する。
スピードの初期値はProject Frame Rate（74
ページ）の設定によって次のようになります。

23.98/24：1/24
25：1/25
29.97：1/30
47.95：1/48
50：1/50
59.94：1/60

1) プロジェクトフレームレートが59.94の場合は1/60
以降の値、50.0の場合は1/50以降の値、29.97の
場合は1/30以降の値、25.0の場合は1/25以降の
値が選択肢となります。

2) プロジェクトフレームレートが50.0または25.0の場
合は1/7000までの値、24.0または23.98の場合は
1/6000までの値が選択肢となります。

Step/Cont. Select Step/Continuous 電子シャッターの値をステップ単位で選択する
か、連続的に選択するかを設定する。

Add/Change Step Shutter SelectのStepでの選択肢を追加また
は変更する。
追加できる選択肢は最大16個になります。

Delete Step Shutter SelectのStepでの選択肢の1つを削除
する。

Shooting > Flicker	Reduce
フリッカー低減に関する設定を行います。

メニュー項目 設定値 内容
Mode On/Off フリッカー低減機能をオン／オフする。
Frequency 50Hz/60Hz フリッカーの原因となる照明の電源周波数を設

定する。
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Shooting > ND
NDフィルターのポジションを設定します。

メニュー項目 設定値 内容
ND Position Clear/0.3/0.6/0.9/1.2/1.5/ 

1.8/2.1/2.4
NDフィルターの濃度を選択する。

Shooting > Exposure	Index
EI値を設定します。

［ご注意］
Technicalメニュー > Special Configuration > RM/RCP Paint Control（93ページ）がOnに設定されている場合は、
Exposure Indexはグレーアウトされ設定を変更できません。

メニュー項目 設定値 内容
EI Select Projectメニュー > Basic 

Setting > Base ISO（74ペー
ジ）の設定によって、設定値が
次のように異なります。
MPC‑3628

Base ISO 800：
200EI/250EI/320EI/ 
400EI/500EI/640EI/ 
800EI/1000EI/1250EI/ 
1600EI/2000EI/2500EI/ 
3200EI

Base ISO 3200：
800EI/1000EI/1250EI/ 
1600EI/2000EI/2500EI/
3200EI/4000EI/5000EI/
6400EI/8000EI/ 
10000EI/12800EI

MPC‑3626
ISO 500：

125EI/160EI/200EI/250E
I/320EI/400EI/500EI/ 
640EI/800EI/1000EI/ 
1250EI/1600EI/2000EI

ISO 2500：
640EI/800EI/1000EI/ 
1250EI/1600EI/2000EI/ 
2500EI/3200EI/4000EI/ 
5000EI/6400EI/8000EI/ 
10000EI

EI値を選択する。

［ご注意］
Technicalメニュー > Special Configuration > RM/
RCP Paint Control（93ページ）がOnに設定されて
いる場合は、設定値が以下のように固定されます。
Base ISOがISO500のとき：500EI
Base ISOがISO2500のとき：2500EI
Base ISOがISO800のとき：800EI 
Base ISOがISO3200のとき：3200EI  

Shooting > Gain
ゲインに関する設定を行います。

［ご注意］
Technicalメニュー > Special Configuration > RM/RCP Paint Control（93ページ）がOffに設定されている場合、
またはRM‑B170などのリモートコントロールユニットが接続されている場合は、Gainの設定を変更できません。

メニュー項目 設定値 内容
Gain Select －6dB/－3dB/0dB/3dB/6dB/

9dB/12dB/15dB/18dB
基準感度を設定する。

Shooting > White	Balance
ホワイトバランスに関する設定を行います。

［ご注意］
Technicalメニュー > Special Configuration > RM/RCP Paint Control（93ページ）がOnで、RM‑B170などのリモー
トコントロールユニット接続時は、White Balanceはグレーアウトされ設定を変更できません。

メニュー項目 設定値 内容
Color Temp. Select 3200K+00/4300K+00/ 

5500K+00
および追加された選択肢（計16
個まで）

ホワイトバランスの色温度／色合いを表示およ
び選択する。

Add/Change Step ホワイトバランスのColor TempとTint値を変更
して、選択肢を追加または変更する。

Delete Step 追加された選択肢の1つを選択肢から削除する。
Auto White Balance Run/Cancel オートホワイトバランスを実行する（Runで実行）。

Shooting > Look
Preset Lookに関する設定を行います。

［ご注意］
Technicalメニュー > Special Configuration > RM/RCP Paint Control（93ページ）がOnに設定されている場合は、
Lookはグレーアウトされ設定を変更できません。

メニュー項目 設定値 内容
Category Preset	Look/User 3D LUT/

ART/ACEScct with User 3D/
ACESproxy with User 3D/
ACES with ART

LUTのカテゴリーを選択する。

［ご注意］
ACEScct with User 3D/ACESproxy with User 
3D/ACES with ARTは、Projectメニュー > Basic 
Setting > Input Color Space（74ページ）が
ACEScctに設定されている場合のみ選択できます。
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Shooting > Look
Preset Lookに関する設定を行います。

［ご注意］
Technicalメニュー > Special Configuration > RM/RCP Paint Control（93ページ）がOnに設定されている場合は、
Lookはグレーアウトされ設定を変更できません。

メニュー項目 設定値 内容
Preset Look Select s709/R709(800%) / 

S‑Gamut3.Cine/ 
SLog3 / S‑Gamut3/ 
SLog3 / ACESproxy /  
ACEScct / ACES 1.0 
Output‑Rec.709

Preset Lookを選択する。
カラーグレーディングの開始点に適した映像や
プリントフィルムに近づけた映像を出力する。
s709：シネマ色
R709(800%)：忠実色
S‑Gamut3/SLog3：広い色域
S‑Gamut3.Cine/SLog3：デジタルシネマを考慮

した色域
ACESproxy：アカデミーにより規定されている

広色域（AP1）のLogカーブです。
ACEScct：ACESproxyにコントラストを抑えた

Toe特性を持たせた広色域（AP1）のLogカー
ブです。

ACES 1.0 Output‑Rec.709：アカデミーにより
規定されているRec.709のリファレンスルッ
クです。

［ご注意］
• CategoryがPreset Lookに設定されている場合の

み設定できます。
• 「S‑Gamut3/SLog3」は、Projectメニュー > Basic 

Setting > Input Color Space（74ページ）が
S‑Gamut3/SLog3に設定されている場合のみ選択
できます。

• ACESproxy/ACEScct/ACES 1.0 
Output‑Rec.709は、Projectメニュー > Basic 
Setting > Input Color Space（74ページ）が
ACEScctに設定されている場合のみ選択できます。

User 3D LUT Select 内部メモリーに保存されている
User 3D LUTのファイル名（01
～ 16）

User 3D LUTファイルを選択する。

［ご注意］
CategoryがUser 3D LUT、ACEScct with User 3D
またはACESproxy with User 3Dに設定されている場
合のみ設定できます。

Shooting > Look
Preset Lookに関する設定を行います。

［ご注意］
Technicalメニュー > Special Configuration > RM/RCP Paint Control（93ページ）がOnに設定されている場合は、
Lookはグレーアウトされ設定を変更できません。

メニュー項目 設定値 内容
ART Select 内部メモリーに保存されている

ARTのファイル名（01 ～ 16）
ARTファイルを選択する。

［ご注意］
CategoryがARTまたはACES with ARTに設定されて
いる場合のみ設定できます。

ART Information ART Selectで選択したARTファイルの情報を表
示する。

［ご注意］
CategoryがARTまたはACES with ARTに設定されて
いる場合のみ表示できます。

ASC CDL Process CDL	Off/Look‑> CDL/CDL ‑> 
Look/CDL On

出力映像にASC CDL を適用するかを設定する。
適用する場合、ASC CDLの処理の順番を指定
する。
CDL Off：出力映像にASC CDLを適用しない。
Look‑>CDL：CDLをLook適用処理の後に適用

する。
CDL‑>Look：CDLをLook適用処理の前に適用

する。
CDL On：出力映像にASC CDLを適用する。

［ご注意］
• ASC CDLは、Shootingメニュー > LUT Select

（70ページ）でLookが選択された出力に有効で
す。

• ASC CDL Processの各選択肢が有効になる条件は
次表のとおりです。
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Shooting > Look
Preset Lookに関する設定を行います。

［ご注意］
Technicalメニュー > Special Configuration > RM/RCP Paint Control（93ページ）がOnに設定されている場合は、
Lookはグレーアウトされ設定を変更できません。

メニュー項目 設定値 内容
ASC CDL Process Shooting > Look Project > Basic Setting 

> Input Color Space
ASC CDL Process
の有効選択肢Category Preset Look Select

Preset 
Look

s709 S‑Gamut3/Slog3
S‑Gamut3.Cine/
Slog3

CDL Off
Look ‑> CDL
CDL‑>Look

R709(800%)
S‑Gamut3/Slog3

S‑Gamut3/Slog3
S‑Gamut3.Cine/
Slog3

CDL Off
Look ‑> CDL

S‑Gamut3.Cine/
Slog3

S‑Gamut3/Slog3 CDL Off
Look ‑> CDL

S‑Gamut3.Cine/
Slog3

CDL Off
Look ‑> CDL

ACESproxy
ACEScct
ACES 1.0 
Output‑Rec.709

ACEScct CDL Off
CDL On

User 3D 
LUT

－ S‑Gamut3/Slog3
S‑Gamut3.Cine/
Slog3

CDL Off
Look ‑> CDL
CDL‑>Look

ART － S‑Gamut3/Slog3
S‑Gamut3.Cine/
Slog3

CDL Off
Look ‑> CDL
CDL‑>Look

ACEScct 
with User 
3D
ACESproxy 
with User 
3D

－ ACEScct CDL Off
CDL‑>Look

ACES with 
ART

－ ACEScct CDL Off
CDL‑>Look

ASC CDL Select No	File/Not Selected 本機に登録されたASC CDLを選択する。
ASC CDL 
Information

ASC CDL Selectで選択したASC CDLの情報を
表示する。
表示された画面でSaturationの設定を変更す
ることができます。

Shooting > Look	File
User 3D LUTファイルを本機に読み込みます。

［ご注意］
Technicalメニュー > Special Configuration > RM/RCP Paint Control（93ページ）がOnに設定されている場合は、
Look Fileはグレーアウトされ設定を変更できません。

メニュー項目 設定値 内容
Load User 3D LUT SDカードに保存されているUser 3D LUTファイ

ルを本機に読み込む。
Reset User 3D LUT 任意のUser 3D LUTデータ設定をリセットする。
Reset All User 3D 
LUTs

Run/Cancel すべてのUser 3D LUTデータ設定をリセットする
（Runで実行）。

Load ART SDカードに保存されているARTファイルを本機
に読み込む。

Reset ART 任意のARTデータ設定をリセットする。
Reset All ARTs Run/Cancel すべてのARTデータ設定をリセットする（Runで

実行）。
Load ASC CDL ASC CDLデータをSDカードから読み込む。
Reset ASC CDL 任意のASC CDLデータ設定をリセットする。
Reset All ASC CDLs Run/Cancel すべてのASC CDLデータ設定をリセットする

（Runで実行）。

Shooting > LUT	Select
各種出力映像に適用するLUTに関する設定を行います。

［ご注意］
Technicalメニュー > Special Configuration > RM/RCP Paint Control（93ページ）の設定によって各メニュー項目
の設定値が異なります（SDR Gainを除く）。

メニュー項目 設定値 内容
SDI 1/2 RM/RCP Paint ControlがOff

のとき：
Log/Look

SDI 1/2出力映像に適用するLUTを選択する。

RM/RCP Paint ControlがOn
のとき：

Log/HLG(Natural)/
HLG(Live)/User Gamma

SDI 1/2出力映像の設定値は、Projectメニュー 
> Basic Setting > Input Color Space（74
ページ）の設定で決まるため表示のみ。
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Shooting > LUT	Select
各種出力映像に適用するLUTに関する設定を行います。

［ご注意］
Technicalメニュー > Special Configuration > RM/RCP Paint Control（93ページ）の設定によって各メニュー項目
の設定値が異なります（SDR Gainを除く）。

メニュー項目 設定値 内容
SDI 3/4 RM/RCP Paint ControlがOff

のとき：
Log/Look

SDI 3/4出力映像に適用するLUTを選択する。

［ご注意］
SDI 1/2出力が以下の場合は、SDI 1/2と同じ設定値に
固定されます。

 ‒ 4K/QFHD Quad出力
 ‒ 4K/QFHD Dual出力

SDI 1/2出力が以下の場合は、Monitorと同じ設定値
に固定されます。

 ‒ 4K/QFHD 12G/6G出力
 ‒ 4K/QFHD Dual出力

RM/RCP Paint ControlがOn
のとき：

Log/HLG(Natural)/
HLG(Live)/User Gamma

SDI 3/4出力映像の設定値は、Projectメニュー 
> Basic Setting > Input Color Space（74
ページ）の設定で決まるため表示のみ。

［ご注意］
SDI 1/2出力が以下の場合は、Monitorと同じ設定値
に固定されます。

 ‒ 4K/QFHD 12G/6G出力
 ‒ 4K/QFHD Dual出力

SDI 1/2出力が以下の場合は、SDI 1/2と同じ設定値に
固定されます。

 ‒ 4K/QFHD Quad出力
 ‒ 4K/QFHD Dual出力

Shooting > LUT	Select
各種出力映像に適用するLUTに関する設定を行います。

［ご注意］
Technicalメニュー > Special Configuration > RM/RCP Paint Control（93ページ）の設定によって各メニュー項目
の設定値が異なります（SDR Gainを除く）。

メニュー項目 設定値 内容
Monitor RM/RCP Paint ControlがOff

のとき：
Output Format > SDI1/2が
2K/HDのとき：

Log/s709/R709(800%)/
Look/‑‑‑

Output Format > SDI1/2が
4K/QFHDのとき：

Log/s709/R709(800%)/
Look/‑‑‑

Monitor出力映像に適用するLUTを選択する。

［ご注意］
Technicalメニュー > Special Configuration > SD 
HDMI（93ページ）がOnのときは無出力となるため、

「‑‑‑」（無効）表示になります。

RM/RCP Paint Controlが
Onのとき、Projectメニュー > 
Basic Setting > Input Color 
Space（74ページ）の設定に
よって、設定値が次のように異
なります。
S‑Gamut3.Cine/SLog3また
はS‑Gamut3/SLog3：
Log/R709(800%)

HLG(Natural)：
HLG(Natural)/
R709(800%)

HLG(Live)：
HLG(Live)/R709(800%)

Rec.2020/User Gamma：
User	Gamma/R709‑
Like

Rec.709/User Gamma：
User Gamma

Monitor出力映像の種類を選択する。

［ご注意］
• ビューファインダー・モニター画面出力映像にはSDR

ゲイン値（－12dB）が反映されます。
• R709(800%)またはR709‑Likeに設定されている

場合に、SDR Gainで出力ゲインを変更することが
できます。
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Shooting > LUT	Select
各種出力映像に適用するLUTに関する設定を行います。

［ご注意］
Technicalメニュー > Special Configuration > RM/RCP Paint Control（93ページ）の設定によって各メニュー項目
の設定値が異なります（SDR Gainを除く）。

メニュー項目 設定値 内容
HDMI RM/RCP Paint ControlがOff

のとき（4K/QFHD出力時）：
Log/Look

HDMI出力映像の設定値はSDI 1/2と同じため表
示のみ。

RM/RCP Paint ControlがOff
のとき（2K/HD出力時）：

Log/s709/R709(800%)/
Look

HDMI出力映像の設定値はMonitorと同じため
表示のみ。

［ご注意］
Technicalメニュー > Special Configuration > SD 
HDMI（93ページ）がOnのときはLogに固定されま
す。

RM/RCP Paint ControlがOn
のとき（4K/QFHD出力時）：
Log	/HLG(Natural)/
HLG(Live)/User Gamma

HDMI出力映像の設定値はSDI 1/2と同じため表
示のみ。

RM/RCP Paint ControlがOn
のとき（2K/HD出力時）：
Log	/HLG(Natural)/
HLG(Live)/User Gamma/
R709(800%)/R709‑Like

HDMI出力映像の設定値はMonitorと同じため
表示のみ。

Shooting > LUT	Select
各種出力映像に適用するLUTに関する設定を行います。

［ご注意］
Technicalメニュー > Special Configuration > RM/RCP Paint Control（93ページ）の設定によって各メニュー項目
の設定値が異なります（SDR Gainを除く）。

メニュー項目 設定値 内容
VF LUT RM/RCP Paint ControlがOff

のとき：
Log/s709/R709(800%)/
Look

ビューファインダー・モニター画面出力映像に適
用するLUTを選択する。

RM/RCP Paint ControlがOn
のとき：

Projectメニュー > Basic 
Setting > Input Color 
Space（74ページ）の設
定によって、設定値が次の
ように異なります。
S‑Gamut3.Cine/SLog3ま
たはS‑Gamut3/SLog3：

Log/R709(800%)
HLG(Natural)：

HLG(Natural)/
R709(800%)

HLG(Live)：
HLG(Live)/
R709(800%)

Rec.2020/User Gamma：
User Gamma/ 
R709-Like

Rec.709/User Gamma：
User Gamma

ビューファインダー・モニター画面出力映像の種
類を選択する。

［ご注意］
• ビューファインダー・モニター画面出力映像にはSDR

ゲイン値（－12dB）が反映されます。
• R709(800%)またはR709‑Likeに設定されている

場合は、SDR Gainで出力ゲインを変更することが
できます。

ProRes RM/RCP Paint ControlがOff
のとき：
Log/Look/‑‑‑

ProRes記録映像に適用するLUTを選択する。

［ご注意］
Projectメニュー > Basic Setting > Recording 
Format（74ページ）がX‑OCNフォーマットのときは

「‑‑‑」（無効）表示になります。

RM/RCP Paint ControlがOn
のとき：

Log/HLG(Natural)/
HLG(Live)/User Gamma

ProRes記録映像の設定値は、Projectメニュー 
> Basic Setting > Input Color Space（74
ページ）の設定で決まるため表示のみ。
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Shooting > LUT	Select
各種出力映像に適用するLUTに関する設定を行います。

［ご注意］
Technicalメニュー > Special Configuration > RM/RCP Paint Control（93ページ）の設定によって各メニュー項目
の設定値が異なります（SDR Gainを除く）。

メニュー項目 設定値 内容
SDR Gain －15dB ～ 0dB（－12dB）（1 dB

刻み）
RM/RCP Paint ControlがOnのときのSDR出
力ゲインを設定する。
R709(800％ )またはR709‑Likeに設定されてい
るMonitorまたはビューファインダーの出力ゲイ
ンを変更することができます。

［ご注意］
Technicalメニュー > Special Configuration > RM/
RCP Paint Control（93ページ）がOnに設定されて
いる場合に設定できます。
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Projectメニュー
各メニュー項目の機能および設定値は次のとおりです。
太字とアンダーラインで表示されている設定値は、出荷時の設定です。
Project > Basic	Setting

画サイズやプロジェクトフレームレートに関する設定を行います。
メニュー項目 設定値 内容
Imager Mode MPC‑3628

8.6K 3:2/8.2K 17:9/ 
7.6K 16:9/5.8K 6:5/ 
5.8K	17:9/5.4K 16:9

MPC‑3626
6K 3:2/6K 1.85:1/6K 
17:9/6K 2.39:1/5.7K 
16:9/4K 6:5/4K 4:3/4K 
4:3 Surround View/4K	
17:9/4K 17:9 Surround 
View/4K 2.39:1/3.8K 
16:9/3.8K 16:9 Surround 
View

有効画サイズを選択する。

［ご注意］
• 5.8K 6:5はアナモフィックライセンスインストール時

のみ表示されます。
• 7.6K 16:9/8.2K 17:9/8.6K 3:2はフルフレームライ

センスインストール時のみ表示されます。
• 6K 3:2/6K 1.85:1/6K 17:9/6K 2.39:1/5.7K 16:9は

フルフレームライセンスインストール時のみ表示され
ます。

• 4K 6:5/4K 4:3/4K 4:3 Surround Viewはアナモ
フィックライセンスインストール時のみ表示されま
す。

Project Frame Rate 23.98/24/25/29.97/47.95/ 
50/59.94

プロジェクトフレームレートを選択する。

Input Color Space RM/RCP Paint Control（93
ページ）がOffのとき：
S-Gamut3.Cine/SLog3	
/ S‑Gamut3/SLog3 / 
ACEScct

RM/RCP Paint ControlがOn
のとき：
S-Gamut3.Cine/SLog3 
/ S‑Gamut3/SLog3 / 
ACEScct / HLG(Natural) 
/ HLG(Live) / Rec.2020/
User Gamma / Rec.709/
User Gamma

色域を設定する。

［ご注意］
HLG(Natural)はHLG BT.2100と同等です。

Recording Format X‑OCN XT/X-OCN	ST/X‑OCN 
LT/ProRes 4444 4K/ProRes 
4444 QFHD/ProRes 422 HQ 
4K/ProRes 422 HQ QFHD

AXSメモリーカードに記録するビデオフォーマッ
トを選択する。

Base ISO MPC‑3628
ISO	800/ISO 3200

MPC‑3626
ISO	500/ISO 2500

基準感度を設定する。

Project > Basic	Setting
画サイズやプロジェクトフレームレートに関する設定を行います。

メニュー項目 設定値 内容
Anamo. 
De‑Squeeze

Off(1.0x)/1.25x/1.3x/1.5x/ 
1.65x/1.8x/2.0x

ProRes記録信号およびビデオ出力信号のデスク
イーズ変換処理を行うかを設定する。
アナモフィックライセンスがインストールされて
いて、Imager Modeの設定が4K 4:3/ 
4K 4:3 Surround View/4K 6:5/4K 17:9/ 
4K 17:9 Surround View/5.8K 6:5/5.8K 
17:9、またはアナモフィックライセンスとフル
フレームライセンスがインストールされていて、
Imager Modeの設定が6K 3:2/6K 17:9/8.2K 
17:9/8.6K 3:2のときに設定できます。ただし、
画サイズによって選択肢が異なります。

MPC‑3628

Imager Mode Anamo. De‑Squeeze
Off(1.0x) 1.25x 1.3x 1.5x 1.65x 1.8x 2.0x

8.6K 3:2 ○ ○ ○ ○ ○ ○ ○
8.2K 17:9 ○ ○ ○ － ○ ○ ○
7.6K 16:9 ○ － － － － － －
5.8K 6:5 ○ － － － － － ○
5.8K 17:9 ○ ○ ○ － ○ ○ ○
5.4K 16:9 ○ － － － － － －
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Project > Basic	Setting
画サイズやプロジェクトフレームレートに関する設定を行います。

メニュー項目 設定値 内容
MPC‑3626

Imager Mode Anamo. De‑Squeeze
Off(1.0x) 1.25x 1.3x 1.5x 1.65x 1.8x 2.0x

6K 3:2 ○ ○ ○ ○ ○ ○ ○
6K 1.85:1 ○ － － － － － －
6K 17:9 ○ ○ ○ － ○ ○ ○
6K 2.39:1 ○ － － － － － －
5.7K 16:9 ○ － － － － － －
4K 6:5 ○ － － － － － ○
4K 4:3 Surround ○ － ○ － ○ ○ ○
4K 4:3 ○ － ○ － ○ ○ ○
4K 17:9 Surround ○ ○ ○ － ○ ○ ○
4K 17:9 ○ ○ ○ － ○ ○ ○
4K 2.39:1 ○ － － － － － －
3.8K 16:9 
Surround

○ － － － － － －

3.8K 16:9 ○ － － － － － －

Zoom to Fit Off/17:9/16:9 ビューファインダー画面、またはMonitor出力に
対して、記録映像を切り出して拡大表示するか
を設定する。

［ご注意］
• 以下の条件で設定できます 

Imager Mode：8K 3:2/6K 3:2 
Recording Format：X‑OCN 
Anamo. De‑Squeeze：Off(1.0x)

• Project Frame Rateが47.95のときは、16:9を選
択できません。

• 17:9または16:9からOffに変更した場合は、SDI出
力フォーマットが初期値に戻ります。

Project > Assignable	Button
アサイナブルボタンに機能を割り当てます。

˜˜ 機能の割り当てについて詳しくは、「ユーザー機能画面」（49ページ）をご覧ください。

メニュー項目 設定値 内容
<1> 49ページ アサイナブル1ボタンに機能を割り当てる。
<2> 49ページ アサイナブル2ボタンに機能を割り当てる。

Project > Assignable	Button
アサイナブルボタンに機能を割り当てます。

˜˜ 機能の割り当てについて詳しくは、「ユーザー機能画面」（49ページ）をご覧ください。

メニュー項目 設定値 内容
<3> 49ページ アサイナブル3ボタンに機能を割り当てる。
<4> 49ページ アサイナブル4ボタンに機能を割り当てる。
<VF A> 49ページ ビューファインダー（DVF‑EL200）のアサイナブ

ルAボタンに機能を割り当てる。
<VF B> 49ページ ビューファインダー（DVF‑EL200）のアサイナブ

ルBボタンに機能を割り当てる。
<VF C> 49ページ ビューファインダー（DVF‑EL200）のアサイナブ

ルCボタンに機能を割り当てる。
<User 1> 49ページ ITEMキー 1に機能を割り当てる。
<User 2> 49ページ ITEMキー 2に機能を割り当てる。
<User 3> 49ページ ITEMキー 3に機能を割り当てる。
<User 4> 49ページ ITEMキー 4に機能を割り当てる。
<User 5> 49ページ ITEMキー 5に機能を割り当てる。

Project > Special	Recording
ピクチャーキャッシュレックに関する設定を行います。

メニュー項目 設定値 内容
Cache Rec Select On/Off ピクチャーキャッシュレック機能をオン／オフす

る。
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Project > Special	Recording
ピクチャーキャッシュレックに関する設定を行います。

メニュー項目 設定値 内容
Max Cache Rec 
Duration

2	s/4 s/6 s/8 s/10 s/15 s/ 
24 s/30 s

ピクチャーキャッシュメモリーに画像を蓄積する
ときの再生時間長を設定する。
AXSメモリーカードに設定可能な最大値は以下
のとおりです。

［ご注意］
FPSがVariableに設定されている場合は、実際の再生
時間長はMax Cache Rec Durationの設定と異なり
ます。

X-OCN記録時
MPC‑3628

Imager 
Mode

Recording 
Format

Project Frame Rate
23.98 24 25 29.97 47.95 50 59.94

8.6K 3:2 X‑OCN XT 4 4 4 2 － － －
X‑OCN ST 10 10 8 6 － － －
X‑OCN LT 15 15 15 15 － － －

8.2K 17:9 X‑OCN XT 8 8 8 6 － － －
X‑OCN ST 15 15 15 10 4 4 2
X‑OCN LT 30 30 30 24 10 10 8

7.6K 16:9 X‑OCN XT 8 8 8 6 － － －
X‑OCN ST 15 15 15 10 － 4 2
X‑OCN LT 30 30 30 24 － 10 8

5.8K 6:5 X‑OCN XT 10 10 10 8 2 － －
X‑OCN ST 15 15 15 15 8 － －
X‑OCN LT 30 30 30 30 15 － －

5.8K 17:9 X‑OCN XT 24 24 24 15 8 8 6
X‑OCN ST 30 30 30 30 15 15 10
X‑OCN LT 30 30 30 30 30 30 24

5.4K 16:9 X‑OCN XT 24 24 24 15 － 8 6
X‑OCN ST 30 30 30 30 － 15 10
X‑OCN LT 30 30 30 30 － 30 24

Project > Special	Recording
ピクチャーキャッシュレックに関する設定を行います。

メニュー項目 設定値 内容
MPC‑3626

Imager Mode Recording 
Format

Project Frame Rate
23.98 24 25 29.97 47.95 50 59.94

6K 3:2 X‑OCN XT 15 15 15 10 4 4 2
X‑OCN ST 24 24 24 15 10 10 6
X‑OCN LT 30 30 30 30 15 15 15

6K 1.85:1 X‑OCN XT 15 15 15 15 8 6 4
X‑OCN ST 30 30 30 24 15 10 10
X‑OCN LT 30 30 30 30 30 24 15

6K 17:9 X‑OCN XT 15 15 15 15 8 8 4
X‑OCN ST 30 30 30 24 15 10 10
X‑OCN LT 30 30 30 30 30 24 15

6K 2.39:1 X‑OCN XT 30 30 24 15 10 10 8
X‑OCN ST 30 30 30 30 15 15 15
X‑OCN LT 30 30 30 30 30 30 30

5.7K 16:9 X‑OCN XT 15 15 15 15 － 8 4
X‑OCN ST 30 30 30 24 － 10 10
X‑OCN LT 30 30 30 30 － 24 15

4K 6:5 X‑OCN XT 30 30 30 24 10 10 10
X‑OCN ST 30 30 30 30 24 15 15
X‑OCN LT 30 30 30 30 30 30 30

4K 4:3 X‑OCN XT 30 30 30 30 15 15 10
X‑OCN ST 30 30 30 30 24 24 15
X‑OCN LT 30 30 30 30 30 30 30

4K 4:3 Surround X‑OCN XT 30 30 30 30 － － －
X‑OCN ST 30 30 30 30 － － －
X‑OCN LT 30 30 30 30 － － －

4K 17:9 X‑OCN XT 30 30 30 30 24 24 15
X‑OCN ST 30 30 30 30 30 30 30
X‑OCN LT 30 30 30 30 30 30 30

4K 17:9 Surround X‑OCN XT 30 30 30 30 － － －
X‑OCN ST 30 30 30 30 － － －
X‑OCN LT 30 30 30 30 － － －

4K 2.39:1 X‑OCN XT 30 30 30 30 30 30 24
X‑OCN ST 30 30 30 30 30 30 30
X‑OCN LT 30 30 30 30 30 30 30

3.8K(QFHD) 16:9 X‑OCN XT 30 30 30 30 － 24 15
X‑OCN ST 30 30 30 30 － 30 30
X‑OCN LT 30 30 30 30 － 30 30

3.8K(QFHD) 16:9 
Surround

X‑OCN XT 30 30 30 30 － － －
X‑OCN ST 30 30 30 30 － － －
X‑OCN LT 30 30 30 30 － － －
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Project > Special	Recording
ピクチャーキャッシュレックに関する設定を行います。

メニュー項目 設定値 内容
ProRes記録時

Recording Format Project Frame Rate
23.98 24 25 29.97 47.95 50 59.94

ProRes 4K 4444 30 30 30 30 － 15 10
ProRes 4K 422 HQ 30 30 30 30 － 24 15
ProRes QFHD 4444 30 30 30 30 － 15 10
ProRes QFHD 422 HQ 30 30 30 30 － 30 24

Project > All	File(Cam	Setup)
Allファイルに関する設定を行います。

メニュー項目 設定値 内容
Load SD Card Allファイルの設定をSDカードから読み出す。
Save SD Card Allファイルの設定をSDカードに保存する。
File ID AllファイルのFile IDを表示し、編集する。
Format SD Card SD Cardをフォーマットする。

Project > Scene	File
Sceneファイルに関する設定を行います。

［ご注意］
Technicalメニュー > Special Configuration > RM/RCP Paint Control（93ページ）がOnに設定されている場合の
み、Scene Fileを表示・選択できます。

メニュー項目 設定値 内容
Recall Internal 
Memory

Sceneファイルの設定を内蔵メモリーから読み
出す。

Store Internal 
Memory

Sceneファイルの設定を内蔵メモリーに保存す
る。

Load SD Card Sceneファイルの設定をSDカードから読み出す。
Save SD Card Sceneファイルの設定をSDカードに保存する。
File ID SceneファイルのFile IDを表示し、編集する。

Project > User	Gamma
ユーザーガンマファイルに関する設定を行います。

［ご注意］
Technicalメニュー > Special Configuration > RM/RCP Paint Control（93ページ）がOnに設定されている場合の
み、User Gammaを表示・選択できます。

メニュー項目 設定値 内容
Current Settings 内蔵メモリー上の、現在のユーザーガンマファイ

ル名を表示する。
Load SD Card SDカード内のユーザー作成によるガンマテーブ

ルデータ（ユーザーガンマファイル）を内蔵メモ
リーに読み込む。
RAW Viewerで作成されたユーザーガンマファ
イルを本機で使用する際には、SDカードの以下
の階層に保存してください。
MPC‑3628：

PRIVATE\SONY\PRO\CAMERA\
MPC3628

MPC‑3626：
PRIVATE\SONY\PRO\CAMERA\
MPC3626

Reset 1/2/3/4/5/All 内蔵メモリー上のユーザーガンマファイルを初期
値に戻す。
1 ～ 5：個別
All：全部
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TC/Mediaメニュー
各メニュー項目の機能および設定値は次のとおりです。
太字とアンダーラインで表示されている設定値は、出荷時の設定です。
TC/Media > Timecode

タイムコードに関する設定を行います。
メニュー項目 設定値 内容
Mode Preset F‑Run (Ext‑Lk)/

Preset	R-Run/Int Regen
タイムコードの歩進モードを選択する。
Preset F‑Run (Ext‑Lk)：設定された状態から

歩進し、外部入力タイムコードに同期する。
Preset R‑Run：記録時のみ設定された状態か

ら歩進する。
Int Regen：前のクリップのタイムコードに続け

て歩進する。
Manual Setting 00:00:00:00 ～ 23:59:59:29 任意のタイムコード値を設定する。
Reset Run/Cancel タイムコードを00:00:00:00にリセットする

（Runで実行）
TC Format DF/NDF タイムコードのフォーマットを選択する。

DF：ドロップフレーム
NDF：ノンドロップフレーム

TC Source Internal/External TCGの同期元を表示する。
Time Data Display Timecode/Duration 表示するタイムデータを選択する。

TC/Media > Genlock
ゲンロックに関する設定を行います。

メニュー項目 設定値 内容
Input Source HD	SDI/Analog ゲンロック入力信号を選択する。

HD SDI：デジタル
Analog：アナログ

Reference Lock 
Type

Internal/External(HD)/
External(SD)

ゲンロックの状態を表示する。ゲンロックがか
かっている場合は信号の種別を表示する。
Internal：かかっていない。
External(HD)：HD syncでかかっている。
External(SD)：SD syncでかかっている。

TC/Media > Clip	Name	Format
クリップ名を設定します。（クリップ名：Camera ID + Reel Number + Shot Number + 年月日 + ラ
ンダム文字列）

メニュー項目 設定値 内容
Camera ID A～ Z クリップ名の生成時のカメラIDを設定する。
Reel Number 001～ 999 クリップ名の生成時のReel Numberの数字部

分を設定する。

TC/Media > Clip	Name	Format
クリップ名を設定します。（クリップ名：Camera ID + Reel Number + Shot Number + 年月日 + ラ
ンダム文字列）

メニュー項目 設定値 内容
Camera Position C/L/R クリップ名の生成時のShot Numberの先頭文

字部分を選択する。

TC/Media > Format	Media
メディアのフォーマット、メディア内の管理ファイルの更新を行います。

メニュー項目 設定値 内容
AXS Slot A Run/Cancel スロットAのAXSメモリーカードを初期化する

（Runで実行）。
AXS Slot B Run/Cancel スロットBのAXSメモリーカードを初期化する

（Runで実行）。
SD Card Run/Cancel SDカードを初期化する（Runで実行）。
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Monitoringメニュー
各メニュー項目の機能および設定値は次のとおりです。
太字とアンダーラインで表示されている設定値は、出荷時の設定です。
Monitoring > Output	Format

出力フォーマットに関する設定を行います。
メニュー項目 設定値 内容
SDI 1/2 Imager Mode、プロジェクト

フレームレート、Recording 
Formatの設定に応じて変わる。

SDI 1/2の出力フォーマットを選択する。
記録フォーマットにより設定値が異なる（128
ページ）。

SDI 3/4 SDI 1/2の設定に応じて変わる。 SDI 3/4の出力フォーマットを選択する。
記録フォーマットにより設定値が異なる（128
ページ）。

Monitor SDI 1/2の設定に応じて変わる。 Monitorの出力フォーマットを選択する。
記録フォーマットにより設定値が異なる（133
ページ）。

HDMI SDI 1/2の設定に応じて変わる。 HDMIの出力フォーマットを選択する。
記録フォーマットにより設定値が異なる（133
ページ）。

3G SDI 1/2/3/4 
Output

Level A/Level	B 3G SDI出力フォーマットをLevelAにするか
Level Bにするかを選択する。

Monitoring > Output	Display
モニターの表示に関する設定を行います。

メニュー項目 設定値 内容
Flip Image Normal/Horizontal Flip/

Vertical Flip/H & V Flip
撮影モード時の画像の反転状態を設定する。
Normalに設定すると画像反転しない。

［ご注意］
• AXS記録画像は反転されずに記録されます。
• Vertical FlipまたはH & V Flip選択時は、映像信号

と音声信号共に撮像フレームレートで内部の処理が
約1 Frame遅延します。

Audio/Video Delay Off/1frame 映像信号と音声信号を遅延させて画像反転して
いる他の機器と同期する機能を有効にするかを
選択する。
Off：遅延制御をしない
1frame：映像信号と音声信号、メタデータ（タイ

ムコードを含む）を約1 Frame遅延させる。

［ご注意］
Flip ImageがVertical FlipまたはH & V Flipに設定さ
れている場合は1frame固定になります。

Monitoring > Output	Display
モニターの表示に関する設定を行います。

メニュー項目 設定値 内容
Monitor Magnifier 
Mode

Toggle/Press & Hold Monitor出力映像のピント拡大機能をオン／オ
フする方法を選択する。
Toggle：Monitor Focus Magnifierを割り当

てたアサイナブルボタンを押すたびにオン／
オフが切り替わる。

Press & Hold：Monitor Focus Magnifierを
割り当てたアサイナブルボタンを押している
間だけオンになる。

Monitor Magnifier 
Ratio

x2.0 / x4.0 / x2.0/x4.0 Monitor出力映像の拡大フォーカス機能の拡大
率を選択する。

［ご注意］
• Project Frame Rate（74ページ）が59.94また

は50のときは、x2.0のみ選択可能です。
• Monitor Magnifier ModeがPress & Holdのとき

は、x2.0/x4.0は選択できません。
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Monitoring >	VF	Display
ビューファインダーの表示に関する設定を行います。

メニュー項目 設定値 内容
VF LUT

［ご注意］
Shootingメニュー > 
LUT Select > VF LUT

（72ページ）と設定は
共通で連動します。

Technicalメニュー > Special 
Configuration > RM/RCP 
Paint Control（93ページ）
がOffのとき：

Log/s709/R709(800%)/
Look

ビューファインダー・モニター画面出力映像に適
用するLUTを選択する。

RM/RCP Paint ControlがOn
のとき：

Projectメニュー > Basic 
Setting > Input Color 
Space（74ページ）の設
定によって、設定値が次の
ように異なります。
S‑Gamut3.Cine/SLog3ま
たはS‑Gamut3/SLog3：

Log/R709(800%)
HLG(Natural)：

HLG(Natural)/
R709(800%)

HLG(Live)：
HLG(Live)/
R709(800%)

Rec.2020/User Gamma：
User Gamma/ 
R709-Like

Rec.709/User Gamma：
User Gamma

ビューファインダー・モニター画面出力映像の種
類を選択する。

［ご注意］
• ビューファインダー・モニター画面出力映像にはSDR

ゲイン値（－12dB）が反映されます。
• R709(800%)またはR709‑Likeに設定されている

場合に、SDR Gainで出力ゲインを変更することが
できます。

Overlay Info.	A/Info. B/Rec Ind./Off ビューファインダー・モニター画面出力映像に重
畳して表示する情報を選択する。

Frame Line Frame Line A/Frame Line B/
Off

ビューファインダー・モニター画面出力映像に重
畳して表示するフレームラインを選択する。

VF Magnifier Mode Toggle/Press & Hold ビューファインダーのピント拡大機能をオン／オ
フする方法を選択する。
Toggle：VF Focus Magnifierのアサイナブル

ボタンを押すたびにオン／オフが切り替わ
る。

Press & Hold：VF Focus Magnifierのアサイ
ナブルボタンを押している間だけオンにな
る。

Monitoring >	VF	Display
ビューファインダーの表示に関する設定を行います。

メニュー項目 設定値 内容
VF Magnifier Ratio x2.0 / x4.0 / x2.0/x4.0 ビューファインダーの拡大フォーカス機能の拡大

率を選択する。

［ご注意］
VF Magnifier ModeがPress & Holdのときは、
x2.0/x4.0は選択できません。

Color －99 ～±0 ～＋99 ビューファインダー映像の色の濃さを調整する。
SDR Gain －15dB ～ 0dB（－12dB）（1 dB

刻み）
RM/RCP Paint ControlがOnのときのSDR出
力ゲインを設定する。
R709(800％ )またはR709‑Likeに設定されてい
るMonitorまたはビューファインダーの出力ゲイ
ンを変更することができます。

［ご注意］
• Shootingメニュー > LUT Select > SDR Gain

（73ページ）と設定は共通で連動します。
• Technicalメニュー > Special Configuration > 

RM/RCP Paint Control（93ページ）がOnに設
定されている場合に設定できます。

Monitoring > VF	Function
ビューファインダーの機能に関する設定を行います。

メニュー項目 設定値 内容
Double Speed Scan On/Off ビューファインダー倍速駆動機能をオン／オフす

る。
Peaking Frequency Normal/High 通常のピーキング時のピーキング周波数を、標

準にするか高くするかを選択する。

［ご注意］
ピーキングレベルはビューファインダーメニューで設定
します。

Assign<VF A> 49ページ ビューファインダー（DVF‑EL200）のアサイナブ
ルAボタンに機能を割り当てる。

Assign<VF B> 49ページ ビューファインダー（DVF‑EL200）のアサイナブ
ルBボタンに機能を割り当てる。

Assign<VF C> 49ページ ビューファインダー（DVF‑EL200）のアサイナブ
ルCボタンに機能を割り当てる。

Zebra On/Off ゼブラ機能をオン／オフする。
Zebra Select 1/2/Both ゼブラ表示の種類（ゼブラ1、ゼブラ2、または

両方）を選択する。
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Monitoring > VF	Function
ビューファインダーの機能に関する設定を行います。

メニュー項目 設定値 内容
Zebra1 Level 0% ～ 107%（41%） ゼブラ1を表示するレベルを設定する。
Zebra1 Aperture 
Level

1% ～ 20%（10%） ゼブラ1のアパーチャーレベルを設定する。

Zebra2 Level 0% ～ 109%（61%） ゼブラ2を表示するレベルを設定する。

Monitoring > Overlays/Frame	Line
各種出力信号に重畳する情報やフレームラインに関する設定を行います。
On/Offの設定はチェックボックスで行います（Frame Line on Playbackを除く）。
On：チェックを付ける
Off：チェックを外す

メニュー項目 設定値 内容
VF Overlay（On/Off、Info.	A/

Info. B/Rec Ind.）
ビューファインダー・モニター画面出力映像に重
畳して表示する情報を選択する。

Frame Line（On/Off、Line	
A/Line B）

ビューファインダー・モニター画面出力映像に重
畳して表示するフレームラインを選択する。

SDI 1/2 Overlay（On/Off、Info. A/
Info.	B/Rec Ind.）

SDI 1/2出力信号に重畳して表示する情報を選
択する。

Frame Line（On/Off、Line 
A/Line	B）

SDI 1/2出力信号に重畳して表示するフレームラ
インを選択する。

SDI 3/4 Overlay（On/Off、Info. A/
Info.	B/Rec Ind.）

SDI 3/4出力信号に重畳して表示する情報を選
択する。

Frame Line（On/Off、Line 
A/Line	B）

SDI 3/4出力信号に重畳して表示するフレームラ
インを選択する。

Same as Monitor SDI 3/4出力信号に重畳して表示する情報の設
定がMonitorと同じかを表示する。

Monitor Overlay（On/Off、Info. A/
Info.	B/Rec Ind.）

Monitor出力信号に重畳して表示する情報を選
択する。

Frame Line（On/Off、Line 
A/Line	B）

Monitor出力信号に重畳して表示するフレーム
ラインを選択する。

HDMI Overlay（On/Off、Info. A/
Info. B/Rec Ind.）

HDMI出力信号に重畳して表示する情報を選択
する。

Frame Line（On/Off、Line 
A/Line	B）

HDMI出力信号に重畳して表示するフレームライ
ンを選択する。

Same as SDI 1/2/3/4 / 
Same as SDI 1/2 / Same as 
Monitor

HDMI出力信号に重畳して表示する情報の設定
が、どの出力と同じかを表示する。

Monitoring > Overlays/Frame	Line
各種出力信号に重畳する情報やフレームラインに関する設定を行います。
On/Offの設定はチェックボックスで行います（Frame Line on Playbackを除く）。
On：チェックを付ける
Off：チェックを外す

メニュー項目 設定値 内容
Overlay A/B Setup Project

Info. A（On/Off）
Info. B（On/Off）

Overlay AおよびOverlay Bに設定した出力情
報にプロジェクト情報を表示するかを選択する。

Camera ID Status
Info. A（On/Off）
Info. B（On/Off）

Overlay AおよびOverlay Bに設定した出力情
報にCamera ID情報を表示するかを選択する。

TC/Genlock Status
Info. A（On/Off）
Info. B（On/Off）

Overlay AおよびOverlay Bに設定した出力情
報に、タイムコードの外部ロック状態およびゲン
ロック状態の情報を表示するかを選択する。

Timecode
Info. A（On/Off）
Info. B（On/Off）

Overlay AおよびOverlay Bに設定した出力情
報にタイムコード情報を表示するかを選択する。

Audio Level Meter
Info. A（On/Off）
Info. B（On/Off）

Overlay AおよびOverlay Bに設定した出力情
報にオーディオレベルメーターを表示するかを
選択する。

Look Status
Info. A（On/Off）
Info. B（On/Off）

Overlay AおよびOverlay Bに設定した出力情
報に選択されているLOOKの種類を表示するか
を選択する。

Output LUT
Info. A（On/Off）
Info. B（On/Off）

Overlay AおよびOverlay Bに設定した出力情
報に出力LUT情報を表示するかを選択する。

Rec Format/LUT
Info. A（On/Off）
Info. B（On/Off）

Overlay AおよびOverlay Bに設定した出力情
報に記録フォーマット、および記録LUT情報を
表示するかを選択する。

VF Status
Info. A（On/Off）
Info. B（On/Off）

Overlay AおよびOverlay Bに設定した出力情
報にビューファインダーの情報を表示するかを選
択する。

Roll/Tilt Value
Info. A（On/Off）
Info. B（On/Off）

Overlay AおよびOverlay Bに設定した出力情
報に水準器状態の情報を数値表示するかを選択
する。

［ご注意］
本機にCBK‑3610XSが接続されている場合は、Roll/
Tilt Valueはグレーアウトされ設定を変更できません。
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Monitoring > Overlays/Frame	Line
各種出力信号に重畳する情報やフレームラインに関する設定を行います。
On/Offの設定はチェックボックスで行います（Frame Line on Playbackを除く）。
On：チェックを付ける
Off：チェックを外す

メニュー項目 設定値 内容
Level Gauge

Info. A（On/Off）
Info. B（On/Off）

Overlay AおよびOverlay Bに設定した出力情
報に水準器状態の情報をグラフィカル表示する
かを選択する。

［ご注意］
本機にCBK‑3610XSが接続されている場合は、Level 
Gaugeはグレーアウトされ設定を変更できません。

Lens Status
Info. A（On/Off）
Info. B（On/Off）
Option（Meter/Feet）

Overlay AおよびOverlay Bに設定した出力情
報にレンズ情報を表示するかを選択する。
フォーカスポジション表示の単位を選択する。

Remote Control Status
Info. A（On/Off）
Info. B（On/Off）

Overlay AおよびOverlay Bに設定した出力情
報にリモート設定情報を表示するかを選択する。

Monitoring > Overlays/Frame	Line
各種出力信号に重畳する情報やフレームラインに関する設定を行います。
On/Offの設定はチェックボックスで行います（Frame Line on Playbackを除く）。
On：チェックを付ける
Off：チェックを外す

メニュー項目 設定値 内容
Frame Line A/B 
Setup

Color
Option（White/Yellow/
Cyan/Green/Magenta/
Red/Blue）

フレームラインの表示色を設定する。

Center Marker
Line A（On/Off）
Line B（On/Off）
Option（Cross/Open 
Cross/Dot）

Frame Line A およびFrame Line Bに設定した
出力情報にセンターマーカーを表示するかを選
択する。
センターマーカーの表示形態（Cross/Open 
Cross/Dot）を選択する。

Picture Area
Line A（On/Off）
Line B（On/Off）

Frame Line A およびFrame Line Bに設定した
出力情報にピクチャーエリアを表示するかを選
択する。

Aspect Ratio
Line A（On/Off）
Line B（On/Off）
Option（17:9/16:9/15:9/ 
14:9/13:9/9:16/4:3/1:1/ 
1.43:1/1.66:1/1.85:1/2:1/ 
2.35:1/2.39:1）

Frame Line A およびFrame Line Bに設定した
出力情報にアスペクトマーカーを表示するかを
選択する。
アスペクトマーカーを表示するときのモード 

（17:9/16:9/15:9/14:9/13:9/9:16/4:3/1:1/ 
1.43:1/1.66:1/1.85:1/2:1/2.35:1/2.39:1）を設
定する。

Aspect Ratio Type
Option（Line/Mask/
Line&Mask）

アスペクトマーカーの表示形態を選択する。
Line：Colorで設定されている色の線で表示す

る。
Mask：マーカー範囲外のビデオ信号レベルを下

げて表示する。
Line&Mask：マーカー範囲外のビデオ信号レベ

ルを下げて、Colorで設定されている色の線
で表示する。

Surround View Type
Option（Line/Mask/
Line&Mask）

サラウンドビューマーカーの表示形態を選択す
る。
Line：記録領域を線で表示する。
Mask：記録領域外側部のビデオ信号レベルを

落として表示する。
Line&Mask：記録領域外側部のビデオ信号レ

ベルを落として、記録領域を線で表示する。
Mask Level

Option（0 ～ 15（12））
Aspect Ratio TypeまたはSurround View 
TypeがMaskのとき、マーカーの外側の映像の
明るさを選択する。
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Monitoring > Overlays/Frame	Line
各種出力信号に重畳する情報やフレームラインに関する設定を行います。
On/Offの設定はチェックボックスで行います（Frame Line on Playbackを除く）。
On：チェックを付ける
Off：チェックを外す

メニュー項目 設定値 内容
Safety Zone

Line A（On/Off）
Line B（On/Off）
Option

（80%/90%/92.5%/95%）

Frame Line A およびFrame Line Bに設定した
出力情報にセーフティーゾーンを表示するかを選
択する。
セーフティーゾーンの範囲

（80%/90%/92.5%/95%）を選択する。
Aspect Safety Zone

Line A（On/Off）
Line B（On/Off）
Option

（80%/90%/92.5%/95%）

Frame Line A およびFrame Line Bに設定した
出力情報にアスペクトセーフティーゾーンを表示
するかを選択する。
アスペクトセーフティーゾーンマーカーの大きさ

（画面全体に対する比率）を選択する。
User Frame Line 1

Line A（On/Off）
Line B（On/Off）
Option

（Preset/Variable）

Frame Line A およびFrame Line Bに設定した
出力情報にユーザーフレームライン1を表示する
かを選択する。
ユーザーフレームライン1を任意に設定した表示
にするか、固定のアスペクト比を表示するかを
選択する。

User Frame Line 2
Line A（On/Off）
Line B（On/Off）
Option

（Preset/Variable）

Frame Line AおよびFrame Line Bに設定した
出力情報にユーザーフレームライン2を表示する
かを選択する。
ユーザーフレームライン2を任意に設定した表示
にするか、固定のアスペクト比を表示するかを
選択する。

Frame Line on Playback
Option（On/Off）

再生時にフレームラインを重畳する機能をオン／
オフする。

Monitoring > Frame	Line	Setup
出力映像に表示するラインやマーカーに関する設定を行います。

メニュー項目 設定値 内容
Color White/Yellow/Cyan/

Green/Magenta/Red/Blue
フレームラインの表示色を選択する。

Center Marker Cross/Open Cross/Dot センターマーカーの表示形態を選択する。
Aspect Ratio 17:9/16:9/15:9/14:9/13:9/ 

9:16/4:3/1:1/1.43:1/1.66:1/ 
1.85:1/2:1/2.35:1/2.39:1

アスペクトマーカーを表示するときのモードを選
択する。

Monitoring > Frame	Line	Setup
出力映像に表示するラインやマーカーに関する設定を行います。

メニュー項目 設定値 内容
Aspect Ratio Type Line/Mask/Line&Mask アスペクトマーカーの表示形態を選択する。

Line：Colorで設定されている色の線で表示す
る。

Mask：マーカー範囲外のビデオ信号レベルを下
げて表示する。

Line&Mask：マーカー範囲外のビデオ信号レベ
ルを下げて、Colorで設定されている色の線
で表示する。

Surround View 
Type

Line/Mask/Line&Mask サラウンドビューマーカーの表示形態を選択す
る。
Line：記録領域を線で表示する。
Mask：記録領域外側部のビデオ信号レベルを

落として表示する。
Line&Mask：記録領域外側部のビデオ信号レ

ベルを落として、記録領域を線で表示する。
Mask Level 0 ～ 15（12） Aspect Ratio TypeまたはSurround View 

TypeがMaskのとき、マーカーの外側の映像の
明るさを選択する。

Safety Zone 80%/90%/92.5%/95% セーフティーゾーンの範囲を選択する。
Aspect Safety Zone 80%/90%/92.5%/95% アスペクトセーフティーゾーンマーカーの大きさ

（画面全体に対する比率）を選択する。
Frame Line on 
Playback

On/Off 再生時にフレームラインを重畳する機能をオン／
オフする。

Monitoring > User	Frame	Line	1
ユーザーフレームライン1に関する設定を行います。

メニュー項目 設定値 内容
Select Preset/Variable ユーザーフレームライン1を任意に設定した表示

にするか、固定のアスペクト比を表示するかを
選択する。
Preset：Preset Aspect Ratio、Scaling、

Preset Aspect Ratio Typeで設定したアス
ペクト比を表示する。

Variable：Width、Height、H Position、V 
Position、Variable Aspect Typeで設定
した任意の矩形枠を表示する。
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Monitoring > User	Frame	Line	1
ユーザーフレームライン1に関する設定を行います。

メニュー項目 設定値 内容
Preset Aspect Ratio 17:9/16:9/15:9/14:9/13:9/ 

9:16/4:3/1:1/1.43:1/1.66:1/ 
1.85:1/2:1/2.35:1/2.39:1/ 
1.90:1 (W34)*
* 1.43:1設定時の水平画サイズを維

持したフレームラインです。6K 3:2
モードのときは、水平画サイズが
約34 mmとなります。

固定のアスペクト比を表示するときのモードを
選択する。

［ご注意］
SelectがPresetに設定されている場合のみ設定でき
ます。

Scaling 1% ～ 100%/‑‑‑ 固定のアスペクト比の拡大･縮小率を設定する。

［ご注意］
• SelectがPresetに設定されている場合のみ設定で

きます。
• Preset Aspect Ratioが1.90:1 (W34)に設定され

ている場合は、「‑‑‑」が表示され設定できません。

Preset Aspect Ratio 
Type

Line/Mask/Line&Mask 固定のアスペクト比の表示形態を選択する。
Line：線で表示する。
Mask：マーカー範囲外のビデオ信号レベルを下

げて表示する。
Line&Mask：マーカー範囲外のビデオ信号レベ

ルを下げて線で表示する。

［ご注意］
SelectがPresetに設定されている場合のみ設定でき
ます。

Aspect 
Ratio(Pixels)

アスペクト比（画素数、アナモ
フィック倍率）

有効画サイズに対するユーザーフレームライン1
のアスペクト比、画素数、アナモフィック倍率を
表示する。

［ご注意］
画素数はデアナモ変換する前の有効画サイズに対して
の値になります。

Width 3 ～ 480（240） ユーザーフレームライン1の幅（中心から左右端ま
での距離）を設定する。

［ご注意］
SelectがVariableに設定されている場合のみ設定で
きます。

Monitoring > User	Frame	Line	1
ユーザーフレームライン1に関する設定を行います。

メニュー項目 設定値 内容
Height 3 ～ 270（135） ユーザーフレームライン1の高さ（中心から上下端

までの距離）を設定する。

［ご注意］
SelectがVariableに設定されている場合のみ設定で
きます。

H Position 最大－477 ～ 477（±0） ユーザーフレームライン1の中心の水平位置を設
定する。
Widthを3より大きくした分だけ設定可能範囲
は狭くなります。

［ご注意］
SelectがVariableに設定されている場合のみ設定で
きます。

V Position 最大－267 ～ 267（±0） ユーザーフレームライン1の中心の垂直位置を設
定する。
Heightを3より大きくした分だけ設定可能範囲
は狭くなります。

［ご注意］
SelectがVariableに設定されている場合のみ設定で
きます。

Variable Aspect 
Type

Line 任意に設定するユーザーフレームライン1表示の
種類を表示する。

［ご注意］
SelectがVariableに設定されている場合のみ表示さ
れます。

Monitoring > User	Frame	Line	2
ユーザーフレームライン2に関する設定を行います。

メニュー項目 設定値 内容
Select Preset/Variable ユーザーフレームライン2を任意に設定した表示

にするか、固定のアスペクト比を表示するかを
選択する。
Preset：Preset Aspect Ratio、Scaling、

Preset Aspect Ratio Typeで設定したアス
ペクト比を表示する。

Variable：Width、Height、H Position、V 
Position、Variable Aspect Typeで設定
した任意の矩形枠を表示する。
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Monitoring > User	Frame	Line	2
ユーザーフレームライン2に関する設定を行います。

メニュー項目 設定値 内容
Preset Aspect Ratio 17:9/16:9/15:9/14:9/13:9/ 

9:16/4:3/1:1/1.43:1/1.66:1/ 
1.85:1/2:1/2.35:1/2.39:1/ 
1.90:1 (W34)*
* 1.43:1設定時の水平画サイズを維

持したフレームラインです。6K 3:2
モードのときは、水平画サイズが
約34 mmとなります。

固定のアスペクト比を表示するときのモードを
選択する。

［ご注意］
SelectがPresetに設定されている場合のみ設定でき
ます。

Scaling 1% ～ 100%/‑‑‑ 固定のアスペクト比の拡大･縮小率を設定する。

［ご注意］
•  SelectがPresetに設定されている場合のみ設定で

きます。
•  Preset Aspect Ratioが1.90:1 (W34)に設定され

ている場合は、「‑‑‑」が表示され設定できません。

Preset Aspect Ratio 
Type

Line 固定のアスペクト比の表示形態を表示する。

［ご注意］
SelectがPresetに設定されている場合のみ表示され
ます。

Aspect 
Ratio(Pixels)

アスペクト比（画素数、アナモ
フィック倍率）

有効画サイズに対するユーザーフレームライン2
のアスペクト比、画素数、アナモフィック倍率を
表示する。

［ご注意］
画素数はデアナモ変換する前の有効画サイズに対して
の値になります。

Width 3 ～ 480（240） ユーザーフレームライン2の幅（中心から左右端ま
での距離）を設定する。

［ご注意］
SelectがVariableに設定されている場合のみ設定で
きます。

Height 3 ～ 270（135） ユーザーフレームライン2の高さ（中心から上下端
までの距離）を設定する。

［ご注意］
SelectがVariableに設定されている場合のみ設定で
きます。

Monitoring > User	Frame	Line	2
ユーザーフレームライン2に関する設定を行います。

メニュー項目 設定値 内容
H Position 最大－477 ～ 477（±0） ユーザーフレームライン2の中心の水平位置を設

定する。
Widthを3より大きくした分だけ設定可能範囲
は狭くなります。

［ご注意］
SelectがVariableに設定されている場合のみ設定で
きます。

V Position 最大－267 ～ 267（±0） ユーザーフレームライン2の中心の垂直位置を設
定する。
Heightを3より大きくした分だけ設定可能範囲
は狭くなります。

［ご注意］
SelectがVariableに設定されている場合のみ設定で
きます。

Variable Aspect 
Type

Line 任意に設定するユーザーフレームライン2表示の
種類を表示する。

［ご注意］
SelectがVariableに設定されている場合のみ表示さ
れます。
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Audioメニュー
各メニュー項目の機能および設定値は次のとおりです。
太字とアンダーラインで表示されている設定値は、出荷時の設定です。
Audio > Audio	Input

録音レベルに関する設定を行います。

［ご注意］
AES/EBU信号が選択されている場合の録音レベルは固定になります。

メニュー項目 設定値 内容
Internal Mic Select Off / CH‑1/CH‑2 / CH‑3/

CH‑4
内蔵マイクの入力チャンネルを選択する。

XLR Audio L Select Auto/Manual Autoにすると、録音レベルは自動調整される。
XLR Audio R Select Auto/Manual Autoにすると、録音レベルは自動調整される。
XLR Audio L Level －99 ～±0～＋99 CH‑1 Audio SelectでManualを選択時、録音

レベルを調整する。
XLR Audio R Level －99 ～±0～＋99 CH‑2 Audio SelectでManualを選択時、録音

レベルを調整する。
XLR Mic Reference －60dB/－50dB/－40dB マイクの基準入力レベルを選択する。

Audio > Audio	Monitor
音声モニターに関する設定を行います。

メニュー項目 設定値 内容
Monitor CH Monitor Output CH Pairが

CH‑1/CH‑2の場合
CH-1/CH-2 、CH‑1、CH‑2

Monitor Output CH Pairが
CH‑3/CH‑4の場合
CH-3/CH-4 、CH‑3、
CH‑4

ヘッドホンおよびスピーカーに出力する音声チャ
ンネルを選択する。
CH‑1/CH‑2（CH‑3/CH‑4）：チャンネル1、2（チャ

ンネル3、4）
CH‑1（CH‑3）：チャンネル1（チャンネル3）のみ
CH‑2（CH‑4）：チャンネル2（チャンネル4）のみ

Monitor Level 0～ 99 モニター音量を調整する。

［ご注意］
内蔵スピーカーから内蔵マイクの収録音が聞こえる設
定の場合は、モニター音量を大きくするとハウリング
を起こすことがあります。

Audio > Audio	Configuration
音声の入出力に関する設定を行います。

メニュー項目 設定値 内容
Alarm Level 0～ 99 アラームの音量を調整する。

Audio > Audio	Configuration
音声の入出力に関する設定を行います。

メニュー項目 設定値 内容
Input Limiter Mode Off/－6dB/－9dB/－12dB/ 

－15dB/－17dB
オーディオ入力レベルの手動調整時、大きな入
力信号に対するリミッター特性（飽和レベル）を
選択する。リミッターを使用しない場合はOffを
選択する。

AGC Level －6dB/－9dB/－12dB/ 
－15dB/－17dB

AGCの特性（飽和レベル）を選択する。

AGC Mono/Stereo Mono/Stereo チャンネル1、2に記録するアナログオーディオ
信号の入力レベルの自動調整を、各チャンネル
で独立して行うか（Mono）、ステレオモードで行
うか（Stereo）を選択する。

MIC Input Mono/
Stereo

Mono/Stereo フロントマイクをモノラル（Mono）にするか、ス
テレオ（Stereo）にするかを選択する。

Phantom Power 
+48V

On/Off マイクに外部電源（ファントム電源）+48Vを供給
する機能をオン／オフする。

Monitor Output CH 
Pair

CH-1/CH-2、CH‑3/CH‑4 音声出力をチャンネル1と2にするか、チャンネ
ル3と4にするかを選択する。

Headphone Mono/
ST

Mono/Stereo ヘッドホンをモノラル（Mono）にするか、ステレ
オ（Stereo）にするかを選択する。
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Paintメニュー
各メニュー項目の機能および設定値は次のとおりです。

［ご注意］
Paintメニューの各項目を設定するには、Technicalメニュー > Special Configuration > RM/RCP Paint Control（93
ページ）がOnに設定されている必要があります。

太字とアンダーラインで表示されている設定値は、出荷時の設定です。
Paint > Black

ブラックレベルに関する設定を行います。
メニュー項目 設定値 内容
Master Black －99 ～±0 ～＋99 マスターブラックレベルを設定する。
R Black －99 ～±0 ～＋99 Rブラックレベルを設定する。
B Black －99 ～±0 ～＋99 Bブラックレベルを設定する。

Paint > Flare
フレア補正に関する設定を行います。

メニュー項目 設定値 内容
Setting On/Off フレア補正機能をオン／オフする。
Master Flare －99 ～±0 ～＋99 本体に起因するフレア補正のマスターフレアの

ユーザー調整値を設定する。
R Flare －99 ～±0 ～＋99 本体に起因するフレア補正のRフレアのユーザー

調整値を設定する。
G Flare －99 ～±0 ～＋99 本体に起因するフレア補正のGフレアのユーザー

調整値を設定する。
B Flare －99 ～±0 ～＋99 本体に起因するフレア補正のBフレアのユーザー

調整値を設定する。

Paint > Gamma
ガンマ補正に関する設定を行います。

メニュー項目 設定値 内容
Setting On/Off ガンマ補正機能をオン／オフする。
Gamma Category S‑Log3/HLG(Natural)/

HLG(Live)/User
ガンマカテゴリーの設定値は、Projectメニュー 
> Basic Setting > Input Color Space（74
ページ）の設定で決まるため表示のみ。

Paint > Gamma
ガンマ補正に関する設定を行います。

メニュー項目 設定値 内容
Gamma Select Gamma CategoryがS‑Log3

のとき：
S‑Log3

Gamma Categoryが
HLG(Natural)のとき：

HLG(Natural)
Gamma Categoryが
HLG(Live)のとき：

HLG(Live)
Gamma CategoryがUserのと
き：
User	1/User 2/User 3/
User 4/User 5

ガンマ補正に使用するガンマテーブルを選択す
る。

Paint > Black	Gamma
ブラックガンマ補正に関する設定を行います。

［ご注意］
Projectメニュー > Basic Setting > Input Color Space（74ページ）がS‑Gamut3.Cine/SLog3またはS‑Gamut3/
SLog3に設定されている場合は、Black Gammaはグレーアウトされ設定を変更できません。

メニュー項目 設定値 内容
Setting On/Off ブラックガンマ補正機能をオン／オフする。
Range Low/L.Mid/H.Mid ブラックガンマ補正の有効範囲を選択する。

Low：0% ～ 3.6%
L.Mid：0% ～ 7.2%
H.Mid：0% ～ 14.4%

Master Black 
Gamma

－99 ～±0 ～＋99 マスターブラックガンマレベルを設定する。

Paint > Knee
ニー補正に関する設定を行います。

［ご注意］
Projectメニュー > Basic Setting > Input Color Space（74ページ）がS‑Gamut3.Cine/SLog3またはS‑Gamut3/
SLog3に設定されている場合は、Kneeはグレーアウトされ設定を変更できません。

メニュー項目 設定値 内容
Setting On/Off ニー補正機能をオン／オフする。
Point －99 ～±0 ～＋99 ニーポイントを設定する。
Slope －99 ～±0 ～＋99 ニースロープを設定する。
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Paint > White	Clip
ホワイトクリップ調整に関する設定を行います。

［ご注意］
Projectメニュー > Basic Setting > Input Color Space（74ページ）がS‑Gamut3.Cine/SLog3またはS‑Gamut3/
SLog3に設定されている場合は、White Clipはグレーアウトされ設定を変更できません。

メニュー項目 設定値 内容
Setting On/Off ホワイトクリップ調整機能をオン／オフする。
Level 60.0% ～ 108.0% ～ 109.0% ホワイトクリップレベルを設定する。

Paint > Detail
ディテール調整に関する設定を行います。

メニュー項目 設定値 内容
Setting On/Off ディテール調整機能をオン／オフする。
Level －99 ～±0 ～＋99 ディテールレベルを設定する。
H/V Ratio －99 ～±0 ～＋99 HディテールレベルとVディテールレベルのミッ

クス比を設定する。
Crispening －99 ～±0 ～＋99 クリスプニングレベルを設定する。
Level Depend On/Off レベルディペンド調整機能をオン／オフする。
Level Depend Level －99 ～±0 ～＋99 レベルディペンドのレベルを設定する。
Frequency －99 ～±0 ～＋99 Hディテール信号の中心周波数を設定する。（値

を大きくするほどディテールは細くなる。）
Knee Aperture On/Off ニーアパーチャー補正機能をオン／オフする。
Knee Aperture 
Level

－99 ～±0 ～＋99 ニーアパーチャーレベルを設定する。

Limit －99 ～±0 ～＋99 白側、黒側両方向のディテールリミッターを設
定する。

White Limit －99 ～±0 ～＋99 白側のディテールリミッターを設定する。
Black Limit －99 ～±0 ～＋99 黒側のディテールリミッターを設定する。

Paint > Matrix
マトリクス補正に関する設定を行います。

メニュー項目 設定値 内容
Setting On/Off マトリクス補正機能をオン／オフする。
User Matrix On/Off ユーザーマトリクス補正機能をオン／オフする。
User Matrix R‑G －99 ～±0 ～＋99 マトリクス係数を個別に設定し、映像全域の色

相を微調整する。User Matrix R‑B －99 ～±0 ～＋99
User Matrix G‑R －99 ～±0 ～＋99
User Matrix G‑B －99 ～±0 ～＋99
User Matrix B‑R －99 ～±0 ～＋99
User Matrix B‑G －99 ～±0 ～＋99

Paint > Multi	Matrix
マルチマトリクス補正に関する設定を行います。

［ご注意］
MatrixがOffに設定されている場合は、Multi Matrixはグレーアウトされ設定を変更できません。

メニュー項目 設定値 内容
Setting On/Off 16軸の色相（ヒュー）空間で飽和度（サチュレー

ション）を設定するマルチマトリクス補正をオン
／オフする。

Area Indication On/Off 画面上のマルチマトリクス補正の対象となる色
の部分にゼブラパターンを表示する機能をオン／
オフする。

Reset Run/Cancel 各軸の[Hue]と[Saturation]をすべて初期値に
する（Runで実行）。

Axis B/B+/MG‑/MG/MG+/R/R+/
YL‑/YL/YL+/G‑/G/G+/CY/
CY+/B‑

マルチマトリクス補正の対象となる色（16軸モー
ド）を設定する。

Hue －99 ～±0 ～＋99 マルチマトリクス補正の対象となる色の色相
（ヒュー）を16軸ごとに設定する。

Saturation －99 ～±0 ～＋99 マルチマトリクス補正の対象となる色の飽和度
（サチュレーション）を16軸ごとに設定する。
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Technicalメニュー
各メニュー項目の機能および設定値は次のとおりです。
太字とアンダーラインで表示されている設定値は、出荷時の設定です。
Technical > System	Configuration

本機の制御に関する設定を行います。
メニュー項目 設定値 内容
Fan Control Auto / Max /  

Off	in	Rec/Auto / Off in 
Rec/Max

ファンの制御モードを選択する。
Auto：常時内部温度に応じて自動制御する。
Max：常時最大回転数で動作する。
Off in Rec/Auto：録画中は静音状態で動作し、

録画中以外は内部温度に応じて自動制御す
る。

Off in Rec/Max：録画中は静音状態で動作し、
録画中以外は最大回転数で動作する。

Shutter Mode Speed/Angle 電子シャッターの動作モードを選択する。
SDI Rec Remote 
Trigger

Off / HD SDI Remote I/F / 
Parallel Rec

SDIリモート制御方式を選択する。
Off：リモート制御しない。
HD SDI Remote I/F：制御方式をHD SDI 

Remoteにする。
Parallel Rec：制御方式をValid Flagにする。

Level Gauge Adjust Run/Cancel 水準器のゼロ調整を実行する（Runで実行）。
Level Gauge Reset Run/Cancel 水準器のゼロ調整値をリセットする（Runで実

行）。

Technical > Lens	Configuration
レンズに関する設定を行います。

メニュー項目 設定値 内容
PL‑Mt Interface 
Position

Top/Side/Off PLマウントレンズのインターフェース位置を設定
する。

［ご注意］
接続するレンズに応じて、接続前にあらかじめ設定して
ください。レンズを装着した状態で設定を変更した場
合は、本機を再起動してください。

PL‑Mt Voltage 8	V		24	V/24 V PLマウントレンズとの通電方式を設定する。

Focus Distance 
Format

Meter/Feet フォーカスポジション表示の単位を選択する。

Lens 12pin On/Off レンズIF 12pinをオン／オフする。

［ご注意］
レンズを装着した状態で設定を変更した場合は、本機
を再起動してください。

Technical > Lens	Configuration
レンズに関する設定を行います。

メニュー項目 設定値 内容
E‑Mount Shading 
Comp.

Auto/Off 対応レンズが装着されている場合に周辺光量落
ちを補正するかを設定する。

E‑Mt Chro. Aber. 
Comp.

Auto/Off 対応レンズが装着されている場合に倍率色収差
を補正するかを設定する。

Technical > Auto	Pixel	Restore
Auto Pixel Restoration（イメージセンサーの自動調整）を実行します。

メニュー項目 設定値 内容
Auto Pixel 
Restoration

Run/Cancel 自動欠陥補正（自動ピクセルノイズリダクション）
機能を実行する（Runで実行）。

Reset Run/Cancel APRの実行によって追加登録された白点データ
を削除する（Runで実行）。

Technical > Authentication
ネットワークの基本認証に関する設定を行います。

メニュー項目 設定値 内容
User Name （現在のユーザー名を表示） アクセス認証に使用する任意のユーザー名を設

定する。
出荷時はadminに設定されています。

Password （*******） アクセス認証に使用するパスワードを設定する
（8文字以上で英数字をそれぞれ1文字以上）。
パスワード入力時、サブディスプレイのITEMキー
1を押している間、「*」（アスタリスク）を入力し
た文字に変更して表示する。

Technical > Network
ネットワークに関する設定を行います。

メニュー項目 設定値 内容
Setting LAN/Wireless/Off ネットワーク接続の方法を設定する。

［ご注意］
Technicalメニュー > Authentication > Password

（89ページ）が設定されていない場合は、グレーア
ウトされ設定できません。
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Technical > Network
ネットワークに関する設定を行います。

メニュー項目 設定値 内容
LAN DHCP（On/Off） DHCPを設定する。

Onにすると、自動的に本機にIPアドレスを割り
当てる。手動で本機のIPアドレスを入力する場
合は、Offにする。

IP Address（DHCP/On：
自動取得、DHCP/Off：
192.168.2.50）

本機のIPアドレスを入力する。
DHCPがOffのときに有効。

Subnet Mask（DHCP/On：
自動取得、DHCP/Off：
255.255.255.0）

本機のサブネットマスクを入力する。
DHCPがOffのときに有効。

Wireless Network Mode（Access	
Point/Station）

ワイヤレス接続する際のネットワークモードを設
定する。

Scan Networks（Run/Cancel） 接続先のアクセスポイントの自動検出を実行する
（Runで実行）。

［ご注意］
Network ModeがStationに設定されている場合のみ
設定できます。

SSID Network ModeがAccess Pointの場合
本機のワイヤレス接続用のSSIDを表示す
る。

Network ModeがStationの場合
接続先のアクセスポイントのSSIDを設定・
表示する。

［ご注意］
表示または入力できる文字は以下のとおりです。
アルファベット（A ～ Z、a ～ z）
数字（0 ～ 9‑.@ —_()）
記号（!"#$%&'*+,/:;<=>?[\]^̀ {|}~）

Technical > Network
ネットワークに関する設定を行います。

メニュー項目 設定値 内容
Password Network ModeがAccess Pointの場合

本機のワイヤレス接続用のパスワードを表
示する。

Network ModeがStationの場合
接続先のアクセスポイントのパスワードを設
定する。
パスワード入力時、サブディスプレイのITEM
キー 1を押している間、「*」（アスタリスク）
を入力した文字に変更して表示する。

［ご注意］
表示または入力できる文字は以下のとおりです。
アルファベット（A ～ Z、a ～ z）
数字（0 ～ 9‑.@ —_()）
記号（!"#$%&'*+,/:;<=>?[\]^̀ {|}~）

WPS（Run/Cancel） WPSによる接続設定を開始する（Runで実行）。
Channel（Auto(5GHz)/Auto/
CH1/CH2/CH3/CH4/CH5/
CH6/CH7/CH8/CH9/CH10/
CH11）

アクセスポイントのチャンネルを設定する。

［ご注意］
• Network ModeがAccess Pointに設定されている

場合のみ設定できます。
• Auto(5GHz)は、ご使用になるワイヤレスLANモ

ジュールにより、表示されない場合があります。ワ
イヤレスLANモジュールが、ご使用になる国／地域
に対応しているかご確認ください。詳しくは、ワイ
ヤレスLANモジュールの取扱説明書をご覧くださ
い。

DHCP（On/Off） DHCPを設定する。
Onにすると、自動的に本機にIPアドレスを割り
当てる。手動で本機のIPアドレスを入力する場
合は、Offにする。

［ご注意］
Network ModeがStationに設定されている場合のみ
設定できます。

IP Address（DHCP/On：
自動取得、DHCP/Off：
192.168.1.50）

本機のIPアドレスを入力する。
DHCPがOffのときに有効。

［ご注意］
Network ModeがStationに設定されている場合のみ
設定できます。
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Technical > Network
ネットワークに関する設定を行います。

メニュー項目 設定値 内容
Subnet Mask（DHCP/On：
自動取得、DHCP/Off：
255.255.255.0）

本機のサブネットマスクを入力する。
DHCPがOffのときに有効。

［ご注意］
Network ModeがStationに設定されている場合のみ
設定できます。

MAC Address 本機に接続されているワイヤレスLANアダプ
ターのMACアドレスを表示する。

Regenerate Password（Run/
Cancel）

パスワードの再生成を実行する（Runで実行）。

［ご注意］
Network ModeがAccess Pointに設定されている場
合のみ実行できます。

Technical > Alerts	&	Tally
RECボタンとメディア残量アラームに関する設定を行います。

メニュー項目 設定値 内容
Rec Light On/Off RECランプをオン／オフする。
Rec Start/Stop 
Beep

0 ～ 99 記録開始・終了操作時のビープ音量を調整する。

Media Near Full 
Alarm

1min/3min/5min メディア残量が少なくなったことを知らせるア
ラームの閾値を設定する。

Technical > Batt./Voltage	Alarm
バッテリーと外部DC電源電圧アラームに関する設定を行います。

メニュー項目 設定値 内容
Near End:Info 
Battery

5%～ 100%（5%刻み） インフォバッテリー使用時にバッテリー残量表
示が点滅するしきい値を設定する。

End:Info Battery 0%～ 5% インフォバッテリー使用時に「Battery End」を
表示するしきい値を設定する。

Near End:Sony 
Battery

11.5V～ 17V （0.1V刻み） ソニー製の非インフォバッテリー使用時にバッテ
リー残量表示が点滅するしきい値を設定する。

End:Sony Battery 11.0V～ 12.5V （0.1V刻み） ソニー製の非インフォバッテリー使用時に
「Battery End」を表示するしきい値を設定する。

Near End:Other 
Battery

11.5V ～ 17V（11.8V）（0.1V刻み） ソニー製以外のバッテリー使用時にバッテリー
残量表示が点滅するしきい値を設定する。

End:Other Battery 11.0V～ 14V （0.1V刻み） ソニー製以外のバッテリー使用時に「Battery 
End」を表示するしきい値を設定する。

Technical > Batt./Voltage	Alarm
バッテリーと外部DC電源電圧アラームに関する設定を行います。

メニュー項目 設定値 内容
Detected Battery Sony Info Battery/Sony 

Battery/Other Battery/DC 
IN (12V)/DC IN (24V)

バッテリーの種類を自動判別した結果を表示す
る。

DC Low Voltage1 11.5V～ 17V （0.1V刻み） DC IN端子に外部電源を接続している場合に入
力電圧の低下警告を表示するしきい値を設定す
る。

DC Low Voltage2 11.0V～ 14V （0.1V刻み） DC IN端子に外部電源を接続している場合に入
力電圧の不足警告を表示するしきい値を設定す
る。

DC(24V) Low 
Voltage1

22.5V～ 34.0V （0.1V刻み） DC IN端子に24V外部電源を接続している場合
に入力電圧の低下警告を表示するしきい値を設
定する。

DC(24V) Low 
Voltage2

22.0V～ 28.0V （0.1V刻み） DC IN端子に24V外部電源を接続している場合
に入力電圧の不足警告を表示するしきい値を設
定する。

Technical > Panel	Control
ディスプレイに関する設定を行います。

メニュー項目 設定値 内容
Brightness level High/Mid/Low/Minimum サブディスプレイとミニディスプレイの明るさを

調整する。
Lock Operator Side without	Rec	Button /  

without Assign3 Button / 
without Rec/Assign3 /  
with Rec/Assign3 Button

オペレーターサイドのLOCKスイッチによって
ロックされるボタンにRECボタンまたはAssign3
ボタンを含めるかどうかを設定する。

Lock Assistant Side without	Rec	Button /  
with Rec Button

アシスタントサイドのLOCKスイッチによってロッ
クされるボタンにRECボタンを含めるかどうかを
設定する。
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Technical > False	Color
フォルスカラーに関する設定を行います。

［ご注意］
Technicalメニュー > Special Configuration > RM/RCP Paint Control（93ページ）がOnに設定されている場合は、
False Colorはグレーアウトされ設定を変更できません。

メニュー項目 設定値 内容
Level Preset/Manual ビューファインダーおよびモニター出力のフォル

スカラーの各色のオン／オフと閾値をプリセット
にするか手動にするかを設定する。
Manualにすると、これ以降の項目を設定でき
ます。

Red On/Off 赤色の表示のオン／オフを設定する。
Red Upper Limit 0.0% ～ 109.0%（96.1%）（0.1%

刻み）
赤色で表示する上限値を設定する。

Red Lower Limit 0.0% ～ 109.0%（93.4%）（0.1%
刻み）

赤色で表示する下限値を設定する。

Yellow On/Off 黄色の表示のオン／オフを設定する。
Yellow Upper Limit 0.0% ～ 109.0%（93.4%）（0.1%

刻み）
黄色で表示する上限値を設定する。

Yellow Lower Limit 0.0% ～ 109.0%（91.3%）（0.1%
刻み）

黄色で表示する下限値を設定する。

Orange On/Off オレンジ色の表示のオン／オフを設定する。
Orange Upper Limit 0.0% ～ 109.0%（90.6%）

（0.1%刻み）
オレンジ色で表示する上限値を設定する。

Orange Lower Limit 0.0% ～ 109.0%（87.7%）（0.1%
刻み）

オレンジ色で表示する下限値を設定する。

Pink On/Off ピンク色の表示のオン／オフを設定する。
Pink Upper Limit 0.0% ～ 109.0%（58.0%）

（0.1%刻み）
ピンク色で表示する上限値を設定する。

Pink Lower Limit 0.0% ～ 109.0%（54.3%）
（0.1%刻み）

ピンク色で表示する下限値を設定する。

Light Pink On/Off ライトピンク色の表示のオン／オフを設定する。
Light Pink Upper 
Limit

0.0% ～ 109.0%（50.8%）
（0.1%刻み）

ライトピンク色で表示する上限値を設定する。

Light Pink Lower 
Limit

0.0% ～ 109.0%（47.8%）（0.1%
刻み）

ライトピンク色で表示する下限値を設定する。

Cyan On/Off シアン色の表示のオン／オフを設定する。
Cyan Upper Limit 0.0% ～ 109.0%（46.5%）

（0.1%刻み）
シアン色で表示する上限値を設定する。

Technical > False	Color
フォルスカラーに関する設定を行います。

［ご注意］
Technicalメニュー > Special Configuration > RM/RCP Paint Control（93ページ）がOnに設定されている場合は、
False Colorはグレーアウトされ設定を変更できません。

メニュー項目 設定値 内容
Cyan Lower Limit 0.0% ～ 109.0%（43.8%）

（0.1%刻み）
シアン色で表示する下限値を設定する。

Green On/Off 緑色の表示のオン／オフを設定する。
Green Upper Limit 0.0% ～ 109.0%（42.2%）

（0.1%刻み）
緑色で表示する上限値を設定する。

Green Lower Limit 0.0% ～ 109.0%（38.9%）
（0.1%刻み）

緑色で表示する下限値を設定する。

Light Blue On/Off ライトブルー色の表示のオン／オフを設定する。
Light Blue Upper 
Limit

0.0% ～ 109.0%（34.4%）
（0.1%刻み）

ライトブルー色で表示する上限値を設定する。

Light Blue Lower 
Limit

0.0% ～ 109.0%（24.6%）
（0.1%刻み）

ライトブルー色で表示する下限値を設定する。

Blue On/Off 青色の表示のオン／オフを設定する。
Blue Upper Limit 0.0% ～ 109.0%（5.6%）（0.1%

刻み）
青色で表示する上限値を設定する。

Blue Lower Limit 0.0% ～ 109.0%（3.5%）（0.1%
刻み）

青色で表示する下限値を設定する。

Purple On/Off 紫色の表示のオン／オフを設定する。
Purple Upper Limit 0.0% ～ 109.0%（3.5%）（0.1%

刻み）
紫色で表示する上限値を設定する。

Purple Lower Limit －7.3% ～ 109.0%（－7.3%）
（0.1%刻み）

紫色で表示する下限値を設定する。

Reset Run/Cancel 各色のオン／オフと閾値を初期値にする（Runで
実行）。
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Technical > Test	Signals
カラーバーに関する設定を行います。

メニュー項目 設定値 内容
Color Bars On/Off カラーバーをオン／オフする。

［ご注意］
• RM‑B170などのリモートコントロールユニット接続

時は、リモートコントロールユニットからの設定値
が表示され、グレーアウトされます。

• カラーバーをオンにしてもカラーバーは記録されま
せん。撮影した映像が記録されます。

Color Bar Type ARIB/SMPTE カラーバーの種類を選択する。
1kHz Tone on Color 
Bars

On/Off カラーバーモード時に1kHzのテスト信号を出力
する機能をオン／オフする。

Test Saw On/Off テスト信号をオン／オフする。
Test Saw Type Saw/Step Saw テスト信号の種類を選択する。

Saw：テスト信号としてSaw波形を出力する。
Step Saw：テスト信号としてStep波形を出力す

る。

Technical > Special	Configuration
本機の制御に関する設定を行います。

メニュー項目 設定値 内容
RM/RCP Paint 
Control

On/Off RM‑B170などのリモートコントロールユニット
のペイント機能をオン／オフする。

［ご注意］
RM/RCP Paint Controlの設定を変更すると、本機
のすべての設定が初期化されます。ただし、RM/RCP 
Paint Controlやネットワークの設定など一部初期化さ
れない設定があります。

NR(4K 17:9/16:9) On/Off 4K 17:9/16:9 記録画像のノイズリダクションの
オン／オフを設定する。

［ご注意］
以下の機能が有効のときはオフ固定になります。
• Select FPS
• Anamo. De‑Squeeze：Off(1.0x)以外
• Flip Image：Normal以外

Technical > Special	Configuration
本機の制御に関する設定を行います。

メニュー項目 設定値 内容
SD HDMI On/Off HDMI出力信号をSDフォーマットにする機能を

オン／オフする。

［ご注意］
以下の条件をすべて満たす場合に、Onに設定できます。
Imager Mode：16:9（Zoom to Fitが16:9のときを含
む）
Recording Format：X‑OCN ST
Project Frame Rate：50または59.94

360° Shutter 
Setting

Pre	Shutter	On/Pre Shutter 
Off

360°シャッター（シャッターオフ）時のプリシャッ
ターをオン／オフする。
Pre Shutter On：プリシャッターをオンにする。
Pre Shutter Off：プリシャッターをオフにする。

［ご注意］
Pre Shutter Offに設定すると、フラッシュなどの過
大光量入射時に残像が1フレーム残る場合があります。
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Maintenanceメニュー
各メニュー項目の機能および設定値は次のとおりです。
太字とアンダーラインで表示されている設定値は、出荷時の設定です。
Maintenance > Language

メニューとメッセージの表示言語を選択します。
メニュー項目 設定値 内容
Select English/中文(简) フルメニューとメニュー、メッセージの表示言語

を選択する。

Maintenance > Clock	Set
内蔵時計に関する設定を行います。

メニュー項目 設定値 内容
Time Zone UTC +14:00 ～ UTC	

Greenwich ～ UTC ‑12:00（30
分単位）

UTC（グリニッジ標準時）からの時差を30分単位
で選択する。

Date Mode YYMMDD/MMDDYY/
DDMMYY

年月日の表示方式を選択する。
YYMMDD：年月日の順
MMDDYY：月日年の順
DDMMYY：日月年の順

Date 現在の日付を設定する（Setを押して決定）。
Time 現在の時刻を設定する（Setを押して決定）。

Maintenance > Hours	Meter
積算時間を表示します。

メニュー項目 設定値 内容
Hours (System) 本機の積算使用時間（リセット不可）を表示する。
Hours (Resettable) 本機の積算使用時間(リセット可)を表示する。
Reset Run/Cancel 本機のHours (Resettable)表示を0にリセット

する（Runで実行）。

Maintenance > Reset	to	Default
本機を工場出荷状態に戻します。

メニュー項目 設定値 内容
Reset Run/Cancel 本機のすべての設定を初期化する（Runで実行）。

Maintenance > Network	Reset
ネットワーク関連設定を工場出荷状態に戻します。

メニュー項目 設定値 内容
Reset Run/Cancel ネットワーク関連の設定を初期化する（Runで実

行）。

Maintenance > License	Options
ソフトウェアオプションをインストールします。

メニュー項目 設定値 内容
Install: 「対象ライセン
ス」

Run/Cancel ソフトウェアオプションをインストールする（Run
で実行）。

Anamorphic XXdays Remaining (Ykeys)/
Permanent License 
Installed/Not Installed/
Expired

アナモフィックオプションが有効かどうかを表示
する。
XXdays Remaining (Ykeys)：時限ライセンス

期限内
Permanent License Installed：永久ライセン

スインストール済み
Not Installed：未インストール
Expired：時限ライセンス期限切れ

Full‑Frame XXdays Remaining (Ykeys)/
Permanent License 
Installed/Not Installed/
Expired

フルフレームオプションが有効かどうかを表示す
る。
XXdays Remaining (Ykeys)：時限ライセンス

期限内
Permanent License Installed：永久ライセン

スインストール済み
Not Installed：未インストール
Expired：時限ライセンス期限切れ

Unique Device ID ソフトウェアオプションのライセンスキーの発行
手続きに使用するIDを表示する。

Maintenance > Firmware
本機のバージョン表示および本機のバージョンアップを実行します。

メニュー項目 設定値 内容
Version 本機のファームウェアバージョンを表示する（Vx.

xx）。
Firmware Update Run/Cancel 本機をバージョンアップする（Runで実行する）。
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サブディスプレイのクリップ操作
クリップ操作は、クリップリスト画面と再生画面の2つの画面で構成されています。サブディスプレイ
に表示されるクリップリスト画面から再生するクリップを選択して、クリップを再生できます。

クリップリスト画面

アシスタントサイドのCLIPSボタン（11ページ）を押すと、サブディスプレイに再生可能なメディアの
クリップリスト画面が表示されます。

5

4

1 2 3

13
12
11
10
9
8
7
6

1.	 メディア切り換えボタン
ITEMキー 1を押すと再生するメディアスロットを
切り換えることができます。

2.	上方向カーソル移動ボタン
ITEMキー 2を押して、クリップ一覧から再生する
クリップを選択します。

3.	 再生開始ボタン
ITEMキー 3を押すと、再生画面（16ページ）
が表示され、再生が開始されます。

4.	クリップ一覧
再生アクティブメディア内のクリップ一覧が表示
されます。また、クリップの状態がアイコンで表
示されます。

アイコン 意味
（再生不可） 再生できないクリップ

5.	 下方向カーソル移動ボタン
ITEMキー 5を押して、クリップ一覧から再生する
クリップを選択します。

6.	再生メディア内のクリップ位置
カーソルがあるクリップのクリップ番号/総数が
表示されます。

7.	 作成日時
カーソルがあるクリップの作成日時が表示されま
す。

8.	フォーマット（コーデック）
カーソルがあるクリップのフォーマット（コーデッ
ク）が表示されます。

9.	画サイズ表示
カーソルがあるクリップを記録したときの有効画
サイズが表示されます。

10.	プロジェクトフレームレート／特殊記録表示
カーソルがあるクリップのプロジェクトフレーム
レートと特殊記録が表示されます。

11.	 デュレーション（Dur）
カーソルがあるクリップのデュレーションが表示
されます。

12.	タイムコード（TCR）
カーソルがあるクリップの先頭フレームのタイム
コードが表示されます。

13.	再生アクティブメディア
表示しているリストの再生アクティブメディアが
表示されます。メディアの状態がアイコンで表示
されます。

アイコン 意味

（プロテクト） 書き込み禁止されているメ
ディア
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再生画面

クリップリスト画面で再生するクリップを選択し、MENUダイヤルまたはPlayボタン（ITEMキー 3）を押
すと、再生画面が表示されます。

機能表示部

1 2 3

4 5 6

1.	 F	Revボタン
逆方向に高速再生します。

2.	 Play/Pauseボタン
クリップの再生または再生を一時停止します。

3.	 F	Fwdボタン
順方向に高速再生します。

4.	Prevボタン
逆方向にクリップの頭出しをします。

5.	 Stop/Clipsボタン
再生を停止し、クリップ一覧画面に戻ります。

6.	Nextボタン
順方向にクリップの頭出しをします。

ステータス表示部

1 2 3 4

5
13

67911

12

810

1.	 タイムデータ表示
再生位置のタイムコードが表示されます。

2.	再生状態
再生状態が表示されます。
CALLコマンドを受信すると、「CALL」が表示さ
れます。

3.	 フレームレート表示
プロジェクトフレームレートが表示されます。

4.	電源電圧／バッテリー残量表示
電源電圧またはバッテリー残量が表示されます。

5.	 音声レベルメーター
再生音声レベルが表示されます。

6.	特殊記録表示
再生クリップの特殊記録情報が表示されます。

7.	 再生クリップフォーマット（コーデック）表示
再生クリップのフォーマット（コーデック）が表示
されます。

8.	イメージャーモード表示
画サイズが表示されます。

9.	クリップ名
クリップ名が表示されます。

10.	クリップ番号
再生中のクリップ番号／再生可能なクリップ総数
が表示されます。

11.	メディア表示
再生しているメディアが表示されます。
メモリーカードがプロテクトされている場合は、
右に （プロテクト）アイコンが表示されます。

12.	温度計アイコン
温度上昇に関する警告メッセージがあるときに表
示されます。
メニューのInfoカテゴリーに内容が表示されま
す。

13.	警告アイコン
温度上昇を除く警告メッセージがあるときに表示
されます。
メニューのInfoカテゴリーに内容が表示されま
す。
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再生
本機が記録停止中（Stby）のときは、記録したク
リップを再生することができます。

［ご注意］
• ProRes記録されたクリップを再生した場合、Shooting

メニュー > LUT Select（70ページ）で設定したLUTは
再生映像に適用されません。

• 各再生項目はITEMキー 1 ～ 6（10ページ）にそれぞれ
対応しています。ITEMキーを押すと、対応する項目の
操作ができます。

1 再生するAXSメモリーカードを入れる。

2 アシスタントサイドのCLIPSボタン
（11ページ）を押す。
サブディスプレイに再生アクティブなメディ
アのクリップリスト画面が表示されます。

3 （ITEMキー 2）ボタン、 （ITEMキー 5）
ボタンまたはMENUダイヤルで再生するク
リップを選択する。

4 MENUダイヤルまたはPlayボタン（ITEMキー
3）を押す。
ビューファインダー・モニター画面に再生画
面が表示されます。

再生操作について

再生操作はサブディスプレイのボタンで行います
（96ページ）。
Play/Pauseボタン：再生を一時停止します。も

う一度押すと再生モードに戻ります。
F Fwdボタン/F Revボタン：高速再生します。

Play/Pauseボタンを押すと標準再生に戻り
ます。

Stop/Clipsボタン：再生を停止し、クリップリス
ト画面になります。

音声を聞く

標準再生モードでは、記録されている音声を内
蔵スピーカー（9ページ）またはヘッドホンで
モニターできます。
ヘッドホン端子（9ページ）にヘッドホンをつ
なぐと、内蔵スピーカーはオフになります。
モニターするチャンネルの選択および音量の調整
は、メニューのAudioカテゴリー > Monitor CH
およびMonitor Level（59ページ）で行います。

頭出しする

クリップの先頭から再生するにはサブディスプレ
イ（96ページ）のPrevボタンを押して頭出しし
ます。
PrevボタンまたはNextボタンを複数回押すこと
で、クリップを飛ばして頭出しすることができま
す。

AXSメモリーカードを切り換える

AXSメモリーカードが2枚装着されているときは、
SLOT SELECTボタン（9ページ）を押して切り
換えます。または、サブディスプレイにクリップ
リスト画面が表示されているときは、サブディス
プレイのITEMキー 1を押して切り換えることもで
きます。

［ご注意］
再生中にAXSメモリーカードを切り換えることはできませ
ん。またスロットAからスロットBへの連続再生はできませ
ん。
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ミニディスプレイのホーム画面の操作方法
ミニディスプレイのホーム画面では、本機の状態
の確認や基本的な項目を設定できます。

1
2
3
4
5

1.	 FPS
撮像フレームレートの設定

2.	 Shutter
電子シャッターの開角度／スピードの表示／設定

3.	 ND	Filter
NDフィルターの濃度の表示／設定

4.	 Exposure	Index/Gain
Exposure Indexの表示／設定またはRM‑B170
などのリモートコントロールユニットで設定したゲ
イン値（dB単位）の表示／設定

[ご注意]
ゲイン値は、Technicalメニュー > Special 
Configuration > RM/RCP Paint Control（93ページ）
がOnに設定されている場合のみ表示されます。

5.	 WB（White	Balance）
ホワイトバランスの表示／設定

RM/RCP Paint Control有効時の表
示と動作について

• Technicalメニュー > Special Configuration 
> RM/RCP Paint Control（93ページ）
がOnに設定されている場合は、Exposure 
Indexの代わりにゲイン値が表示されます。こ
の場合、EI値は変更できませんが、ゲイン値を
変更できます。

• Technicalメニュー > Special Configuration 
> RM/RCP Paint Control（93ページ）が
Onで、RM‑B170などのリモートコントロール
ユニット接続時は、以下の項目は操作できま
せん。リモートコントロールユニットで設定して
ください（119ページ）。

• Shutter
• WB（White Balance）

操作部

HOMEボタン（9ページ）
ホーム画面に戻ります。確定前の変更はキャンセ
ルされます。

ITEMキー 1（ （上））（9ページ）
ホーム画面の項目を選びます。

ITEMキー 2（ （決定））（9ページ）
選択している項目を決定します。

ITEMキー 3（ （下））（9ページ）
ホーム画面の項目を選びます。

基本操作

1 ITEMキー 1、2、3のいずれかを押す。
カーソルが表示されます。

2 （ITEMキー 1）ボタン、 （ITEMキー 3）
ボタンで設定したい項目を選ぶ。

3 （決定）ボタン（ITEMキー 2）を押す。
選んだ項目の設定値の選択画面が表示され
ます。

 [ご注意]
（黒丸）アイコンは現在の設定値を示しています。

4 （ITEMキー 1）ボタン、 （ITEMキー 3）
ボタンで、選択項目または設定値にカーソル
を合わせる。

5 （決定）ボタン（ITEMキー 2）を押して決定
する。

6 HOMEボタンを押してカーソルを消す。
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ミニディスプレイのホーム画面設定項目一覧

各項目名称と設定内容は次のとおりです。
太字とアンダーラインで表示されている設定値は、出荷時の設定です。

項目 内容
FPS 撮像フレームレートを設定する。

Fixed/Variable：サブディスプレイのホーム画面（45ページ）で等速撮影と
可変速撮影を切り換えます。

「Fixed」を選択した場合、メニューのProjectカテゴリー > Project Frame 
Rate（56ページ）の設定で値が決まります。

Project Frame Rate 表示

23.98 Fix 23.98

24 Fix 24.00

25 Fix 25.00

29.97 Fix 29.97

47.95 Fix 47.95

50 Fix 50.00

59.94 Fix 59.94

「Variable」を選択した場合、Projectカテゴリー > Imager Mode（74ペー
ジ）とRecording Format（74ページ）の設定によって、設定値が次のよう
に異なります。

X-OCN記録時
MPC‑3628

Imager Mode 撮像フレームレート
8.6K 3:2 1 ～ 30 FPS

8.2K 17:9
7.6K 16:9

1 ～ 60 FPS

5.8K 6:5 1 ～ 48 FPS
5.8K 17:9
5.4K 16:9

1 ～ 60、66、72、75、88、90 FPS

項目 内容
MPC‑3626

Imager Mode 設定値
6K 3:2 1 ～ 60 FPS

6K 1.85:1
6K 17:9
5.7K 16:9

1 ～ 60、66、72 FPS

6K 2.39:1 1 ～ 60、66、72、75、88、90 FPS
4K 6:5 1 ～ 60、66、72 FPS
4K 4:3 1 ～ 60、66、72、75 FPS
4K 4:3 Surround View 1 ～ 30 FPS
4K 17:9
3.8K 16:9

1 ～ 60、66、72、75、88、90、96、100、
110 FPS

4K 17:9 Surround View
3.8K 16:9 Surround 
View

1 ～ 48 FPS

4K 2.39:1 1 ～ 60、66、72、75、88、90、96、100、
110、120 FPS

ProRes記録時
MPC‑3628

Imager Mode 撮像フレームレート
ProRes 4K / QFHD
4444 422 HQ

8.2K 17:9
7.6K 16:9

1 ～ 60 FPS 1 ～ 60 FPS

5.8K 6:5 1 ～ 48 FPS 1 ～ 48 FPS
5.8K 17:9
5.4K 16:9

1 ～ 60 FPS 1 ～ 60、66、72、
75 FPS



3章　カメラ操作：ミニディスプレイのホーム画面の操作方法100

項目 内容
MPC‑3626

Imager Mode 撮像フレームレート
ProRes 4K / QFHD
4444 422 HQ

6K 17:9
5.7K 16:9

1 ～ 60 FPS 1 ～ 60、66、72 FPS

6K 2.39:1 1 ～ 60 FPS 1 ～ 60、66、72、
75 FPS

4K 6:5 1 ～ 60 FPS 1 ～ 60、66、72 FPS
4K 17:9
3.8K 16:9

1 ～ 60 FPS 1 ～ 60、66、72、75、
88、90 FPS

4K 17:9 Surround View
3.8K 16:9 Surround 
View

1 ～ 48 FPS 1 ～ 48 FPS

4K 2.39:1 1 ～ 60 FPS 1 ～ 60、66、72、75、
88、90 FPS

［ご注意］
以下に設定されている場合は、7以下の撮像フレームレートを設定できません。

 ‒ Base ISOがISO 3200 
 ‒ Base ISOがISO 2500かつ記録フォーマットがProRes

Exposure Index EI値を設定する。Projectメニュー > Basic Setting > Base ISO（74ページ）
の設定によって、設定値が次のように異なります。
MPC‑3628

Base ISO 800：
200EI/250EI/320EI/400EI/500EI/640EI/800EI/1000EI/1250EI/ 
1600EI/2000EI/2500EI/3200EI

Base ISO 3200：
800EI/1000EI/1250EI/1600EI/2000EI/2500EI/3200EI/4000EI/ 
5000EI/6400EI/8000EI/10000EI/12800EI

MPC‑3626
ISO 500：

125EI/160EI/200EI/250EI/320EI/400EI/500EI/640EI/800EI/ 
1000EI/1250EI/1600EI/2000EI

ISO 2500：
640EI/800EI/1000EI/1250EI/1600EI/2000EI/2500EI/3200EI/ 
4000EI/5000EI/6400EI/8000EI/10000EI

項目 内容
Gain 基準感度を設定する。

－6dB/－3dB/0dB/3dB/6dB/9dB/12dB/15dB/18dB

［ご注意］
Technicalメニュー > Special Configuration > RM/RCP Paint Control（93ページ）
がOnで、RM‑B170などのリモートコントロールユニットが接続されていない場合のみ設
定できます。

Shutter 電子シャッターの開角度／スピードを設定する。
ステップシャッターとして登録されているプリセット値から選択する。

[ご注意]
電子シャッター動作をContinuousにしているときは操作できません。

フルメニューのTechnical > System Configuration > Shutter Mode
（89ページ）の設定によって次のように選択肢が表示される。
Angle（Δ）：開角度表示

360.0/180.0/172.8/144.0/90.0/45.0/22.5/11.2/5.61)

Speed（SS）：スピード表示
1/24、1/25、1/30、1/48、1/50、1/60、1/100、1/120、1/250、
1/500、1/1000、1/20001)

ND Filter NDフィルターの濃度を設定する。設定値は以下のとおりです。
Clear/0.3/0.6/0.9/1.2/1.5/1.8/2.1/2.4

WB（White Balance） ホワイトバランスの色温度を設定する。
WBステップとして登録されているプリセット値から選択します。
3200K+00/4300K+00/5500K+001)

1） 選択肢はサブディスプレイのホーム画面でStep Editから変更することができます。
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ミニディスプレイのクリップ操作
ミニディスプレイに表示されるクリップ画面から
再生するクリップを選択して、クリップを再生で
きます。

クリップ画面

オペレーターサイドのCLIPSボタン（9ページ）
を押すと、ミニディスプレイに再生可能なメディ
アのクリップ画面が表示されます。

7

6

5

1
2

3

4

1.	 	再生状態表示
クリップの再生状態が表示されます。

2.	再生アクティブメディア
選択しているクリップの再生アクティブメディア
が表示されます。

3.	 クリップ名
選択しているクリップのクリップ名が表示されま
す。

4.	再生メディア内のクリップ位置
選択しているクリップのクリップ番号/総数が表
示されます。

5.	 F	Fwd/Nextボタン
再生一時停止中に （ITEMキー 3）ボタンを押す
と次のクリップに移動します。
再生中に （ITEMキー 3）ボタンを押すと順方向
にクリップの頭出しをします。

6.	Play/Pauseボタン
（ITEMキー 2）ボタンを押すとクリップの再生を

します。または再生を一時停止します。

7.	 F	Rev/Prevボタン
再生一時停止中に （ITEMキー 1）ボタンを押す
と1つ前のクリップに移動します。
再生中に （ITEMキー 1）ボタンを押すと逆方向
にクリップの頭出しをします。

再生する

本機が記録停止中（Stby）のときは、記録したク
リップを再生することができます。

1 再生するAXSメモリーカードを入れる。

2 オペレーターサイドのCLIPSボタン（9
ページ）を押す。
ミニディスプレイに再生アクティブなクリッ
プが表示されます。

3 Prevボタン（ITEMキー 1）またはNextボタン
（ITEMキー 3）で再生するクリップを選択す
る。

4 Play/Pauseボタン（ITEMキー 2）を押す。
ビューファインダー・モニター画面に再生画
面が表示されます。

再生操作について

再生操作はミニディスプレイのボタンで行います
（101ページ）。
Play/Pause ボタン：再生を一時停止します。も
う一度押すと再生モードに戻ります。
F Fwd ボタン/F Rev ボタン：高速再生します。
Play/Pause ボタンを押すと標準再生に戻りま
す。

音声を聞く

標準再生モードでは、記録されている音声を内
蔵スピーカー（9ページ）またはヘッドホンで
モニターできます。
ヘッドホン端子（9ページ）にヘッドホンをつ
なぐと、内蔵スピーカーはオフになります。
モニターするチャンネルの選択および音量の調整
は、メニューのAudioカテゴリー > Monitor CH
およびMonitor Level（58ページ）で行います。

AXSメモリーカードを切り換える

AXSメモリーカードが2枚装着されているときは、
SLOT SELECTボタン（9ページ）を押して切り
換えます。または、サブディスプレイにクリップ
リスト画面が表示されているときは、サブディス
プレイのITEMキー 1を押して切り換えることもで
きます。

［ご注意］
再生中にAXSメモリーカードを切り換えることはできませ
ん。またスロットAからスロットBへの連続再生はできませ
ん。
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ネットワークの設定方法と操作方法
本機をネットワークに接続すると、コンピューター
やスマートフォン、タブレットなどのデバイスから
本機の各種機能を制御したり、本機の各種情報
を表示することができます。

［ご注意］
インターネットへの接続には、ルーターまたはルーター機
能を持つ機器やファイヤーウォールなどを経由し、外部か
らの攻撃を受けないようにしてください。

ネットワーク機能の概要

本機とデバイスを有線LANまたは無線LAN接続
し、デバイスのブラウザーから本機にアクセスす
ると、Webリモコンが表示され、次の各種操作
を行うことができます。
• 本機の記録制御（105ページ）
• 本機の再生制御（106ページ）
• 本機の撮影設定（106ページ）
• 本機のレンズ制御（106ページ）
• 本機のアサイナブルボタンの設定および操作
（106ページ）

Webリモコンを使用すると、記録の開始／停止
や撮影設定を遠隔操作で調整できるため、本機
を離れた場所に固定する場合や、本機をクレー
ンに装着して使用する場合などに有効です。

対応デバイスについて

本機の設定や操作にはコンピューターやスマート
フォン、タブレットを使用することができます。
確認済みのデバイス、OS、ブラウザーは次のと
おりです。

デバイス OS ブラウザー
コンピュー
ター

Microsoft Windows 
10/11

Chrome

macOS 11.x Safari
スマート
フォン

Android 10.x/11.x Chrome
iOS 14.x/15 Safari

タブレット Android 10.x/11.x Chrome
iPadOS 14.x Safari

［ご注意］
使用するブラウザーのバージョンによっては、正常に描写
できない場合があります。確認済みのブラウザーのバージョ
ンは次のとおりです
Safari：14/15
Chrome：93

本機とデバイスを有線LAN接
続する

本機のネットワーク端子を使用して、有線LAN
接続により直接デバイスに接続、またはルーター
経由で接続することができます。

1 本機ネットワーク端子（12ページ）とコン
ピューターをLANケーブルで接続する。また
は、本機ネットワーク端子とルーターをLAN
ケーブルで接続する。

2 Technicalメニュー > Network > Setting
（89ページ）をLANにする。

 ［ご注意］
Technicalメニュー > Authentication > Password

（89ページ）が設定されていない場合は、グレーア
ウトされ設定できません。

3 本機の設定をする。
自動的に本機にIPアドレスを割り当てる場
合：
Technicalメニュー > Network > LAN > 
DHCP（90ページ）をOnにして、Setを選
択して確定する。
接続先のIPアドレスを手動で入力する場合：
Technicalメニュー > Network > LAN > 
DHCP をOffにし、LAN > IP Addressで指
定のIPアドレスを入力後、Setを選択して確
定する。

 ［ご注意］
Technicalメニュー > Network > LANの設定画面で
Setを選択してください。Setを選択しなかった場合
は設定した内容が反映されません。

有線LAN接続が有効になると、ビューファイ
ンダー・モニター画面にネットワーク接続状
態表示（15ページ）のLANアイコンが点灯
します。

本機とデバイスを無線LAN接
続する

本機にワイヤレスLANアダプター CBK‑WA02（別
売り）を取り付けると、本機とデバイスを無線
LANで接続することができます。

CBK‑WA02を取り付ける

［ご注意］
CBK‑WA02の取り付けは、本機の電源を切った状態で行っ
てください。

1 USB延長アダプターを下図の位置に取り付
け、固定ネジを時計方向に回して固定する。

固定ネジ

USB 延長アダプター

USB延長アダプターは、図に示す範囲で取
り付け位置を調節することができます。

2 USB延長アダプターのUSB端子に保護
キャップ（付属）を取り付ける。

3 外部機器接続端子のカバーを開け、USB延
長アダプターのUSB 端子を外部機器接続端
子に差し込む。
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4 CBK‑WA02 をUSB 延長アダプターのUSB 
端子に差し込む。

アクセスポイントモードで接続する

本機をアクセスポイントとしてデバイスと無線
LAN接続します。

スマートフォン／タ
ブレット

コンピューター

WPS機能搭載のデバイスで接続する
デバイスがWPSをサポートしている場合には、
WPSでの接続が可能です。

1 Technicalメニュー > Network > Setting
（89ページ）をWirelessにする。

 ［ご注意］
Technicalメニュー > Authentication > Password

（89ページ）が設定されていない場合は、グレーア
ウトされ設定できません。

2 Technicalメニュー > Network > Wireless 
> Network Mode（90ページ）をAccess 
Pointにする。

3 Technicalメニュー > Network > Wireless 
> WPS（90ページ）を選択する。

4 MENUダイヤルを回してRunを選択し、
MENUダイヤルを押す。

5 デバイスのNetwork設定／ Wi‑Fi設定を開
き、Wi‑FiをOnにする。

6 デバイスのNetwork設定/Wi‑Fi設定の詳細
設定からWPS Push Buttonを押す。

［ご注意］
使用する機器によっては、操作が異なる場合があります。

デバイスでSSID、パスワードを入力して
接続する
デバイス側でSSIDとパスワードを入力して接続し
ます。

1 Technicalメニュー > Network > Setting
（89ページ）をWirelessにする。

 ［ご注意］
Technicalメニュー > Authentication > Password

（89ページ）が設定されていない場合は、グレーア
ウトされ設定できません。

2 Technicalメニュー > Network > Wireless 
> Network Mode（90ページ）をAccess 
Pointにする。

3 デバイスのNetwork設定／ Wi‑Fi設定を開
き、Wi‑FiをOnにする。

4 Wi‑Fi NetworkのSSID一覧から、本機の
SSIDを選択し、パスワードを入力して接続
する。
本機のSSIDおよびパスワードについては、
Technicalメニュー > Network > Wireless 
> SSIDとPassword（90ページ）をでご確
認ください。

［ご注意］
使用する機器によっては、操作が異なる場合があります。

ステーションモードで接続する

本機をクライアントとして既存の無線LANのアク
セスポイントに接続します。
デバイスとはアクセスポイント経由で接続します。

スマートフォン／タ
ブレット

コンピューター

アクセス 
ポイント

WPS機能を使ってアクセスポイントに接
続する
アクセスポイントがWPS機能対応の場合は、簡
単な設定で接続することができます。

1 アクセスポイントの電源を入れる。
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2 本機の電源を入れる。

3 Technicalメニュー > Network > Setting
（89ページ）をWirelessにする。

 ［ご注意］
Technicalメニュー > Authentication > Password

（89ページ）が設定されていない場合は、グレーア
ウトされ設定できません。

4 Technicalメニュー > Network > Wireless 
> Network Mode（90ページ）をStation
にする。

5 Technicalメニュー > Network > Wireless 
> WPS（90ページ）を選択する。

6 MENUダイヤルを回してRunを選択し、
MENUダイヤルを押す。

7 アクセスポイントのWPS ボタンを押す。
WPSボタンの操作については、アクセスポ
イントの取扱説明書をご覧ください。

［ご注意］
接続に失敗した場合は手順1からやり直してください。

SSID、パスワードを入力して接続する
本機でSSIDとパスワードを入力して接続します。

1 Technicalメニュー > Network > Setting
（89ページ）をWirelessにする。

 ［ご注意］
Technicalメニュー > Authentication > Password

（89ページ）が設定されていない場合は、グレーア
ウトされ設定できません。

2 Technicalメニュー > Network > Wireless 
> Network Mode（90ページ）をStation
にする。

3 Technicalメニュー > Network > Wireless
（90ページ）の以下の項目を設定する。
• SSID
• Password
• DHCP
• IP Address
• Subnet Mask

4 Setを選択して確定する。

［ご注意］
必ずSetで確定してください。Setで確定しなかった場合は
設定した内容が反映されません。

アクセスポイントを自動検出して接続する
接続先のアクセスポイントを自動検出して、SSID
を手動入力しないで接続することができます。

1 Technicalメニュー > Network > Setting
（89ページ）をWirelessにする。

 ［ご注意］
Technicalメニュー > Authentication > Password

（89ページ）が設定されていない場合は、グレーア
ウトされ設定できません。

2 Technicalメニュー > Network > Wireless 
> Network Mode（90ページ）をStation
にする。

3 Technicalメニュー > Network > Wireless 
> Scan Networks（90ページ）を選択す
る。

4 MENUダイヤルを回してRunを選択し、
MENUダイヤルを押す。
本機が接続先のアクセスポイントの自動検
出を開始します。自動検出が終了すると、
接続可能なネットワークがリスト表示されま
す。

5 MENUダイヤルを回して接続するネットワー
クを選択し、MENUダイヤルを押す。

6 Setを選択して確定する。
パスワードの入力画面が表示されます。

7 パスワードを入力してDoneを選択する。
Wireless設定詳細画面が表示されます。

8 Technicalメニュー > Network > Wireless
の以下の項目を入力した後、Setを選択して
確定する。
• DHCP
• IP Address
• Subnet Mask

［ご注意］
必ずSetで確定してください。Setで確定しなかった場合は
設定した内容が反映されません。

Webリモコンを表示する

デバイスのブラウザーから本機にアクセスして
Webリモコンを表示します。Webリモコン画面
は、デバイスの画面サイズに応じて自動で切り換
わります。

1 「本機とデバイスを有線LAN接続する」また
は「本機とデバイスを無線LAN接続する」の
手順に従って、本機とデバイスを接続する。

2 デバイスでブラウザーを起動し、「http://本
機のIPアドレス/rm.html」にアクセスする。
本機のIPアドレスは、Infoカテゴリー > 
SystemのIP Address（59ページ）で確
認できます。
例：IPアドレスが「192.168.1.1」の場合は、ア
ドレスバーに「http://192.168.1.1/rm.html」
と入力します。

3 ブラウザー画面に、ユーザー名とパスワー
ド（Technicalメニュー > Authentication

（89ページ））を入力する。
接続が完了すると、デバイスにWebリモコ
ン画面が表示されます。

［ご注意］
スマートフォン等でモバイル用ページ表示設定にしている場
合、正しく表示されないことがあります。デスクトップ用ペー
ジ表示設定に変更してください。

Webリモコン画面

Global Menu

Webリモコン画面左上の  （Global Menu）を
選択するとGlobal Menuが表示されます。設定
したい項目を選択します。
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Camera Control画面

Camera Control画面は、Camera画面とLens
画面、Info画面で構成されています。Camera
タブを選択するとCamera画面が、Lensタブを
選択するとLens画面が、Infoタブを選択すると
Info画面が表示されます。
Camera Control画面では、各種表示項目と操
作ボタンが配置されています（Camera画面／
Lens画面／ Info画面／再生画面共通）。
• ネットワーク接続状態（Connected/

Disconnected）
• Camera ID*
• Recボタン
• アサイナブルボタン（1 ～ 4、A ～ C）
* Camera IDの文字色は、Frame Line A/B Setupの

Colorと同じ色になります。

Camera画面

Camera画面では、サブディスプレイのホーム画
面と同じ内容が表示され各種設定ができます。

［ご注意］
サブディスプレイ画面と同様に、Technicalメニュー > 
Special Configuration > RM/RCP Paint Control（93
ページ）がOnに設定されている場合は、EI表示がGain表
示に切り換わり、操作項目に制限がかかります（38ペー
ジ）。

• 撮影設定（36ページ） 
FPS、EI、Shutter、ND、LUT、WB

• カメラステータス表示（37ページ） 
動作状態、タイムデータ、音声レベルメーター、
クリップ名、記録フォーマット、メディア状態
／残量、電源電圧／バッテリー残量

Lens画面

Lens画面では、ズーム、フォーカス、アイリスの
各レンズコントロールが表示されます。

Info画面

Info画面では、サブディスプレイのメニュー画面
のInfoカテゴリー（59ページ）と同じ内容が

表示され、カメラやメディア、バッテリーなどの
状態を確認できます。

Full Menu画面

Global MenuでFull Menuを選択すると、フル
メニューの設定画面が表示され、各項目を設定
できます（66ページ）。

［ご注意］
Webリモコンでは一部設定できない項目があります。

OSS(Open Source Software) 
Information画面

Global MenuでOSS Informationを選択する
とオープンソースソフトウェアの情報が表示され
ます。

再生画面

再生画面では、クリップの再生機能の操作を行
うことができます。また画面には再生しているク
リップの情報がステータス表示部に表示されま
す。
• 機能表示（96ページ） 

F Rev、Play/Pause、F Fwd、Prev、Stop/
Clips、Next

• 再生ステータス表示（96ページ） 
タイムデータ表示、クリップ番号、フレームレー
ト／再生クリップ画サイズ表示、特殊記録表
示、音声レベルメーター、再生クリップフォー
マット（コーデック）表示、アイコン表示（保護）、
クリップ名、再生メディア表示、再生状態

HOMEボタン

HOMEボタンを押すと、Camera画面に切り換
わります。
本体が再生状態で、Webリモコン画面に再生画
面を表示していても、HOMEボタンを押すと、カ
メラ撮像状態に戻ります。

CLIPSボタン

CLIPSボタンを押すと、再生画面に切り換わりま
す。（本体はクリップリスト画面に切り換わります

（95ページ）。）

記録する

Camera Control画面でRecボタンを押すと記録
が始まりRECランプが赤色に点灯し、もう一度押
すと記録が停止します。
Recボタン右下のREC ACTIVEランプが緑のとき
Recボタンを操作できます。
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Recボタンをロックするには

Recボタン下のLockつまみを右にスライドする
と、Recボタンの操作を禁止することができます。

再生する

Camera画面でCLIPSボタンを押すと、再生画面
に切り換わり、本体が再生状態になります。（本
体のサブディスプレイはクリップリスト画面が表
示されます（95ページ）。）
再生画面で再生するクリップの選択、再生操作
を行うことができます。

再生メディアを切り換えるには

メディア切り換えボタンを押すと再生するメディ
アスロットを切り換えることができます。

撮影設定をする

Camera画面で、本機のサブディスプレイのホー
ム画面と同じ項目の設定と操作を行うことがで
きます。

［ご注意］
ShutterのStep Edit操作はできません。

操作方法はサブディスプレイのホーム画面と同じ
です。

˜˜「サブディスプレイのホーム画面の操作方法」
（38ページ）

レンズを制御する

Lens画面で、Eマウントレンズ設定（ズーム、フォー
カス、アイリス）の状態を確認したり、制御可能
なレンズを装着していた場合はスライダー操作で
ズーム、フォーカス、アイリスを制御できます。
Lens画面で、PLマウントCookeレンズ通信制御
が可能です。
また、Lens画面で、12pinレンズ通信制御が可
能です。

［ご注意］
Technicalメニュー > Special Configuration > RM/RCP 
Paint Control（93ページ）がOnで、RM‑B170などのリ
モートコントロールユニット接続時は、スライダーはグレー
アウトされ操作できません。フォーカスとズームのスライ
ダーは、フォーカスまたはズームのリモート操作を有効にし
た場合にグレーアウトされます。

アサイナブルボタンを 
設定／操作する

Camera Control画面には、アサイナブル1 ～ 4
ボタンとビューファインダーアサイナブルA ～ Cボ
タンが配置されています。
本機のアサイナブル1 ～ 4ボタンおよびDVF‑
EL200のアサイナブルA ～ Cボタンを操作したと
きと同様に、アサイナブルボタンを押すと、割り
当てられた機能のオン（有効）とオフ（無効）を切
り換えたり、割り当てられた機能を起動したりで
きます。
アサイナブルボタンの機能名を選択すると、切り
換え可能な選択肢がプルダウン表示され、選択
肢を選択することにより、アサイナブルボタンに
割り当てる機能を変更できます。

˜˜「アサイナブル1 ～ 4ボタンに割り当て可能な機能」
（51ページ）

˜˜「ビューファインダー（DVF‑EL200）アサイナブルA ～ 
Cボタンに割り当て可能な機能」（53ページ）

［ご注意］
アサイナブルボタンに割り当てた機能が、ボタンを押してい
る間だけ有効になる機能、またはボタンを長押しして有効
になる機能だった場合、Webリモコンのアサイナブルボタ
ンからの操作は無効になります。対象となる機能は以下の
とおりです。

 ‒ Press&Hold for SDI12 Log
 ‒ Press&Hold for SDI34 Log
 ‒ Press & Hold for Moni Log
 ‒ Press & Hold for VF Log
 ‒ Iris Open (1/16 stop)
 ‒ Iris Close (1/16 stop)
 ‒ Monitor Focus Magnifier（Monitor Magnifier 

ModeがPress & Holdのとき）
 ‒ VF Focus Magnifier（VF Magnifier ModeがPress 

& Holdのとき）

各種ファイルを読み込む

Camera画面のLUT選択画面で、User 3D LUT
ファイルやARTファイル、ASC CDLファイルを本
機に読み込むことができます。

LUT選択画面を表示する

Camera画面のサブディスプレイのホーム画面で
LUT選択部をクリック、またはタッチする。

LUT選択部

LUT選択画面が表示されます。

User 3D LUTファイルを読み込む

User 3D LUTファイルをネットワーク接続したデ
バイスから本機に読み込むことができます。

1 LUT選択画面でEdit Lookボタンをクリック、
またはタッチする。
Look選択画面が表示されます。

2 Load Fileボタンをクリック、またはタッチす
る。
読み込むファイルの種類を選択する画面が
表示されます。
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3 Load User 3D LUT Fileにカーソルを移動
し、Selectボタンをクリック、またはタッチ
する。
読み込み先を選択する画面が表示されます。

4 Webにカーソルを移動し、Selectボタンを
クリック、またはタッチする。

読み込み先の番号（01 ～ 16）が表示されま
す。
読み込み済みの番号にはファイル名が表示
されます。

5 ボタン、 ボタンまたはダイレクトタッチ
で、読み込み先の番号にカーソルを移動し、
Selectボタンをクリック、またはタッチする。

6 ネットワーク接続したデバイスの任意のフォ
ルダを開き、読み込むファイルを選択する。
ファイルの読み込みが完了すると、

「Successfully loaded」が表示されます。

ARTファイルを読み込む

ARTファイルをネットワーク接続したデバイスか
ら本機に読み込むことができます。

1 LUT選択画面でEdit Lookボタンをクリック、
またはタッチする。
Look選択画面が表示されます。

2 Load Fileボタンをクリック、またはタッチす
る。

読み込むファイルの種類を選択する画面が
表示されます。

3 Load ART Fileにカーソルを移動し、Select
ボタンをクリック、またはタッチする。
読み込み先を選択する画面が表示されます。

4 Webにカーソルを移動し、Selectボタンを
クリック、またはタッチする。

読み込み先の番号（01 ～ 16）が表示されま
す。
読み込み済みの番号にはファイル名が表示
されます。

5 ボタン、 ボタンまたはダイレクトタッチ
で、読み込み先の番号にカーソルを移動し、
Selectボタンをクリック、またはタッチする。

6 ネットワーク接続したデバイスの任意のフォ
ルダを開き、読み込むファイルを選択する。
ファイルの読み込みが完了すると、

「Successfully loaded」が表示されます。

ASC CDLファイルを読み込む

ASC CDLファイルをネットワーク接続したデバイ
スから本機に読み込むことができます。

1 LUT選択画面でEdit Lookボタンをクリック、
またはタッチする。
Look選択画面が表示されます。

2 Load Fileボタンをクリック、またはタッチす
る。
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読み込むファイルの種類を選択する画面が
表示されます。

3 Load ASC CDL Fileにカーソルを移動し、
Selectボタンをクリック、またはタッチする。
読み込み先を選択する画面が表示されます。

4 Webにカーソルを移動し、Selectボタンを
クリック、またはタッチする。

5 ネットワーク接続したデバイスの任意のフォ
ルダを開き、読み込むファイルを選択する。
ファイルの読み込みが完了すると、

「Successfully loaded」が表示されます。

ASC CDLファイルの
Saturationを変更する

Camera画面のLUT選択画面で、ASC CDLファ
イルのSaturationの設定を変更することができ
ます。

1 LUT選択画面でEdit Lookボタンをクリック、
またはタッチする。
Look選択画面が表示されます。

2 ASC CDL Selectにカーソルを移動し、
CDL/ART Infoをクリック、またはタッチす
る。
ASC CDLファイルの情報画面が表示されま
す。

3 Editボタンをクリック、またはタッチする。
Saturationの編集画面が表示されます。

4 +ボタン、－ボタンをクリック、またはタッチ
して、設定値を変更する。

5 OKボタンをクリック、またはタッチして決定
する。

Webリモコン画面をロックす
る

Webリモコン画面右上のLockつまみを右にスラ
イドすると、Webリモコン画面の操作を禁止す
ることができます。
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基本操作
基本的な撮影は次の手順で行います。

1 必要な機器が取り付けられ、電源が供給さ
れていることを確認する。

2 電源スイッチ（9ページ）をONにする。
ビューファインダーに撮影画面が表示されま
す。

3 必要なメモリーカードを入れる。
AXSメモリーカードは2枚入れておくと、1枚
目がフルになった時点で自動的に2枚目に切
り換わります。

4 RECボタン（9、11ページ）を押す。
RECランプが点灯して、記録が始まります。

 ［ご注意］
REC操作を受け付けた後、すぐに記録を開始できな
い場合はRECランプが点滅に変わり、記録開始され
ると点灯します。

5 記録を終了するときは、もう一度RECボタン
を押す。
記録が停止し、本機はSTBY（記録待機）モー
ドになります。
記録を停止すると、開始から停止までの画
像・音声と付随データが、ひとつのクリップ
として記録されます。

クリップ名について

Cam ID + Reel#形式のクリップ名で記録を行い
ます。以下の規則に従ってクリップ名が生成され
ます。
• 挿入されたAXSメモリーカードにCam ID + 

Reel#形式のクリップ名が存在している場合
は、最終クリップの情報が継承されます。 
例：「B002C003_XXXXXXXX」がAXSメモ
リーカードに存在している場合 
次に生成されるクリップは「B002C004_
XXXXXXXX」になります。

• 空のAXSメモリーカードを挿入した場合は、前
回記録したクリップのReel Numberに1だけ
追加されます。 
例：カード1で「D001CXXX_XXXXXXXX」ま
で記録した後、空のカード2を入れて記録を
行った場合 
次に生成されるクリップは「D002C001_ 
XXXXXXXX」になり、記録開始までクリップ
名表示に下線が表示されます。

• メニューのTC/MediaカテゴリーのCamera 
IDや、Reel Numberを設定した場合は、そ
の情報が有効になります。 
例：「E003CXXX_XXXXXXXX」まで記録し
たAXSメモリーカードのCamera IDとReel 
Numberをメニューから変更した場合 
Camera IDを「F」に、Reel Numberを「001」
に変更すると、次に記録されるクリップは

「F001CXXX_XXXXXXXX」になります。ま
た、Camera IDだけを変更すると、Reel 
Numberは「001」に変更されます。
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便利な機能
ユーザーフレームライン表示

ユーザーフレームラインは任意に設定した表示に
するか、固定のアスペクト比を表示するかを選択
することができます。
ユーザーフレームラインは、User Frame Line 1
とUser Frame Line 2を設定することができま
す。
任意に設定する場合は、Monitoringメニュー 
> User Frame Line 1（83ページ）または
User Frame Line 2（84ページ） > Select
でVariableを選択し、Width、Height、H 
Position、V Positionの各メニュー項目で設定
することができます。
固定のアスペクト比を設定する場合は、
Monotoringメニュー > User Frame Line 1

（83ページ）またはUser Frame Line 2（84
ページ） > SelectでPresetを選択し、Preset 
Aspect Ratio、Scaling、Preset Aspect 
Ratio Typeの各メニュー項目で設定することが
できます。
任意の設定、固定のアスペクト比の設定ともに、
Aspect Ratio(Pixels)（84ページ）で、設定し
たユーザーフレームラインのアスペクト比、画素
数、アナモフィック倍率を確認することができま
す。

［ご注意］
• User Frame Line 2 > Preset Aspect Ratio Typeの

設定はLineに固定されています。
• アナモフィック倍率を設定できない有効画サイズ

（Imager Mode）設定のときは、アナモフィック倍率は
表示されません。

アサイナブルボタンの操作について

アサイナブル1 ～ 4、ビューファインダーアサイナ
ブルA ～ C、ITEMキー 1 ～ 5（49ページ）のい
ずれかにLine A: User Frame Disp.を割り当て
ると、Line Aに設定しているUser Frame Line 
1およびUser Frame Line 2の表示・非表示を切
り換えることができます。
アサイナブルボタンを押すたびに、User Frame 
Line 1と2を表示→User Frame Line 1を表示
→User Frame Line 2を表示→User Frame 
Line 1と2を非表示の順に切り換わります。
同様にLine B: User Frame Disp.を割り当てる
と、Line Bに設定しているUser Frame Line 1お
よびUser Frame Line 2の表示・非表示を切り
換えることができます。
また、アサイナブル1 ～ 4、ビューファインダーア
サイナブルA ～ C、ITEMキー 1 ～ 5のいずれか
に、Line A: Aspect Ratio Disp.またはLine B: 
Aspect Ratio Disp.を割り当てると、Line Aま
たはLine Bに設定しているAspect Ratioの表示・
非表示を切り換えることができます。アサイナブ
ルボタンを押すたびに、Aspect Ratioの表示・
非表示が切り換わります。

ピクチャーキャッシュレック

撮影している映像／音声データを、本機のメモ
リーに蓄えておくことにより、記録を開始したと
き、その数秒前からの映像を記録することがで
きます。
Projectメニュー > Special Recordingの
Cache Rec Select（75ページ）をOnにして
記録を開始すると、Projectメニュー > Special 
RecordingのMax Cache Rec Duration（76
ページ）で設定した蓄積時間にさかのぼって映像
を記録します。
Picture Cache Recを割り当てたアサイナブルボ
タンを押して、ピクチャーキャッシュレック機能
をオン／オフすることもできます。

［ご注意］
• プロジェクトフレームレートや記録フォーマット、記録す

るメディアによってMax Cache Rec Durationの設定に
制限があります。詳しくは76ページを参照してくださ
い。

• 記録フォーマットなどのシステム設定を変更すると、メ
モリーに蓄えられていた画像がクリアされます。変更直
後に記録を開始しても、変更前に撮影した映像は記録
されません。ピクチャーキャッシュモードは自動的に解
除されます。

• 記録中にピクチャーキャッシュの設定を変更することは
できません。

レックレビュー

アサイナブル1 ～ 4ボタン（49ページ）のい
ずれかにRec Reviewを割り当てると、直前に
記録したクリップの映像を画面で確認（レックレ
ビュー）できます。
記録を停止し、Rec Reviewを割り当てたアサイ
ナブルボタンを押すと、クリップの最初のフレー
ムから1倍速で再生します。
クリップの終わりまで再生すると、レックレビュー
は終了し、STBY（記録待機）モードに戻ります。
また、再生中にオペレーターサイドもしくはアシ
スタントサイドのHOMEボタンを押すと、再生が
停止し記録可能な状態になります。

Zoom to Fit

実際に運用する映像画サイズよりも広めに撮影・
記録する場合に、ビューファインダー画面やモニ
ター画面で記録映像を実際の運用画面サイズに
拡大して見ることができます。
Projectメニュー > Basic Setting > Zoom to 
Fit（75ページ）で設定できます。

［ご注意］
再生時は、Zoom to Fit機能は無効になります。
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高精細拡大フォーカス機能

ビューファインダー画面、またはMonitor出力に
対して、拡大表示することができます。
本機に装着されたビューファインダー（DVF‑
EL200、DVF‑L700）のFOCUS MAGボタンや、
VF Focus Magnifierを割り当てたアサイナブル
ボタンを押すことによって、ビューファインダーの
画面中央部分が拡大表示され、フォーカスを合
わせやすくなります。または、Monitor Focus 
Magnifierを割り当てたアサイナブルボタンを押
すことによって、Monitor出力映像の画面中央部
分が拡大表示され、フォーカスを合わせやすくな
ります。
拡大表示中は、記録映像やMonitor出力を除い
た他の出力信号に影響はありません。
通常の拡大フォーカスは、それまで表示されて
いる画の一部分を拡大するため解像度が荒くな
りますが、本機のx2倍フォーカスは、拡大した
部分が記録映像やMonitor出力を除いた他の出
力信号とは別に4K映像からの切り出しで表示さ
れるため解像度を保ったまま拡大フォーカス調整
することが可能です。
また、さらに4K切り出し映像からの拡大でx4倍
フォーカスも選択できます。
アサイナブルボタン（49ページ）に割り当てる
ことができる拡大フォーカス機能は以下のとおり
です。
ビューファインダー画面の拡大フォーカス機能：

VF Focus Maginifier
Monitor出力の拡大フォーカス機能：Monitor 

Focus Magnifier

FOCUS MAGボタンや、拡大フォーカス機能を
割り当てたアサイナブルボタンの動作順は以下の
項目で設定できます。
ビューファインダー画面：Monitoringメニュー 

> VF Display > VF Magnifier Ratio（80
ページ）

Monitor出力：Monitoringメニュー > Output 
Display > Monitor Magnifier Ratio（79
ページ）

VF Magnifier Ratioをx2.0/x4.0に設定すると、
VF Focus Magnifierを割り当てたアサイナブル
ボタンを押すたびに、x2.0→x4.0→x1.0→x2.0
の順に拡大率が切り換わります。
同様にMonitor Magnifier Ratioをx2.0/x4.0
に設定すると、Monitor Focus Magnifierを割
り当てたアサイナブルボタンを押すたびに、拡大
率が切り換わります。

［ご注意］
• 撮像フレームレートが61fps以上のハイフレームレート

モード時は、4K映像からの切り出し表示ができないた
め、x2/x4倍フォーカスの表示映像の解像度が下がりま
す。

• Project Frame Rateが59.94または50のとき、
Monitor出力設定が1920x1080Pの場合、Monitor 
Magnifier Ratioはx4.0およびx2.0/x4.0には設定で
きません。また、Monitor出力設定が1920x1080iの場
合、Monitor Focus Magnifierは動作しません。

• HDMI出力がMonitor出力と同じ出力フォーマットの
場合にMonitor Focus MagnifierはHDMI出力に
対しても拡大表示されます。Monitoringメニュー > 
Overlays/Frame Line > HDMI（81ページ）で設定
を確認できます。HDMIがSame as Monitorに設定さ
れている場合、HDMI出力はMonitor出力と同じです。

拡大フォーカス機能を割り当てたアサ
イナブルボタンの操作設定について

拡大フォーカス機能を割り当てたアサイナブルボ
タンを押すたびにオン／オフを切り替えるか、ボ

タンを押している間だけオンにするかを以下の項
目で設定できます。
ビューファインダー画面：Monitoringメニュー > 
VF Display > VF Magnifier Mode（80ペー
ジ）
Monitor出力：Monitoringメニュー > Output 
Display > Monitor Magnifier Mode（79
ページ）

ハイライトクリップインジケー
ター

高輝度のためクリップされた箇所を赤色にして
Monitor出力映像およびビューファインダー出力
映像に表示することができます。
Monitor Highlight Clip IndおよびVF 
Highlight Clip Indを割り当てたアサイナブルボ
タン（49ページ参照、51ページ参照）を押
すと、ハイライトクリップインジケーターのオン／
オフを切り換えることができます。

［ご注意］
Technicalメニュー > Special Configuration > RM/RCP 
Paint Control（93ページ）がOnに設定されている場合
は、ハイライトクリップインジケーターは動作しません。

ハイ／ローキー

Monitor出力映像およびビューファインダー出力
映像を、高輝度の白飛び確認または低輝度の暗
部確認の状態にすることができます。
High Keyが有効になると、高輝度部分の差異が
見やすくなり、高輝度の白飛びを確認できます。

Low Keyが有効になると、低輝度部分の差異が
見やすくなり、低輝度の暗部を確認できます。
Monitor High/Low KeyおよびVF High/
Low Keyを割り当てたアサイナブル1 ～ 4ボタン

（51ページ）を押すと、ハイ／ローキーの設定
を切り換えることができます。

［ご注意］
Technicalメニュー > Special Configuration > RM/RCP 
Paint Control（93ページ）がOnに設定されている場合
は、ハイ／ローキーは動作しません。

フォルスカラー表示

本機に装着されたビューファインダー 
（DVF‑EL200）のB/False Colorボタン、または
ビューファインダー（DVF‑L700）のSPAREボタン
を押すことによって、ビューファインダー内にフォ
ルスカラー（偽色）表示を行うことができます。
また、モニター出力にもフォルスカラー表示を行
うことができます。

表示色 信号レベル
S‑Log3 (初期値) S‑Log2（PMW‑F55

参考値）
赤 93.4% ～ 96.1% 105.5% ～ 109.5%
黄 91.3% ～ 93.4% 102.5% ～ 105.5%
オレンジ 87.7% ～ 90.6% 97.4% ～ 101.5%
ピンク 54.3% ～ 58.0% 50.2% ～ 55.2%
ライト 
ピンク

47.8% ～ 50.8% 
(18%Gray+1stop)

41.5% ～ 45.4% 
(18%Gray+1stop)

シアン 43.8% ～ 46.5% 36.3% ～ 39.6%
緑 38.9% ～

42.2%(18%Gray)
30.4% ～
34.4%(18%Gray)

ライト 
ブルー

24.6% ～ 34.4% 15.5% ～ 25.2%

青 3.5% ～ 5.6% 3.0% ～ 4.0%
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表示色 信号レベル
S‑Log3 (初期値) S‑Log2（PMW‑F55

参考値）
紫 ‑7.3% ～ 3.5% ‑7.3% ～ 3.0％

• Technical > False Color（92ページ）で
ビューファインダーおよびモニター出力のフォル
スカラーの各色のオン／オフと閾値をプリセッ
トにするか手動にするかを設定できます。

• VF False Colorを割り当てたアサイナブルボタ
ンを押すと、ビューファインダーに表示するフォ
ルスカラー機能をオン／オフできます。

• Monitor False Colorを割り当てたアサイナブ
ルボタンを押すと、モニターに表示するフォル
スカラー機能をオン／オフできます。

［ご注意］
Technicalメニュー > Special Configuration > RM/RCP 
Paint Control（93ページ）がOnに設定されている場合
は、フォルスカラー機能は動作しません。

ビューファインダー倍速駆動
機能

プロジェクトフレームレートが23.98P、24P、
25P、29.97Pの場合、フレーム周波数が低いた
め左右に振って撮影するような場合に映像がぶ
れて見にくい場合があります。
このような場合にビューファインダー倍速駆動機
能を有効にすることで、ビューファインダーの映
像のブレが軽減され、見やすくすることができま
す。
Monitoringメニュー > VF FunctionのDouble 
Speed Scan（80ページ）をOnに設定するこ
とで、機能を有効にすることができます。

［ご注意］
• 本機能が有効なときは、電子シャッターは開角度換算

で180°以下に制限されます。
• 可変速撮影時は本機能はOffになります
• 本機能が有効になるイメージサイズとプロジェクトフ

レームレートは以下のとおりです。
 MPC‑3628：
 5.8K 6:5（23.98p、24p）
 5.8K 17:9（23.98p、24p、25p、29.97p）
 5.4K 16:9（23.98p、24p、25p、29.97p）
 MPC‑3626：
 4K 4:3（23.98p、24p）
 4K 17:9（23.98p、24p、25p、29.97p）
 4K 17:9 Surround View（23.98p、24p）
 4K 2.39:1（23.98p、24p、25p、29.97p）
 3.8K 16:9（23.98p、24p、25p、29.97p）
 3.8K 16:9 Surround View（23.98p、24p）

User 3D LUT

本機では、RAW ViewerやBlackmagic 
Design Pty. Ltd.製DaVinci Resolveで生成
される17格子点、33格子点または65格子点の
CUBEファイル（*.cube）をインポートすることが
できます（41ページ）。
また、ネットワーク経由でUser 3D LUTファイル
を本機に読み込むこともできます（106ページ）。
CUBEファイル生成時のInput Color Spaceと本
機のInput Color Spaceは合わせてください。
S‑Gamut3.Cine/SLog3で生成した場合は、本
機のProject > Basic SettingのInput Color 
Space（74ページ）をS‑Gamut3.Cine/
SLog3に設定してください。
生成されたUser 3D LUTファイルは、SDカード
の以下の階層に保存してください。
PRIVATE\SONY\PRO\LUT\

［ご注意］
65格子点のデータは33格子点に間引いて読み込まれます。

ART

本機では、RAW Viewerなどで生成されるART
（Advanced Rendering Transform）ファイル
（*.art）をインポートすることができます（41
ページ）。
また、ネットワーク経由でARTファイルを本機に
読み込むこともできます（107ページ）。
ARTファイルは、バイナリフォーマットで生成さ
れたソニー独自のLookファイルです。ARTファイ
ルを使用することにより、本機にUser 3D LUT
をインポートするより高品質なモニター出力が可
能です。
本機に生成されたARTファイルは、SDカードの
以下の階層に保存してください。
MPC‑3628： 

PRIVATE\SONY\PRO\CAMERA\
MPC3628

MPC‑3626： 
PRIVATE\SONY\PRO\CAMERA\
MPC3626

［ご注意］
MPC‑3610のARTファイルと互換性はありません。

ASC CDL

本機では、外部ツールで生成された
ASC CDL（The American Society of 
Cinematographers Color Decision List）
ファイル（*.cdl）をインポートすることができます

（42ページ）。
また、ネットワーク経由でASC CDLファイルを本
機に読み込むこともできます（107ページ）。

ASC CDLのパラメーターをLookに適用して撮影
を行うことができます。
生成されたASC CDLファイルは、SDカードの以
下の階層に保存してください。
PRIVATE\SONY\PRO\CDL\
また、ウェブブラウザ経由でASC CDLのパラメー
ターを変更したり、Pomfort社製のLivegrade
で制御したりすることも可能です。
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ユーザー設定データ
フルメニューの設定内容は、本機の内蔵メモリー
またはSDカードに保存／読み込みすることがで
きます。このデータを使って、適切なセットアッ
プ状態をすばやく再現できます。
設定データをSDカードに保存する場合は、あら
かじめ、書き込み可能なSDカード（34ページ）
をSDカードスロット（13ページ）に挿入してお
きます。
各ファイルに保存される設定値については、「ファ
イルに保存される項目」（142ページ）をご覧く
ださい。

Allファイル

全メニューの設定データを保存／読み込みしま
す。
SDカードに64個まで保存することができます。

［ご注意］
機器固有のデータ（機器ごとに調整が必要なシェーディング
や出力レベルなど）は保存されません。

Sceneファイル

撮影シーンに合わせて設定したペイント項目の設
定値を保存／読み込みします。本機の内蔵メモ
リーに5個、SDカードに64個まで保存すること
ができます。
Technicalメニュー > Special Configuration > 
RM/RCP Paint Control（93ページ）がOnに
設定されている場合に、設定値の保存／読み込
みができます。
次のデータをSceneファイルに保存できます。
• Paintメニューを使用して設定した値
• シャッター、NDフィルター、Gain、Base 

ISO、Input Color Space、NRの設定
• ホワイトバランスのデータ

ユーザーガンマファイル

ユーザーが作成したユーザーガンマファイルを本
機の内蔵メモリーに5個まで保存することができ
ます。
Technicalメニュー > Special Configuration > 
RM/RCP Paint Control（93ページ）がOnに
設定されている場合に保存できます。
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Allファイル
設定データをAllファイルとし
て保存する

1 Projectメニュー > All File(Cam Setup) > 
Save SD Card（77ページ）を選択する。
Allファイルの保存先画面が表示されます。

2 MENUダイヤルを回して保存先を選択し、
MENUダイヤルを押す。
File IDがNo Fileの行にファイルを保存する
ことができます。
File IDにFile IDが記載されている行を選択
すると、そのファイルに上書きされます。
File IDは自動的に付けられますが、変更す
ることもできます。

3 MENUダイヤルを回して確認画面のRunを
選択し、MENUダイヤルを押す。

ファイルの保存が実行されないときは

操作中または操作後に次のエラーメッセージが表
示されたときは、ファイルは保存されません。

エラー 
メッセージ

状況 対策

File 
Access 
NG

保存可能なSD
カードが挿入され
ていない

保存可能なSD
カードを挿入する

File IDを変更する

1 Projectメニュー > All File(Cam Setup) > 
File ID（77ページ）を選択する。
File IDの編集画面が表示されます。

2 文字を選択してFile IDを入力する。

3 MENUダイヤルを回してDoneを選択し、
MENUダイヤルを押す。
File IDの変更が完了します。

設定データを読み込む

1 Projectメニュー > All File(Cam Setup) > 
Load SD Card（77ページ）を選択する。
Allファイル一覧画面が表示されます。

2 MENUダイヤルを回して読み込むファイルを
選択し、MENUダイヤルを押す。
確認画面が表示されます。

3 MENUダイヤルを回してRunを選択し、
MENUダイヤルを押す。

［ご注意］
• SDカードからファイルを読み込むと、本機内部に保存さ

れているデータは上書きされます。
• ファイルを保存した機器より古いバージョンの機器では

読み込まないでください。故障の原因となることがあり
ます。

• 設定データを読み込むと、本機は自動的に再起動され
ます。

• MPC‑3628はMPC‑3626のAllファイルを読み込めませ
ん。また、MPC‑3626はMPC‑3628のAllファイルを読
み込めません。

ファイルの読み込みが実行されないと
きは

操作中または操作後に次のエラーメッセージが表
示された場合は、ファイルの読み込みは行われ
ません。

エラー 
メッセージ

状況 対策

File 
Access 
NG

• ファイルの読
み込みが異常
終了した

• SDカードの該
当ファイルの
データが壊れ
ている

• 読み込みを再
実行する

• SDカードを再
挿入する

• SDカードに正
常なファイル
を保存する

［ご注意］
各ソフトウェアオプションをインストールした本機で保存さ
れたファイルは、該当ソフトウェアオプションがインストー
ルされていない本機に読み込むことはできません。

現在の設定値をすべて初期値
に戻す

1 Maintenanceメニュー > Reset to Default
（94ページ）を選択する。
確認画面が表示されます。

2 MENUダイヤルを回してRunを選択し、
MENUダイヤルを押す。

［ご注意］
実行後、本機は自動的に再起動されます。
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Sceneファイル
Sceneファイルを内蔵メモ
リーに保存する

1 Projectメニュー > Scene File > Store 
Internal Memory（77ページ）を選択す
る。
Sceneファイル一覧画面が表示されます。
File IDがStandardの保存先にはあらかじめ
標準設定が保存されます。

2 MENUダイヤルを回して保存先を選択し、
MENUダイヤルを押す。
選択した保存先にSceneファイルが上書きさ
れます。

3 MENUダイヤルを回して確認画面のRunを
選択し、MENUダイヤルを押す。

SceneファイルをSDカードに
保存する

1 Projectメニュー > Scene File > Save SD 
Card（77ページ）を選択する。
Sceneファイル保存先画面が表示されます。

2 MENUダイヤルを回して保存先を選択し、
MENUダイヤルを押す。
File IDがNo Fileの行にファイルを保存する
ことができます。
File IDにFile IDが記載されている行を選択
すると、そのファイルに上書きされます。
File IDは自動的に付けられますが、変更す
ることもできます。

3 MENUダイヤルを回して確認画面のRunを
選択し、MENUダイヤルを押す。

File IDを変更する

1 Projectメニュー > Scene File > File ID
（77ページ）を選択する。
File IDの編集画面が表示されます。

2 文字を選択してFile IDを入力する。

3 MENUダイヤルを回してDoneを選択し、
MENUダイヤルを押す。
File IDの変更が完了します。

Sceneファイルを内蔵メモ
リーから読み込む

1 Projectメニュー > Scene File > Recall 
Internal Memory（77ページ）を選択す
る。
Sceneファイル一覧画面が表示されます。

2 MENUダイヤルを回して読み込むファイルを
選択し、MENUダイヤルを押す。
確認画面が表示されます。

3 MENUダイヤルを回してRunを選択し、
MENUダイヤルを押す。

［ご注意］
MPC‑3628はMPC‑3626のSceneファイルを読み込めま
せん。また、MPC‑3626はMPC‑3628のSceneファイルを
読み込めません。

SceneファイルをSDカードか
ら読み込む

1 Projectメニュー > Scene File > Load SD 
Card（77ページ）を選択する。
Sceneファイル一覧画面が表示されます。

2 MENUダイヤルを回して読み込むファイルを
選択し、MENUダイヤルを押す。
確認画面が表示されます。

3 MENUダイヤルを回してRunを選択し、
MENUダイヤルを押す。

［ご注意］
MPC‑3628はMPC‑3626のSceneファイルを読み込めま
せん。また、MPC‑3626はMPC‑3628のSceneファイルを
読み込めません。
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ユーザーガンマファイル
RAW Viewer V4.0以降で作
成したユーザーガンマファイ
ルを使用する

RAW Viewer V4.0以降で作成したユーザーガン
マファイルを本機で使用することができます。
作成したデータを使用するにはSDカードの以下
の階層に保存してください。
MPC‑3628： 

PRIVATE\SONY\PRO\CAMERA\
MPC3628

MPC‑3626： 
PRIVATE\SONY\PRO\CAMERA\
MPC3626

RAW Viewer V4.0以降について詳しくは、お買
い上げ店またはソニーのサービス窓口にお問い合
わせください。

ユーザーガンマファイルの読み込みや確認、リ
セットなどの操作を行うには、Technicalメニュー 
> Special Configuration > RM/RCP Paint 
Control（93ページ）をOnに設定して、ペイン
ト機能をオンにします。

SDカードからユーザーガンマ
ファイルを読み込む

1 Projectメニュー > User Gamma > Load 
SD Card（77ページ）を選択する。
ユーザーガンマファイル一覧画面が表示さ
れます。
ユーザーガンマファイル一覧画面では、5個
のファイルが一度に選択されます。

 ［ご注意］
読み込み操作は5個まとめて行われます。1個だけファ
イルを選択することはできません。

2 MENUダイヤルを押す。
確認画面が表示されます。

3 MENUダイヤルを回してRunを選択し、
MENUダイヤルを押す。
5個のファイルが内蔵メモリーに読み込まれ
ます。

現在の内蔵メモリーに保存さ
れているユーザーガンマファ
イルを確認する

Projectメニュー > User Gamma > Current 
Settings（77ページ）を選択すると、現在本
機内蔵メモリーに保存されているユーザーガンマ
ファイル一覧画面が表示されます。

［ご注意］
SDカードからユーザーガンマファイルを読み込む前は、
Projectメニュー > Basic Setting > Input Color Space

（74ページ）がRec.709/User Gammaに設定されてい
る場合、Nameには初期値である「709(800%)」が表示さ
れます。Rec.709/User Gamma以外に設定されている場
合は、「HLG(Natural)」が表示されます。

内蔵メモリーに保存したユー
ザーガンマファイルを設定す
る

1 Projectメニュー > Basic Setting > Input 
Color Space（74ページ）をRec.2020/
User GammaまたはRec.709/User 
Gammaに設定する。

 ［ご注意］
Rec.2020/User GammaまたはRec.709/
User Gammaは、Technicalメニュー > Special 
Configuration > RM/RCP Paint Control（93
ページ）がOnに設定されている場合のみ選択できま
す。

2 Paintメニュー > Gamma > Gamma 
Select（87ページ）で、User 1 ～ User 5
のいずれかを選択する。

 ［ご注意］
Gamma Selectの選択肢User 1 ～ User 5は、ユー
ザーガンマファイル一覧画面のNo.1 ～ 5に該当しま
す。
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内蔵メモリーに保存されてい
るユーザーガンマファイルを
初期状態にリセットする

1 Projectメニュー > User Gamma > Reset
（77ページ）を選択する。
リセットするガンマファイル番号の選択肢画
面が表示されます。

2 MENUダイヤルを回してリセットするガンマ
ファイル番号（1 ～ 5）を選択する。
すべてのガンマファイルをリセットする場合
はAllを選択します。
確認画面が表示されます。

3 MENUダイヤルを回してRunを選択し、
MENUダイヤルを押す。
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リモートコントロールユニットを接続する
リモートコントロールユニットRM‑B170やリモー
トコントロールパネルRCP‑1001/1501/3100/ 
3501などのコントロールユニットを接続すると、
それらの機器から本機の機能の一部をコント
ロールすることが可能です。

リモートコントロールユニット
を接続する

リモートケーブルを使って、本機のREMOTE端子
（8ピン）と、コントロールユニットのカメラ端子
を接続します。
接続後に本機の電源を入れると、本機はリモー
トコントロールモードになり、本機のメニュー操
作や撮影操作が可能となります。

［ご注意］
• 本機の電源を入れたままコントロールユニットを接続し

たり、接続を外さないでください。
• リモートコントロールパネルRCP‑1001/1501/3100/ 

3501にはリモートケーブルは付属されていません。

リモートコントロールモード
を解除する

本機の電源を切り、コントロールユニットを取り
外します。

ペイント機能を設定する

ペイント機能を設定するには、Technicalメ
ニュー > Special Configuration > RM/RCP 

Paint Control（93ページ）をOnに設定する
必要があります。
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RCP‑1001/1501/3100/3501、RM‑B170/B750で操作できる主な機能

表の見かた
操作表示の記号の意味は次のとおりです。
○：操作できる
―：操作できない
項目 小項目 細目 選択肢 RCP‑1001 RCP‑1501/3501 RCP‑3100 RM‑B170 RM‑B750
Shooting FPS Fixed/Variable Select On/Off ― ○ ― ○1) ○

FPS Select 1FPS ～ 120FPS ― ○ ― ○1) ○
Shutter Select2) Shutter ON/OFF On/Off ― ○ ○ ○ ○

ECS ON/OFF On/Off ― ○ ○ ○ ○
Shutter Speed Step用に登録した任意の値。

以下の値を表示可能。
1/32
1/33
1/48
1/50
1/60
1/96
1/100
1/120
1/125
1/250
1/500
1/1000
1/2000
1/3000
1/4000
1/5000

― ○ ○ ○ ○

ECS Frequency ― ― ○ ○ ○ ○
ND ND Position 1：（CLEAR）

2：（濃度0.3）
3：（濃度0.6）
4：（濃度0.9）
5：（濃度1.2）
6：（濃度1.5）
7：（濃度1.8）
8：（濃度2.1）
9：（濃度2.4）

○ ○ ○ ○ ○
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項目 小項目 細目 選択肢 RCP‑1001 RCP‑1501/3501 RCP‑3100 RM‑B170 RM‑B750
Gain2) Gain(Step) －6dB/－3dB/0dB/3dB/6dB/9dB/

12dB/15dB/18dB
○ ○ ○1) ○ ○

White Balance2) Color Temp 2000K ～ 15000K3) ― ○ ○1) ― ○
Color Temp Balance (Tint.相当) －99 ～ ±0 ～ +994) ― ○ ○1) ― ○
R Gain －99 ～ ±0 ～ +99 ○ ○ ― ○ ○
B Gain －99 ～ ±0 ～ +99 ○ ○ ― ○ ○
Auto White Balance ― ○ ○ ○ ○ ○

Project Scene File2)5) ― ― ― ○ ○ ― ○
Standard File6) ― ― ○ ○ ― ― ○

Paint2) Switch Status Gamma On/Off ― ○ ○1) ○1) ○
Black Gamma7) On/Off ― ○ ○1) ○1) ○
Matrix On/Off ― ○ ○1) ― ○
Knee7) On/Off ― ○ ○1) ○1) ○
White Clip7) On/Off ― ○ ○1) ― ○
Detail On/Off ― ○ ○1) ― ○
Flare On/Off ― ○ ○ ○1) ○
Test Saw8) On/Off ― ○ ○ ○1) ○

Black Master Black －99 ～ ±0 ～ +99 ○ ○ ○ ○ ○
R Black －99 ～ ±0 ～ +99 ○ ○ ○ ○ ○
B Black －99 ～ ±0 ～ +99 ○ ○ ○ ○ ○

Flare Setting On/Off ― ○ ○ ○1) ○
Master Flare －99 ～ ±0 ～ +99 ― ○ ○ ○1) ―
R Flare －99 ～ ±0 ～ +99 ― ○ ○ ― ○
G Flare －99 ～ ±0 ～ +99 ― ○ ○ ― ○
B Flare －99 ～ ±0 ～ +99 ― ○ ○ ― ○

Gamma Setting On/Off ― ○ ○1) ○1) ○
Gamma Category（表示のみ）9) User ― ○ ― ― ○
Gamma Select User 1/User 2/User 3/User 4/

User 5
― ○ ― ― ○

Black Gamma7) Setting On/Off ― ○ ○1) ○1) ○
Range Low/L.Mid/H.Mid ― ○ ― ― ○
Master Black Gamma －99 ～ ±0 ～ +99 ― ○ ○1) ○1) ○

Knee7)10) Setting On/Off ○ ○ ○1) ○ ○
Point －99 ～ ±0 ～ +99 ○ ○ ○1) ○ ○
Slope －99 ～ ±0 ～ +99 ○ ○ ○1) ― ○
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項目 小項目 細目 選択肢 RCP‑1001 RCP‑1501/3501 RCP‑3100 RM‑B170 RM‑B750
White Clip7) Setting On/Off ― ○ ○1) ― ○

Level －99 ～ ±0 ～ +99 ― ○ ― ― ○
Detail Setting On/Off ― ○ ○1) ― ○

Level －99 ～ ±0 ～ +99 ― ○ ○1) ― ○
H/V Ratio －99 ～ ±0 ～ +99 ― ○ ― ― ○
Crispening －99 ～ ±0 ～ +99 ― ○ ― ― ○
Level Depend On/Off ― ○ ― ― ○
Level Depend Level －99 ～ ±0 ～ +99 ― ○ ― ― ○
Frequency －99 ～ ±0 ～ +99 ― ○ ― ― ○
Knee Aperture On/Off ― ○ ― ― ○
Knee Aperture Level －99 ～ ±0 ～ +99 ― ○ ― ― ○
Limit －99 ～ ±0 ～ +99 ― ○ ― ― ○
White Limit －99 ～ ±0 ～ +99 ― ○ ― ― ○
Black Limit －99 ～ ±0 ～ +99 ― ○ ― ― ○

Matrix Setting On/Off ― ○ ○1) ― ○
User Matrix On/Off ― ○ ― ― ○
User Matrix R‑G －99 ～ ±0 ～ +99 ― ○ ― ― ○
User Matrix R‑B －99 ～ ±0 ～ +99 ― ○ ― ― ○
User Matrix G‑R －99 ～ ±0 ～ +99 ― ○ ― ― ○
User Matrix G‑B －99 ～ ±0 ～ +99 ― ○ ― ― ○
User Matrix B‑R －99 ～ ±0 ～ +99 ― ○ ― ― ○
User Matrix B‑G －99 ～ ±0 ～ +99 ― ○ ― ― ○

Multi Matrix Setting On/Off ― ○ ― ― ○
Area Indication On/Off ― ○ ― ― ○
Reset Run/Cancel ― ○ ― ― ○
Axis B/B+/MG‑/MG/MG+/R/R+/YL‑/

YL/YL+/G‑/G/G+/CY/CY+/B‑
― ○ ― ― ○

Hue －99 ～ ±0 ～ +99 ― ○ ― ― ○
Saturation －99 ～ ±0 ～ +99 ― ○ ― ― ○

Technical Test Signals Color Bars On/Off On/Off ○ ○ ○ ○ ○
Test Saw8) On/Off ― ○ ○ ○1) ○

Rec ― ― ― ― ― ― ○ ○
Play ― ― ― ― ― ― ○ ○
Stop ― ― ― ― ― ― ○ ○
F.Rev ― ― ― ― ― ― ○ ○
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項目 小項目 細目 選択肢 RCP‑1001 RCP‑1501/3501 RCP‑3100 RM‑B170 RM‑B750
F.Fwd ― ― ― ― ― ― ○ ○
Rec Review ― ― ― ― ― ― ○ ○
Next ― ― ― ― ― ― ○ ―
Prev. ― ― ― ― ― ― ○ ―
White Mode2) Preset ON/OFF ― On/Off ― ― ― ○ ○
Iris Iris Level ― （対象レンズの制御範囲） ○ ○ ○ ○ ○

Close ― On/Off ○ ○ ○ ― ○
Zoom11) Remote ― On/Off ― ○1) ○1) ○1) ―

Speed ― ― ― ― ― ― ―
Tele ～ Wide ― ― ― ○1) ○1) ○1) ―
Zoom Value[%] ― ― ― ○1) ○1) ○1) ―
Focal Length[mm] ― ― ― ○1) ○1) ○1) ―

Focus11) Remote ― On/Off ― ○1) ○1) ○1) ―
Focus Position ― ― ― ○1) ○1) ○1) ―
Focus Value[%] ― ― ― ○1) ○1) ○1) ―
Focus Length[m] ― ― ― ○1) ○1) ○1) ―

Call ― ― ― ○ ○ ○ ○ ○

1) コントローラーの操作部に割り当てれば制御可能です。
2) Technicalメニュー > Special Configuration > RM/RCP Paint Control（93ページ）がOnに設定されている場合のみ設定可能です。
3) Color Tempは、R/B Gain操作時に2000Kや15000Kでクリップされるため、R/B Gain値の正確なColor Temp値を表示できない場合があります。
4) Color Temp Balanceは±99で表示クリップされるため、R/B Gain値の正確なColor Temp Balance値を表示できない場合があります。
5) 本機に読み込み済みのScene File 1 ～ 5の選択および選択解除のみ可能です。
6) コントローラーからの操作で、本機の設定をScene Fileが読み込まれていない標準状態に戻すことができます。
7) Projectメニュー > Basic Setting > Input Color Space（74ページ）がHLG(Natural)、HLG(Live)、Rec.2020/User GammaまたはRec.709/User Gammaに設定されている場合のみ設定可能です。
8) オートホワイトバランスの実行中は、テスト信号のOn/Offを切り換えることはできません。
9) コントローラーの機種やバージョンによっては表示できないものもあります。
10) 本機では、通常のKneeコントロールによって、HDR Kneeと同等の高輝度Kneeを制御します。
11) Eマウントレンズ装着時、リモートコントロールユニットからのズームおよびフォーカスの駆動指示は無効になります。
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外部モニターや記録装置を接続する
記録・再生画像を外部モニターに表示させるとき
は、本機の出力信号を選択し、接続するモニター
に応じた接続ケーブルを使用してください。
VTRなどの記録装置を接続して、本機の出力信
号を記録することもできます。
外部モニターにビューファインダーと同様の各種
ステータス情報やメニューなどを表示させること
ができます。モニターに出力する信号に応じて、
Monitoringメニュー（79ページ）で表示する
内容を設定してください。

［ご注意］
FPSをVariableに設定しているとき、4K出力のみにおいて
水平方向の画ズレが発生する場合があります。これは、速
いFPS設定時に顕著な現象です。ただし、記録画には影響
がないため、再生画像は正しく表示できます。

SDI OUT端子（BNC型）

Monitoringメニュー（79ページ）で、出力フォー
マットを設定します。
接続には市販の75Ω同軸ケーブルを使用してくだ
さい。

［ご注意］
本機と外部機器の間のアースが確実に接地されていること
を確認してから、電源を入れてください。（75Ω同軸ケーブ
ルを接続した後に、本機と外部機器の電源を入れることを
お勧めします。）
やむを得ず、電源投入状態で外部機器を接続する場合は、
75Ω同軸ケーブルを外部機器に接続した後に、本機と接続
してください。

本機と同時に外部機器で記録を開始
するには

SDI信号出力時は、メニューのTechnical > 
System Configuration > SDI Rec Remote 

Trigger（89ページ）をHD SDI Remote I/Fま
たはParallel Recに設定すると、SDI OUT端子
に接続した外部機器にRECトリガー信号を出力す
ることによって、本機と同期した記録が可能にな
ります。

［ご注意］
• 接続した外部機器がRECトリガー信号に対応していない

場合は動作しません。
• SDI 3/4にモニター信号を出力しているときは、RECトリ

ガー信号は出力されません。
• SDI 1/2出力が以下の場合は、SDI 3/4にモニター信号

を出力します。
 ‒ 4K/QFHD 12G/6G出力
 ‒ 4K/QFHD Dual出力

MONITOR OUT端子（BNC
型）

HD SDI信号を出力します。
Monitoringメニュー（79ページ）で出力フォー
マットを設定します。
接続には市販の75Ω同軸ケーブルを使用してくだ
さい。

［ご注意］
音声とタイムコードは本出力には重畳されていません。

HDMI OUT端子（Type Aコネ
クター）

Monitoringメニュー（79ページ）で、出力
フォーマットを設定します。
接続には、市販のHDMI接続ケーブルを使用しま
す。

出力フォーマットがMONITOR OUT端子と同一
の解像度の場合は、同じ映像信号が出力されま
す。

12V OUT端子（DC OUT 12V、
Lemo 2ピン）

電源スイッチがONの場合に、アクセサリーにDC 
12Vの電源を供給します。

No. 信号 I/O 仕様
1 UNREG GND － GND
2 UNREG +12 V 

OUT
OUT +11 V to 17 V DC 

output
11	V～ 17	V入力時
出力電圧：入力電圧
と同じ
出力最大電流：1.0 A
22	V～ 32	V入力時
出力電圧：16.8 V
出力最大電流：1.0 A

24V OUT端子（DC OUT 
24V、Fischer 3ピン）

電源スイッチがONの場合に、アクセサリーにDC 
24Vの電源を供給します。また、24V OUT端子
を経由して、REC Trigger信号の入力をすること
が可能です。

No. 信号 仕様
1 GND
2 24V‑OUT 11	V～ 17	V入力時

出力電圧：24 V
出力最大電流：1.0 A
22	V～ 32	V入力時
出力電圧：入力電圧と同
じ
出力最大電流：2.0 A

3 REC 
TRIGGER 
IN

Open or +5 V DC: 
Normal
GND: Active(REC)

AUX 端子（BNC型）

タイムコード信号または製造／サービスでの調整
用クロック信号を出力します。
• TC OUT
• Factory Use
接続には市販の75Ω同軸ケーブルを使用してくだ
さい。
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本機を複数台使用して撮影するときなど、特定
の基準信号に同期させたり、タイムコードを合わ
せることができます。

映像信号の位相を合わせる
（ゲンロック）

本機のGENLOCK IN端子（12ページ）に以下
の基準信号を入力することによって、ゲンロック
が可能です。
• HDSDI 1.5G デジタル（interlace/PsF/

Progressive）
• HD Yアナログ（interlace/Progressive）
• SD VBSアナログ
ゲンロック入力信号は、フルメニューのTC/
Media > Genlock > Input Source （78ペー
ジ）で設定できます。
また、フルメニューのTC/Media > Genlock > 
Reference Lock Type（78ページ）、サブディ
スプレイのホーム画面（36ページ）、ゲンロッ
ク状態表示（14ページ）で状態を確認できま
す。
入力できる基準信号は、設定されているプロジェ
クトフレームレートによって異なります。
プロジェ
クトフレー
ムレート

入力可能な基準信号
アナログ デジタル

23.98 1920×1080 
47.95i(23.98PsF)
1920×1080 
23.98P

1920×1080 
23.98PsF
1920×1080 
23.98P

24 1920×1080 
48i(24PsF)
1920×1080 24P

1920×1080 24PsF
1920×1080 24P

プロジェ
クトフレー
ムレート

入力可能な基準信号
アナログ デジタル

25 1920×1080 50i
720×576 50i
1920×1080 25P

1920×1080 50i
1920×1080 25PsF
1920×1080 25P

29.97 1920×1080 59.94i
720×486 59.94i
1920×1080 
29.97P

1920×1080 59.94i
1920×1080 
29.97PsF
1920×1080 
29.97P

47.95 1920×1080 
47.95i(23.98PsF)

1920×1080 
23.98PsF

50 1920×1080 50i
720×576 50i

1920×1080 50i

59.94 1920×1080 59.94i
720×486 59.94i

1920×1080 59.94i

ゲンロックの状態は、メニューのTC/Media > 
Genlock > Reference Lock Type（78ペー
ジ）で確認できます。

［ご注意］
• 基準信号が不安定な場合は、ゲンロックできません。
• サブキャリアは同期しません。 

他機のタイムコードにロック
させる

タイムコード供給源となる機器は、タイムコード
出力が更新されるモード（Free Run）に設定して
ください。

1 メニューのTC/Media > Timecode > Mode
（78ページ）をPreset F‑Run  
(Ext‑Lk)に設定する。

2 GENLOCK IN端子（12ページ）とTC IN端
子（12ページ）に、それぞれHDまたはSD
のリファレンスビデオ信号およびそれに同期
した基準タイムコードを供給する。

これで本機のタイムコードジェネレーターが基準
タイムコードにロックし、サブディスプレイのホー
ム画面に「Ext‑Lk」と表示されます。
ロックしてから約10秒経過した後は、外部から
の基準タイムコードの接続を外しても、外部ロッ
ク状態は保たれます。

［ご注意］
• 供給する基準タイムコードとリファレンスビデオ信号が、

SMPTEタイムコードの規格を満たした位相関係にある
ことを確認してください。

• 外部ロックの操作をすると、タイムコードは瞬時に外部
のタイムコードにロックし、外部タイムコードの値と同じ
値がタイムデータ表示部に出ますが、タイムコードジェ
ネレーターが安定するまでの数秒間は、記録を開始しな
いでください。

• リファレンスビデオ信号の周波数と本機のフレーム周波
数が同じでないと、正しくロックできず、本機が正常に
動作できません。この場合、タイムコードも外部のタイ
ムコードに正しくロックできません。

• 接続を外した場合、基準タイムコードに対し1時間で1フ
レームずれる場合があります。

外部ロックを解除するには

メニューのTC/Media > Timecode > Mode
（78ページ）の設定を変更してください。

外部同期
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使用上のご注意
安全にご使用いただくために、付属の「ご使用に
なる前に」と併せてご覧ください。

取り扱い・保管上のご注意

強い衝撃を与えない

内部構造や外観の変形などの損傷を受けること
があります。

動作中は布などで包まないでください

内部の温度が上がり、好ましくありません。

使い終わったら

電源スイッチをOFFにしてください。

長時間使わないときは

バッテリーを抜いておいてください。

レンズを太陽光に向けて放置しない

太陽光がレンズを通して内部に焦点を結び、火災
の原因となることがあります。

輸送

• メモリーカードは必ず取り出しておいてくださ
い。

• トラック、船、航空機など、本機を貨物として
扱う輸送では、お買い上げ時の梱包材をご使
用ください。

お手入れ

外装の汚れは、乾いた柔らかい布で拭き取りま
す。ひどい汚れは、中性洗剤液を少し含ませた
布で拭いた後、カラ拭きします。
アルコール、ベンジン、シンナーなどの薬品類は、
表面が変質したり、塗料がはげることがあります
ので、使わないでください。
エアダスター等の高風圧機器を使ったお手入れ
は光学部位の損傷につながりますのでお控えくだ
さい。

万一、異常が生じたときは

お買い上げ店かソニーのサービス窓口にご相談く
ださい。

ファン、バッテリーは有寿命
部品として定期的な交換が
必要です

ファン、バッテリーは有寿命部品として定期的な
交換が必要です。
常温でのご使用の場合、5年を目安に交換してく
ださい。ただし、交換時期は目安であり、部品
の寿命を保証するものではありません。交換の
際はお買い上げ店にご相談ください。

電解コンデンサの寿命は約5
年です

電解コンデンサの寿命は約5年です。

（常温で1日に8時間、1カ月で25日間、通常に使
用すると想定した場合）
したがって、使用時間が上記より長い場合は、
その分寿命は短くなります。

バッテリー端子に関するご注
意

機器に搭載されているバッテリー端子（バッテリー
パックやACアダプターとの接点部分）は消耗品で
す。
振動や衝撃によって端子が変形したり、曲がった
り、あるいは長期の屋外での使用などによって表
面が腐食したりすると、本体に電源が供給され
なくなります。
長期間機器を使用していただくために、定期点
検を実施することをお願いします。点検につきま
しては、ソニーのサービス担当者または営業担当
者にご相談ください。

使用場所・保管場所

水平な場所、空調のある場所に保管してください。
次のような場所での使用・保管は避けてください。
• 極端に寒い所、暑い所（使用温度は0℃～

40℃）。 
真夏、窓を閉め切った自動車内は50℃を越え
ることがあります。

• 湿気・ほこりの多い所。
• 雨があたる所。
• 激しく振動する所。
• 強い磁気を発生するものの近く。

• 強力な電波を発生するテレビやラジオの送信
所の近く。

• 直射日光が長時間当たる場所や暖房器具の近
く。

携帯電話などによる電波障害を防止す
るために

携帯電話などを本機の近くで使用すると、誤動
作を引き起こしたり、映像、音声などに影響を与
えることがあります。
本機の近くでは、携帯電話などの電源はできる
だけ切ってください。

レーザービームについてのご注意

レーザービームはCMOSイメージセンサーに損傷
を与えることがあります。レーザービームを使用
した撮影環境では、CMOSイメージセンサー表
面にレーザービームが照射されないように充分
注意してください。特に医療用などの強力なレー
ザー光の場合は、反射光や散乱光でも損傷を与
えることがあります。

画面について

• 画面を太陽に向けたままにすると、画面を傷
めます。屋外でご使用のときは、太陽に向けて
放置しないでください。

• 画面を強く押したり、ひっかいたり、上に物を
置いたりしないでください。画面にムラが出た
り、パネルの故障の原因になります。

• 使用中に画面が暖かくなることがありますが、
故障ではありません。
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LCD（液晶）画面について

本機のLCD（液晶）パネルは有効画素99.99％以
上の非常に精密度の高い技術で作られています
が、画面上に黒い点が現れたり（画素欠け）、常
時点灯している輝点（赤、青、緑など）や滅点が
ある場合があります。また、LCD（液晶）パネル
の特性上、長期間ご使用の間に画素欠けが生じ
ることもあります。
これらの現象は故障ではありませんので、ご了承
の上本機をお使いください。
なお、これらの点が記録されることはありません。

有機ELパネルについて

本機の有機ELパネルは有効画素99.99％以上の
非常に精密度の高い技術で作られていますが、
画面上に黒い点が現れたり（画素欠け）、常時点
灯している輝点や滅点がある場合があります。ま
た、有機ELパネルの特性上、長期間ご使用の間
に画素欠けが生じることもあります。これらの現
象は故障ではありませんので、ご了承の上本機
をお使いください。なお、これらの点が記録され
ることはありません。
一般に、有機ELパネルは、その特性上、焼き付
き、輝度低下などが発生することがあります。
これらは故障ではありませんので、ご了承の上本
機をお使いください。

結露について

本機を寒いところから急に暖かいところに持ち込
んだときなど、機器表面や内部に水滴がつくこと
があります。これを結露といいます。結露が起き
たときは電源を切り、結露がなくなるまで放置し、
結露がなくなってからご使用ください。結露時の
ご使用は機器の故障の原因となる場合がありま
す。

CMOSイメージセンサー特有
の現象

撮影画面に出る下記の現象は、CMOSイメージ
センサー特有の現象で、故障ではありません。

白点

CMOSイメージセンサーは非常に精密な技術で
作られていますが、宇宙線などの影響により、ま
れに画面上に微小な白点が発生する場合があり
ます。これは撮像素子の原理に起因するもので
故障ではありません。
また、以下の場合、白点が見えやすくなります。
• 高温の環境で使用するとき

折り返しひずみ

細かい模様、線などを撮影すると、ぎざぎざや
ちらつきが見えることがあります。

フォーカルプレーン

撮像素子（CMOSセンサー）の映像信号を読み出
す方法の性質により、撮像条件によっては、画
面をすばやく横切る被写体が少しゆがんで見える
ことがあります。

フラッシュバンド

フラッシュ光や、すばやく点滅する光源を撮影し
たときに、画面の上下で輝度が変化することがあ
ります。

フリッカー

蛍光灯、ナトリウム灯、水銀灯などの放電管によ
る照明下で撮影すると、画面が明滅したり、色
が変化したり、横縞が流れるように見えることが
あります。
本機のフリッカー低減機能を使用することにより
低減可能です（67ページ）。

画面表示に関するご注意

• 次のような場合、ビューファインダーおよび出
力の映像が乱れることがあります。

 ‒ フォーマットを切り換えたとき
 ‒ FPSフレームレートを切り換えたとき
 ‒ ゲンロックがかかるとき

• ビューファインダー内で視線を動かした場合な
どに、赤、緑、青の原色が見えることがありま
すが、故障ではありません。また、これらの原
色が実際にメディアに記録されることはありま
せん。

ファイルの断片化について

画像が正しく記録・再生されないときは記録メ
ディアをフォーマット（初期化）してください。長
期間、映像の記録・クリップの消去を繰り返して
いると、記録メディア内のファイル が断片化（フ
ラグメンテーション）して、映像が正しく記録・
保存できなくな る場合があります。このような場
合は、クリップのバックアップを取ったあと、メ
ニューの TC/Media > Format Media（78
ページ）で記録メディアのフォーマット（初期化）
を行ってください。
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本機の出力電圧について

本機から出力できる周辺機器用電力の合計は、
本機への入力電圧やアクセサリーの接続状況に
よって変化します。条件によっては下記各電源出
力端子の最大許容電力まで供給できない場合が
あります。
LENS端子：1 A max
12V	OUT端子（2ピン）：1 A max
24V	OUT端子（3ピン）：

2 A max（入力電圧：22 V ～ 32 V)
1 A max（入力電圧：11 V ～ 17 V）

本機器への入力電圧値に応じて、アクセサリー
（DVF‑EL200およびCBK‑3610XS）の装着および
周辺機器への供給電力が制限されます。

本機器に供給される電圧：Ｘ[V]
周辺機器用供給電力合計：Ｙ[W]
本機器の消費電力：Z[W]1)

 DVF‑EL200の消費電力：約2.5 W
 CBK‑3610XSの消費電力：約3.9 W

Y[W]=X[V]x9.0[A]*-(Z++)[W]

* X[V]x9.0[A]が220 Wを超える場合は、220[W]
として計算してください。

上記アクセサリーの装着および周辺機器に電力
を供給する場合は、上記計算式でYが負の値に
ならないように運用してください。本機器の消費
電力1)は最大消費電力の値にすることをお勧めし
ます。

（算出した結果Ｙが、各電源出力端子の最大許容
電力の和を超える場合は適用されません。）
1) MPC‑3628： 

本体標準消費電力：約76 W（8.6K 3:2、24FPS、
X‑OCN XT記録時）

 本体最大消費電力：約100 W（8.2K 17:9、60FPS、
X‑OCN ST記録時、40 ℃環境、32 V DC入力）

 MPC‑3626： 
本体標準消費電力：約73 W（6K 3:2、24FPS、X‑OCN 
XT記録時）

 本体最大消費電力：約94 W（6K 3:2、60FPS、X‑OCN 
ST記録時、40 ℃環境、32 V DC入力）

セキュリティに関するご注意

• 通信を行う機器でセキュリティ対策を行わな
かった結果、または、通信仕様上の、やむを
得ない事情により、データ漏洩等、セキュリティ
上の問題が発生した場合、弊社ではそれによっ
て生じたあらゆる損害に対する責任を負いかね
ます。

• 使用環境によってはネットワーク上の意図せぬ
第三者から製品にアクセスされる可能性があり
ます。本機をネットワークに接続する際には、
セキュアなネットワークであることをご確認の
上ご使用ください。

• セキュリティの面から、製品をネットワークに
接続してご使用になる際は、ブラウザでコント
ロール画面にアクセスし、アクセス制限設定を
工場出荷時の設定値から変更して設定するこ
とを強く推奨します。（89ページ） 
また、定期的にパスワードを変更することを推
奨します。

• 設定作業中または設定作業後のブラウザで他
のサイトを閲覧しないでください。ブラウザに
ログインした状態が残りますので、意図しない
第三者の使用や悪意のあるプログラムの実行
を防ぐために、設定作業が完了したら必ずブラ
ウザを終了してください。



128 8章　付録

SDI OUT端子の出力フォーマット

SDI OUT端子からのシリアルデジタル信号は、メニューのProjectカテゴリーとMonitoringカテゴリーの設定に応じて出力されます。
Projectカテゴリーの設定組み合わせに関しては「記録フォーマット設定表」（61ページ）を参照してください。
Monitoringメニュー > Output Formatの3G SDI 1/2/3/4 Output（79ページ）で、3G SDI出力フォーマットをLevelAにするかLevel Bにするかを選択できます。

太字とアンダーラインで表示されている設定値は、出荷時の設定です。
Project Monitoring > Output Format 出力フォーマット
Project Frame Rate Imager Mode Recording Format SDI 1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4
59.94/50 8.2K 17:9/

6K 3:2/
6K 1.85:1/
6K 17:9/
6K 2.39:1/
5.8K 6:5/
5.8K 17:9/
4K 6:5/
4K 4:3/
4K 17:9/
4K 2.39:1

X‑OCN XT
X‑OCN ST
X‑OCN LT
ProRes 4444 4K
ProRes 422 HQ 4K

4096x2160P 12G
1920x1080P Level A1）

4096x2160P  
YPbPr 12G

4096x2160P  
YPbPr 12G

1920x1080P  
YPbPr 3G Level A

1920x1080P  
YPbPr 3G Level A

1920x1080i 1920x1080i  
YPbPr 1.5G

1920x1080i  
YPbPr 1.5G

4096x2160P  
Square Level B2）

4096x2160P  
Square Level B2） 4096x2160P YPbPr 3G Square Level B

4096x2160P  
2SI Level B2）

4096x2160P  
2SI Level B2） 4096x2160P YPbPr 3G 2SI Level B

2048x1080P Level 
B2）

1920x1080P Level 
B2） 2048x1080P  

YPbPr 3G Level B
2048x1080P  

YPbPr 3G Level B

1920x1080P  
YPbPr 3G Level B

1920x1080P  
YPbPr 3G Level B

1920x1080i 1920x1080i  
YPbPr 1.5G

1920x1080i  
YPbPr 1.5G

1920x1080P Level 
B2）

1920x1080P Level 
B2） 1920x1080P  

YPbPr 3G Level B
1920x1080P  

YPbPr 3G Level B

1920x1080P  
YPbPr 3G Level B

1920x1080P  
YPbPr 3G Level B

1920x1080i 1920x1080i  
YPbPr 1.5G

1920x1080i  
YPbPr 1.5G

1920x1080i 1920x1080i 1920x1080i  
YPbPr 1.5G

1920x1080i  
YPbPr 1.5G

1920x1080i  
YPbPr 1.5G

1920x1080i  
YPbPr 1.5G

記録フォーマットと出力信号
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Project Monitoring > Output Format 出力フォーマット
Project Frame Rate Imager Mode Recording Format SDI 1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4
59.94/50 7.6K 16:9/

5.7K 16:9/
5.4K 16:9/
3.8K 16:9

X‑OCN XT
X‑OCN ST
X‑OCN LT
ProRes 4444 QFHD
ProRes 422 HQ QFHD

3840x2160P 12G
1920x1080P Level A1）

3840x2160P  
YPbPr 12G

3840x2160P  
YPbPr 12G

1920x1080P  
YPbPr 3G Level A

1920x1080P  
YPbPr 3G Level A

1920x1080i 1920x1080i  
YPbPr 1.5G

1920x1080i  
YPbPr 1.5G

3840x2160P  
Square Level B2）

3840x2160P  
Square Level B2） 3840x2160P YPbPr 3G Square Level B

3840x2160P  
2SI Level B2）

3840x2160P  
2SI Level B2） 3840x2160P YPbPr 3G 2SI Level B

1920x1080P Level 
B2）

1920x1080P Level 
B2） 1920x1080P  

YPbPr 3G Level B
1920x1080P  

YPbPr 3G Level B

1920x1080P  
YPbPr 3G Level B

1920x1080P  
YPbPr 3G Level B

1920x1080i 1920x1080i  
YPbPr 1.5G

1920x1080i  
YPbPr 1.5G

1920x1080i 1920x1080i 1920x1080i  
YPbPr 1.5G

1920x1080i  
YPbPr 1.5G

1920x1080i  
YPbPr 1.5G

1920x1080i  
YPbPr 1.5G

1920x1080i3） 1920x1080i3） 1920x1080i  
YPbPr 1.5G

1920x1080i 
YPbPr 1.5G

1920x1080i  
YPbPr 1.5G

1920x1080i  
YPbPr 1.5G

47.95 8.2K 17:9/
6K 3:2/
6K 1.85:1/
6K 17:9/
6K 2.39:1/
5.8K 6:5/
5.8K 17:9/
4K 6:5/
4K 4:3/
4K 17:9/
4K 2.39:1
3.8K 16:9

X‑OCN XT
X‑OCN ST
X‑OCN LT

4096x2160P  
Square Level B2）

4096x2160P  
Square Level B2） 4096x2160P YPbPr 3G Square Level B

4096x2160P  
2SI Level B2）

4096x2160P  
2SI Level B2） 4096x2160P YPbPr 3G 2SI Level B

2048x1080P Level 
B2） 1920x1080P 2048x1080P  

YPbPr 3G Level B
2048x1080P  

YPbPr 3G Level B
1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P 1920x1080P 1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G
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Project Monitoring > Output Format 出力フォーマット
Project Frame Rate Imager Mode Recording Format SDI 1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4
29.97/25 8.6K 3:2/

8.2K 17:9/
6K 3:2/
6K 1.85:1/
6K 17:9/
6K 2.39:1/
5.8K 6:5/
5.8K 17:9/
4K 6:5/
4K 4:3/
4K 17:9/
4K 2.39:1

X‑OCN XT
X‑OCN ST
X‑OCN LT
ProRes 4444 4K
ProRes 422 HQ 4K

4096x2160P 6G
1920x1080P

4096x2160P  
YPbPr 6G 2SI

4096x2160P  
YPbPr 6G 2SI

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080PsF 1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G

4096x2160P Square 4096x2160P Square 4096x2160P YPbPr 1.5G Square

4096x2160P 2SI
1920x1080P

4096x2160P YPbPr 3G 2SI

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080PsF 1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G

2048x1080PsF
1920x1080P

2048x1080PsF 
YPbPr 1.5G

2048x1080PsF 
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080PsF 1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G

1920x1080P 1920x1080P 1920x1080P 
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080PsF 1920x1080PsF 1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G

7.6K 16:9/
5.7K 16:9/
5.4K 16:9/
3.8K 16:9

X‑OCN XT
X‑OCN ST
X‑OCN LT
ProRes 4444 QFHD
ProRes 422 QFHD

3840x2160P 6G
1920x1080P

3840x2160P  
YPbPr 6G 2SI

3840x2160P  
YPbPr 6G 2SI

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080PsF 1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G

3840x2160P Square 3840x2160P Square 3840x2160P YPbPr 1.5G Square

3840x2160P 2SI
1920x1080P

3840x2160P YPbPr 3G 2SI

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080PsF 1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G

1920x1080P 1920x1080P 1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080PsF 1920x1080PsF 1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G
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Project Monitoring > Output Format 出力フォーマット
Project Frame Rate Imager Mode Recording Format SDI 1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4
24 8.6K 3:2/

8.2K 17:9/
6K 3:2/
6K 1.85:1/
6K 17:9/
6K 2.39:1/
5.8K 6:5/
5.8K 17:9/
4K 6:5/
4K 4:3/
4K 17:9/
4K 2.39:1

X‑OCN XT
X‑OCN ST
X‑OCN LT
ProRes 4444 4K
ProRes 422 HQ 4K

4096x2160P 6G 1920x1080P 4096x2160P  
YPbPr 6G 2SI

4096x2160P  
YPbPr 6G 2SI

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

4096x2160P Square 4096x2160P Square 4096x2160P YPbPr 1.5G Square

4096x2160P 2SI 1920x1080P 4096x2160P YPbPr 3G 2SI 1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

2048x1080PsF 1920x1080P 2048x1080PsF 
YPbPr 1.5G

2048x1080PsF 
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P 1920x1080P 1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080PsF 1920x1080P 1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

7.6K 16:9/
5.7K 16:9/
5.4K 16:9/
3.8K 16:9

X‑OCN XT
X‑OCN ST
X‑OCN LT
ProRes 4444 QFHD
ProRes 422 QFHD

3840x2160P 6G 1920x1080P 3840x2160P  
YPbPr 6G 2SI

3840x2160P  
YPbPr 6G 2SI

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

3840x2160P Square 3840x2160P Square 3840x2160P YPbPr 1.5G Square

3840x2160P 2SI 1920x1080P 3840x2160P YPbPr 3G 2SI 1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P 1920x1080P 1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080PsF 1920x1080P 1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G
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Project Monitoring > Output Format 出力フォーマット
Project Frame Rate Imager Mode Recording Format SDI 1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4
23.98 8.6K 3:2/

8.2K 17:9/
6K 3:2/
6K 1.85:1/
6K 17:9/
6K 2.39:1/
5.8K 6:5/
5.8K 17:9/
4K 6:5/
4K 4:3/
4K 17:9/
4K 2.39:1

X‑OCN XT
X‑OCN ST
X‑OCN LT
ProRes 4444 4K
ProRes 422 HQ 4K

4096x2160P 6G 1920x1080P 4096x2160P  
YPbPr 6G 2SI

4096x2160P  
YPbPr 6G 2SI

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

4096x2160P Square 4096x2160P Square 4096x2160P YPbPr 1.5G Square

4096x2160P 2SI 1920x1080P 4096x2160P YPbPr 3G 2SI 1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

2048x1080PsF 1920x1080P 2048x1080PsF 
YPbPr 1.5G

2048x1080PsF 
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P 1920x1080P 1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080PsF 1920x1080P 1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

7.6K 16:9/
5.7K 16:9/
5.4K 16:9/
3.8K 16:9

X‑OCN XT
X‑OCN ST
X‑OCN LT
ProRes 4444 QFHD
ProRes 422 QFHD

3840x2160P 6G 1920x1080P 3840x2160P  
YPbPr 6G 2SI

3840x2160P  
YPbPr 6G 2SI

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

3840x2160P Square 3840x2160P Square 3840x2160P YPbPr 1.5G Square

3840x2160P 2SI 1920x1080P 3840x2160P YPbPr 3G 2SI 1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P 1920x1080P 1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080PsF 1920x1080P 1920x1080PsF  
YPbPr 1.5G

1920x1080PsF  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1920x1080P  
YPbPr 1.5G

1） Monitoringメニュー > Output Formatの3G SDI 1/2/3/4 Output（79ページ）をLevel Bに設定してもLevel A信号が出力されます。
2） Monitoringメニュー > Output Formatの3G SDI 1/2/3/4 OutputをLevel Aに設定するとメニューの設定値がLevel Aになり、Level A信号が出力されます。
3） Technicalメニュー > Special ConfigurationのSD HDMI（93ページ）がOnのときの設定です。
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MONITOR OUT端子/HDMI OUT端子の出力フォーマット

MONITOR OUT端子、HDMI OUT端子からのデジタル信号は、メニューのProjectカテゴリーとMonitoringカテゴリーの設定に応じて出力されます。
Projectカテゴリーの設定組み合わせに関しては「記録フォーマット設定表」（61ページ）を参照してください。

太字とアンダーラインで表示されている設定値は、出荷時の設定です。
Project Monitoring > Output Format 出力フォーマット
Project Frame Rate Imager Mode Recording Format SDI 1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI
59.94/50 8.2K 17:9/

6K 3:2/
6K 1.85:1/
6K 17:9/
6K 2.39:1/
5.8K 6:5/
5.8K 17:9/
4K 6:5/
4K 4:3/
4K 17:9/
4K 2.39:1

X‑OCN XT
X‑OCN ST
X‑OCN LT
ProRes 4444 4K
ProRes 422 HQ 4K

4096x2160P 12G
1920x1080P Level A1） 1920x1080P Level A

4096x2160P 1920x1080P  
YPbPr 3G Level A

4096x2160P
1920x1080P 1920x1080P

1920x1080i 1920x1080i
4096x2160P 1920x1080P  

YPbPr 3G Level A
4096x2160P

1920x1080i 1920x1080i

4096x2160P  
Square Level B2）

4096x2160P  
Square Level B2）

1920x1080P Level A 1920x1080P 1920x1080P  
YPbPr 3G Level A 1920x1080P

1920x1080i 1920x1080i 1920x1080i  
YPbPr 1.5G 1920x1080i

4096x2160P 2SI 
Level B2）

4096x2160P 2SI 
Level B2）

1920x1080P Level A
4096x2160P 1920x1080P  

YPbPr 3G Level A
4096x2160P

1920x1080P 1920x1080P

1920x1080i
4096x2160P 1920x1080i  

YPbPr 1.5G
4096x2160P

1920x1080i 1920x1080i

2048x1080P Level 
B2）

1920x1080P Level 
B2） 1920x1080P Level A 1920x1080P 1920x1080P  

YPbPr 3G Level A 1920x1080P

1920x1080i 1920x1080i 1920x1080i 1920x1080i  
YPbPr 1.5G 1920x1080i

1920x1080P Level 
B2）

1920x1080P Level 
B2） 1920x1080P Level A 1920x1080P 1920x1080P  

YPbPr 3G Level A 1920x1080P

1920x1080i 1920x1080i 1920x1080i 1920x1080i  
YPbPr 1.5G 1920x1080i

1920x1080i 1920x1080i 1920x1080i 1920x1080i 1920x1080i  
YPbPr 1.5G 1920x1080i
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Project Monitoring > Output Format 出力フォーマット
Project Frame Rate Imager Mode Recording Format SDI 1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI
59.94/50 7.6K 16:9/

5.7K 16:9/
5.4K 16:9/
3.8K 16:9

X‑OCN XT
X‑OCN ST
X‑OCN LT
ProRes 4444 QFHD
ProRes 422 HQ QFHD

3840x2160P 12G
1920x1080P Level A1） 1920x1080P Level A

3840x2160P 1920x1080P  
YPbPr 3G Level A

3840x2160P
1920x1080P 1920x1080P

1920x1080i 1920x1080i
3840x2160P 1920x1080P  

YPbPr 3G Level A
3840x2160P

1920x1080i 1920x1080i

3840x2160P  
Square Level B2）

3840x2160P  
Square Level B2）

1920x1080P Level A 1920x1080P 1920x1080P  
YPbPr 3G Level A 1920x1080P

1920x1080i 1920x1080i 1920x1080i  
YPbPr 1.5G 1920x1080i

3840x2160P  
2SI Level B2）

3840x2160P  
2SI Level B2）

1920x1080P Level A
3840x2160P 1920x1080P  

YPbPr 3G Level A
3840x2160P

1920x1080P 1920x1080P

1920x1080i
3840x2160P 1920x1080i  

YPbPr 1.5G
3840x2160P

1920x1080i 1920x1080i

1920x1080P Level 
B2）

1920x1080P Level 
B2） 1920x1080P Level A 1920x1080P 1920x1080P  

YPbPr 3G Level A 1920x1080P

1920x1080i 1920x1080i 1920x1080i 1920x1080i  
YPbPr 1.5G 1920x1080i

1920x1080i 1920x1080i 1920x1080i 1920x1080i 1920x1080i  
YPbPr 1.5G 1920x1080i

1920x1080i3） 1920x1080i3） ― 720x480P3） ― 720x480P3）4）

47.95 8.2K 17:9/
6K 3:2/
6K 1.85:1/
6K 17:9/
6K 2.39:1/
5.8K 6:5/
5.8K 17:9/
4K 6:5/
4K 4:3/
4K 17:9/
4K 2.39:1/
3.8K 16:9

X‑OCN XT
X‑OCN ST
X‑OCN LT

4096x2160P  
Square Level B2）

4096x2160P  
Square Level B2）

1920x1080P 1920x1080P 1920x1080P  
YPbPr 1.5G 1920x1080P

4096x2160P  
2SI Level B2）

4096x2160P  
2SI Level B2）

2048x1080P Level 
B2） 1920x1080P

1920x1080P 1920x1080P
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Project Monitoring > Output Format 出力フォーマット
Project Frame Rate Imager Mode Recording Format SDI 1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI
29.97/25 8.6K 3:2/

8.2K 17:9/
6K 3:2/
6K 1.85:1/
6K 17:9/
6K 2.39:1/
5.8K 6:5/
5.8K 17:9/
4K 6:5/
4K 4:3/
4K 17:9/
4K 2.39:1

X‑OCN XT
X‑OCN ST
X‑OCN LT
ProRes 4444 4K
ProRes 422 HQ 4K

4096x2160P 6G
1920x1080P 1920x1080P

4096x2160P 1920x1080P  
YPbPr 1.5G

4096x2160P
1920x1080P 1920x1080P

1920x1080PsF 1920x1080PsF
4096x2160P 1920x1080P  

YPbPr 1.5G
4096x2160P

1920x1080PsF 1920x1080PsF

4096x2160P Square 4096x2160P Square
1920x1080P 1920x1080P 1920x1080P  

YPbPr 1.5G 1920x1080P

1920x1080PsF 1920x1080PsF 1920x1080PsF  
YPbPr 1.5G 1920x1080PsF

4096x2160P 2SI
1920x1080P 1920x1080P

4096x2160P 1920x1080P  
YPbPr 1.5G

4096x2160P
1920x1080P 1920x1080P

1920x1080PsF 1920x1080PsF
4096x2160P 1920x1080P  

YPbPr 1.5G
4096x2160P

1920x1080PsF 1920x1080PsF

2048x1080PsF
1920x1080P 1920x1080P 1920x1080P 1920x1080P  

YPbPr 1.5G 1920x1080P

1920x1080PsF 1920x1080PsF 1920x1080PsF 1920x1080PsF  
YPbPr 1.5G 1920x1080PsF

1920x1080P 1920x1080P 1920x1080P 1920x1080P 1920x1080P  
YPbPr 1.5G 1920x1080P

1920x1080PsF 1920x1080PsF 1920x1080PsF 1920x1080PsF 1920x1080PsF  
YPbPr 1.5G 1920x1080PsF

7.6K 16:9/
5.7K 16:9/
5.4K 16:9/
3.8K 16:9

X‑OCN XT
X‑OCN ST
X‑OCN LT
ProRes 4444 QFHD
ProRes 422 QFHD

3840x2160P 6G
1920x1080P 1920x1080P

3840x2160P 1920x1080P  
YPbPr 1.5G

3840x2160P
1920x1080P 1920x1080P

1920x1080PsF 1920x1080PsF
3840x2160P 1920x1080P  

YPbPr 1.5G
3840x2160P

1920x1080PsF 1920x1080PsF

3840x2160P Square 3840x2160P Square
1920x1080P 1920x1080P 1920x1080P  

YPbPr 1.5G 1920x1080P

1920x1080PsF 1920x1080PsF 1920x1080PsF  
YPbPr 1.5G 1920x1080PsF

3840x2160P 2SI
1920x1080P 1920x1080P

3840x2160P 1920x1080P  
YPbPr 1.5G

3840x2160P
1920x1080P 1920x1080P

1920x1080PsF 1920x1080PsF
3840x2160P 1920x1080P  

YPbPr 1.5G
3840x2160P

1920x1080PsF 1920x1080PsF

1920x1080P 1920x1080P 1920x1080P 1920x1080P 1920x1080P  
YPbPr 1.5G 1920x1080P

1920x1080PsF 1920x1080PsF 1920x1080PsF 1920x1080PsF 1920x1080PsF  
YPbPr 1.5G 1920x1080PsF
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Project Monitoring > Output Format 出力フォーマット
Project Frame Rate Imager Mode Recording Format SDI 1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI
24 8.6K 3:2/

8.2K 17:9/
6K 3:2/
6K 1.85:1/
6K 17:9/
6K 2.39:1/
5.8K 6:5/
5.8K 17:9/
4K 6:5/
4K 4:3/
4K 17:9/
4K 2.39:1

X‑OCN XT
X‑OCN ST
X‑OCN LT
ProRes 4444 4K
ProRes 422 HQ 4K

4096x2160P 6G 1920x1080P 1920x1080P
4096x2160P 1920x1080P  

YPbPr 1.5G
4096x2160P

1920x1080P 1920x1080P

4096x2160P Square 4096x2160P Square 1920x1080P 1920x1080P 1920x1080P  
YPbPr 1.5G 1920x1080P

4096x2160P 2SI 1920x1080P 1920x1080P
4096x2160P 1920x1080P  

YPbPr 1.5G
4096x2160P

1920x1080P 1920x1080P

2048x1080PsF 1920x1080P 1920x1080P 1920x1080P 1920x1080P  
YPbPr 1.5G 1920x1080P

1920x1080P 1920x1080P 1920x1080P 1920x1080P 1920x1080P  
YPbPr 1.5G 1920x1080P

1920x1080PsF 1920x1080P 1920x1080P 1920x1080P 1920x1080P  
YPbPr 1.5G 1920x1080P

7.6K 16:9/
5.7K 16:9/
5.4K 16:9/
3.8K 16:9

X‑OCN XT
X‑OCN ST
X‑OCN LT
ProRes 4444 QFHD
ProRes 422 QFHD

3840x2160P 6G 1920x1080P 1920x1080P
3840x2160P 1920x1080P  

YPbPr 1.5G
3840x2160P

1920x1080P 1920x1080P

3840x2160P Square 3840x2160P Square 1920x1080P 1920x1080P 1920x1080P  
YPbPr 1.5G 1920x1080P

3840x2160P 2SI 1920x1080P 1920x1080P
3840x2160P 1920x1080P  

YPbPr 1.5G
3840x2160P

1920x1080P 1920x1080P

1920x1080P 1920x1080P 1920x1080P 1920x1080P 1920x1080P  
YPbPr 1.5G 1920x1080P

1920x1080PsF 1920x1080P 1920x1080P 1920x1080P 1920x1080P  
YPbPr 1.5G 1920x1080P
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Project Monitoring > Output Format 出力フォーマット
Project Frame Rate Imager Mode Recording Format SDI 1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI
23.98 8.6K 3:2/

8.2K 17:9/
6K 3:2/
6K 1.85:1/
6K 17:9/
6K 2.39:1/
5.8K 6:5/
5.8K 17:9/
4K 6:5/
4K 4:3/
4K 17:9/
4K 2.39:1

X‑OCN XT
X‑OCN ST
X‑OCN LT
ProRes 4444 4K
ProRes 422 HQ 4K

4096x2160P 6G 1920x1080P 1920x1080P
4096x2160P 1920x1080P  

YPbPr 1.5G
4096x2160P

1920x1080P 1920x1080P

4096x2160P Square 4096x2160P Square 1920x1080P 1920x1080P 1920x1080P  
YPbPr 1.5G 1920x1080P

4096x2160P 2SI 1920x1080P 1920x1080P
4096x2160P 1920x1080P  

YPbPr 1.5G
4096x2160P

1920x1080P 1920x1080P

2048x1080PsF 1920x1080P 1920x1080P 1920x1080P 1920x1080P  
YPbPr 1.5G 1920x1080P

1920x1080P 1920x1080P 1920x1080P 1920x1080P 1920x1080P  
YPbPr 1.5G 1920x1080P

1920x1080PsF 1920x1080P 1920x1080P 1920x1080P 1920x1080P  
YPbPr 1.5G 1920x1080P

7.6K 16:9/
5.7K 16:9/
5.4K 16:9/
3.8K 16:9

X‑OCN XT
X‑OCN ST
X‑OCN LT
ProRes 4444 QFHD
ProRes 422 QFHD

3840x2160P 6G 1920x1080P 1920x1080P
3840x2160P 1920x1080P  

YPbPr 1.5G
3840x2160P

1920x1080P 1920x1080P

3840x2160P Square 3840x2160P Square 1920x1080P 1920x1080P 1920x1080P  
YPbPr 1.5G 1920x1080P

3840x2160P 2SI 1920x1080P 1920x1080P
3840x2160P 1920x1080P  

YPbPr 1.5G
3840x2160P

1920x1080P 1920x1080P

1920x1080P 1920x1080P 1920x1080P 1920x1080P 1920x1080P  
YPbPr 1.5G 1920x1080P

1920x1080PsF 1920x1080P 1920x1080P 1920x1080P 1920x1080P  
YPbPr 1.5G 1920x1080P

1） Monitoringメニュー > Output Formatの3G SDI 1/2/3/4 Output（79ページ）をLevel Bに設定してもLevel A信号が出力されます。
2） Monitoringメニュー > Output Formatの3G SDI 1/2/3/4 OutputをLevel Aに設定するとメニューの設定値がLevel Aになり、Level A信号が出力されます。
3） Technicalメニュー > Special ConfigurationのSD HDMI（93ページ）がOnのときの設定です。
4） Imager ModeまたはZoom to Fitが16:9で、Recording FormatがX‑OCN STの場合に設定できます。また、プロジェクトフレームレートが50のときはHDMIの出力は720x576Pとなります。
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AXSクリップ記録・再生時間
AXS‑A1TS66を使用した場合の記録・再生時間は以下のとおりです（単位：min）。

[ご注意]
記録・再生時間は、1クリップとして連続記録したときのものです。記録するクリップ数によっては記載の時間より短くなる場合があります。また、使用条件やメモリーの特性などにより、多少の誤差が生じる場合があります。

X‑OCN記録・再生時間

MPC‑3628

Recording Format Project Frame Rate 8.6K 3:2 8.2K 17:9 7.6K 17:9 5.8K 6:5 5.8K 17:9 5.4K 16:9
X‑OCN XT 23.98/24 23 32 32 41 65 65

25 22 31 31 39 62 62
29.97 18 25 25 33 52 52
47.95 － － － 20 32 －
50 － － － － 31 31
59.94 － － － － 26 26

X‑OCN ST 23.98/24 34 47 47 60 95 95
25 32 45 45 57 91 91
29.97 27 37 37 48 76 76
47.95 － 23 － 30 47 －
50 － 22 22 － 45 45
59.94 － 18 18 － 38 38

X‑OCN LT 23.98/24 58 80 80 102 160 160
25 55 77 77 98 154 154
29.97 46 64 64 81 128 128
47.95 － 40 － 51 80 －
50 － 38 38 － 77 77
59.94 － 32 32 － 64 64
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MPC‑3626

Recording Format Project Frame Rate 6K 3:2 6K 1.85:1 6K 17:9 6K 2.39:1 5.7K 16:9 4K 6:5 4K 4:3 4K 17:9 4K 2.39:1 3.8K 16:9
X‑OCN XT 23.98/24 47 58 59 75 59 81 93 129 161 129

25 45 56 57 72 57 78 89 124 155 124
29.97 38 46 47 60 47 65 74 103 129 103
47.95 23 29 29 37 － 41 46 64 81 －
50 22 28 28 36 28 39 44 62 77 62
59.94 19 23 23 30 23 32 37 51 64 51

X‑OCN ST 23.98/24 69 85 87 109 87 119 135 188 235 188
25 66 81 83 105 83 114 130 180 225 180
29.97 55 68 69 87 69 95 108 150 188 150
47.95 34 42 43 54 － 59 68 94 118 －
50 33 40 42 52 42 57 65 90 113 90
59.94 27 34 35 43 35 47 54 75 94 75

X‑OCN LT 23.98/24 117 144 147 185 147 201 229 316 395 316
25 112 138 141 177 141 193 220 304 380 304
29.97 94 115 118 148 118 161 183 254 317 254
47.95 58 72 74 92 － 101 115 159 199 －
50 56 69 71 89 71 97 110 153 191 153
59.94 47 57 59 74 59 81 92 127 159 127

ProRes記録・再生時間

Project Frame Rate 4K 4444 4K 422 HQ QFHD 4444 QFHD 422 HQ
23.98/24 98 146 104 156
25 94 140 100 150
29.97 78 117 83 125
50 47 70 50 75
59.94 39 58 41 62
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エラー /警告表示
本機では警告、注意、動作確認などが必要な状況では、サブディスプレイ画面にメッセージ表示、
RECランプの点滅、および警告音で対応します。
警告音は、内蔵スピーカーまたはヘッドホン端子に接続したヘッドホンに出力します。
本機の電源起動時に、一定期間イメージセンサーの自動調整（Auto Pixel Restoration）を実行して
いない場合は、Auto Pixel Restorationの実行を促すメッセージがサブディスプレイ画面に表示され
ます。この場合は、表示される指示に従って、Auto Pixel Restoration（89ページ）を実行してく
ださい。

エラー表示

次のような表示が出た場合は、本機は動作を停止します。
エラー表示内容 警告音 RECランプ 原因と対策
E+エラーコード 断続音 高速点滅 本体の異常の可能性があります。ビューファインダー・

モニター画面上にRECと表示されていても記録は止
まっています。
電源を切り、接続している機器やケーブル類、メディ
アに異常がないか確認してください。これらに異常が
ないときは、再度電源を入れ、エラーが継続する場
合はソニーのサービス窓口にご連絡ください。（電源
スイッチをOFFにしても電源が切れない場合は、バッ
テリーパックやDC IN電源も外してください。）

警告表示

次のような表示が出た場合は、次表に従って対処してください。
警告表示内容 警告音 RECランプ 原因と対策
Media Full1) 連続音 高速点滅 AXSメモリーカードの残量がないため、記録、コピー、

クリップ分割はできません。
交換してください。

Battery End1) 連続音 高速点滅 バッテリーパックが消耗しました。記録はできません。
いったん操作を中止し、バッテリーパックを交換して
ください。

Temperature High1) 断続音 点滅 内部温度が上昇しました。
いったん電源を切り、温度が下がるまで使用を中止し
てください。

警告表示内容 警告音 RECランプ 原因と対策
Insufficient 
Voltage1)

連続音 高速点滅 DC IN電圧が低すぎます。記録はできません。
他の電源に接続し直してください。

1) モニター画面にはメッセージは表示されません。

温度に関する警告表示について

動作モードや周囲環境によっては、本機の動作保証温度範囲内であってもTemperature Highが表示
されることがあります。これらの警告が表示されても直ちに記録が止まることはありませんが、早めに
上記の原因と対策の指示に従って対応してください。

注意・動作確認表示

モニター画面もしくはサブディスプレイ上に次のような注意・動作確認表示が現れたり、警告アイコン
が表示され、メニューのInfoカテゴリー > Camera Conditionに次のような注意・動作確認表示が
現れることがあります。この場合は次表に従って対処してください。
表示内容 原因と対策
Backup Battery End
Please Change

バックアップ電池の残量が不足しています。
バックアップ電池を交換してください。

Cannot Use AXS(A)*
Please Change

パーティションが切られているメモリーカードや、本
機で扱えるクリップ数を超えて記録されたメモリー
カードが挿入されました。
本機では使用できませんので、交換してください。

Cannot Use AXS(A)*
Unsupported File System

ファイルシステムの異なるカードまたはフォーマット
されていないカードが挿入されました。
本機では使用できませんので、交換または本機で
フォーマットしてください。

Media Error
AXS(A)* Needs to be Restored

メモリーカードに異常が発生し、修復が必要な状態
になりました。
メモリーカードの修復を行ってください。

AXS(A)* Error
Recording Stopped
Playback Stopped

メモリーカードに異常が発生したため、記録または
再生が停止しました。
頻繁に起きる場合には、メモリーカードを交換して
ください。
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表示内容 原因と対策
Input AES/EBU is Invalid Emphasis AES/EBU入力に対応していないEmphasis信号が

入力されました。
本機は50μs + 15μsのEmphasis信号にのみ対応し
ています。

Input AES/EBU is not Pro Use AES/EBU入力に、Professional Use以外の信号が
入力されました。
本機はProfessional Useにのみ対応しています。

Fan Stopped 本体内のファンが停止しています。
高温下での使用を避け、電源を切ってソニーのサー
ビス担当者に連絡してください。

XXXX License Yday Remaining 
（XXXX：ライセンスの種類、Y：残り日数）

期間限定ライセンス付ソフトウェアオプションの有
効期限が残り2日を切りました。

Lens I/F Error Eマウントレンズ装着時にレンズI/F通信でレンズの不
具合が検出されました。
Eマウントレンズとの接続状態を確認してください。

Set the "Password" of "Authentication". Technicalメニュー > Authentication > Password
（89ページ）が未設定なので設定してください。

* AXSメモリーカードスロットAに入れたAXSカードの場合はAXS(A)、AXSメモリーカードスロットBに入れたAXSカード
の場合はAXS(B)が表示されます。
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ファイルに保存される項目
表凡例
○：保存する
×：保存しない
―：保存しない（一時的動作メニュー）

Shootingメニュー

項目 細目 保存先ファイル
All Scene

FPS Fixed/Variable Select ○ ×
FPS Select ○ ×

Shutter1） Shutter Select ○ ○
Step/Cont. Select ○ ○
Add/Change Step － －
Delete Step － －

Flicker Reduce Mode ○ ×
Frequency ○ ×

ND ND Position ○ ○
Exposure Index EI Select ○ ○
Gain Gain Select ○ ○
White Balance1） Color Temp. Select ○ ○

Add/Change Step － －
Delete Step － －
Auto White Balance － －

Look Category ○ ×
Preset Look Select ○ ×
User 3D LUT Select ○ ×
ART Select ○ ×
ART Information － －
ASC CDL Process ○ ×
ASC CDL Select ○ ×
ASC CDL Information － －

項目 細目 保存先ファイル
All Scene

Look File Load User 3D LUT － －
Reset User 3D LUT － －
Reset All User 3D LUTs － －
Load ART － －
Reset ART － －
Reset All ARTs － －
Load ASC CDL － －
Reset ASC CDL － －
Reset All ASC CDLs － －

LUT Select SDI 1/2 ○ －
SDI 3/4 ○ ×
Monitor ○ ×
HDMI － －
VF LUT ○ ×
ProRes ○ ×
SDR Gain ○ ×

1） ユーザーが追加・編集した選択肢も保存されます。
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Projectメニュー

項目 細目 保存先ファイル
All Scene

Basic Setting Imager Mode ○ ×
Project Frame Rate ○ ×
Input Color Space ○ ○
Recording Format ○ ×
Base ISO ○ ○
Anamo. De‑Squeeze ○ ×
Zoom to Fit ○ ×

Assignable Button <1> ○ ×
<2> ○ ×
<3> ○ ×
<4> ○ ×
<VF A> ○ ×
<VF B> ○ ×
<VF C> ○ ×
<User 1> ○ ×
<User 2> ○ ×
<User 3> ○ ×
<User 4> ○ ×
<User 5> ○ ×

Special Recording Cache Rec Select ○ ×
Max Cache Rec Duration ○ ×

All File(Cam Setup) Load SD Card － －
Save SD Card － －
File ID ○ ×
Format SD Card － －

Scene File Recall Internal Memory － －
Store Internal Memory － －
Load SD Card － －
Save SD Card － －
File ID × ○

項目 細目 保存先ファイル
All Scene

User Gamma Current Settings － －
Load SD Card － －
Reset － －
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TC/Mediaメニュー

項目 細目 保存先ファイル

All Scene
Timecode Mode ○ ×

Manual Setting － －
Reset － －
TC Format ○ ×
TC Source － －
Time Data Display ○ ×

Genlock Input Source ○ ×
Reference Lock Type － －

Clip Name Format Camera ID1） ○ ×
Reel Number1） ○ ×
Camera Position1） ○ ×

Format Media AXS Slot A － －
AXS Slot B － －
SD Card － －

1） Allファイルを読み込んだ際も本機内部に保存されているデータは上書きされません。

Monitoringメニュー

項目 細目 保存先ファイル
All Scene

Output Format SDI 1/2 ○ ×
SDI 3/4 ○ ×
Monitor ○ ×
HDMI ○ ×
3G SDI 1/2/3/4 Output ○ ×

Output Display Flip Image ○ ×
Audio/Video Delay ○ ×
Monitor Magnifier Mode ○ ×
Monitor Magnifier Ratio ○ ×

VF Display VF LUT ○ ×
Overlay ○ ×
Frame Line ○ ×
VF Magnifier Mode ○ ×
VF Magnifier Ratio ○ ×
Color ○ ×
SDR Gain ○ ×

VF Function Double Speed Scan ○ ×
Peaking Frequency ○ ×
Assign<VF A> ○ ×
Assign<VF B> ○ ×
Assign<VF C> ○ ×
Zebra ○ ×
Zebra Select ○ ×
Zebra1 Level ○ ×
Zebra1 Aperture Level ○ ×
Zebra2 Level ○ ×
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項目 細目 保存先ファイル
All Scene

Overlays/Frame Line VF ○ ×
SDI 1/2 ○ ×
SDI 3/4 ○ ×
Monitor ○ ×
HDMI － －
Overlay A/B Setup ○ ×
Frame Line A/B Setup ○ ×

Frame Line Setup Color ○ ×

Center Marker ○ ×

Aspect Ratio ○ ×

Aspect Ratio Type ○ ×

Surround View Type ○ ×

Mask Level ○ ×

Safety Zone ○ ×

Aspect Safety Zone ○ ×

Frame Line on Playback ○ ×

User Frame Line 1 Select ○ ×
Preset Aspect Ratio ○ ×
Scaling ○ ×
Preset Aspect Ratio Type ○ ×
Aspect Ratio(Pixels) － －
Width ○ ×
Height ○ ×
H Position ○ ×
V Position ○ ×
Variable Aspect Type － －

項目 細目 保存先ファイル
All Scene

User Frame Line 2 Select ○ ×
Preset Aspect Ratio ○ ×
Scaling ○ ×
Preset Aspect Ratio Type － －
Aspect Ratio(Pixels) － －
Width ○ ×
Height ○ ×
H Position ○ ×
V Position ○ ×
Variable Aspect Type － －
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Audioメニュー

項目 細目 保存先ファイル
All Scene

Audio Input Internal Mic Select ○ ×
XLR Audio L Select ○ ×
XLR Audio R Select ○ ×
XLR Audio L Level ○ ×
XLR Audio R Level ○ ×
XLR Mic Reference ○ ×

Audio Monitor Monitor CH ○ ×
Monitor Level ○ ×

Audio Configuration Alarm Level ○ ×
Input Limiter Mode ○ ×
AGC Level ○ ×
AGC Mono/Stereo ○ ×
MIC Input Mono/Stereo ○ ×
Phantom Power +48V ○ ×
Monitor Output CH Pair ○ ×
Headphone Mono/ST ○ ×

Paintメニュー

項目 細目 保存先ファイル
All Scene

Black Master Black ○ ○
R Black ○ ○
B Black ○ ○

Flare Setting ○ ○
Master Flare ○ ○
R Flare ○ ○
G Flare ○ ○
B Flare ○ ○

Gamma Setting ○ ○
Gamma Category － －
Gamma Select ○ ○

Black Gamma Setting ○ ○
Range ○ ○
Master Black Gamma ○ ○

Knee Setting ○ ○
Point ○ ○
Slope ○ ○

White Clip Setting ○ ○
Level ○ ○
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項目 細目 保存先ファイル
All Scene

Detail Setting ○ ○
Level ○ ○
H/V Ratio ○ ○
Crispening ○ ○
Level Depend ○ ○
Level Depend Level ○ ○
Frequency ○ ○
Knee Aperture ○ ○
Knee Aperture Level ○ ○
Limit ○ ○
White Limit ○ ○
Black Limit ○ ○

Matrix Setting ○ ○
User Matrix ○ ○
User Matrix R‑G ○ ○
User Matrix R‑B ○ ○
User Matrix G‑R ○ ○
User Matrix G‑B ○ ○
User Matrix B‑R ○ ○
User Matrix B‑G ○ ○

Multi Matrix Setting ○ ○
Area Indication × ×
Reset － －
Axis × ×
Hue ○ ○
Saturation ○ ○

Technicalメニュー

項目 細目 保存先ファイル
All Scene

System Configuration Fan Control ○ ×
Shutter Mode ○ ○
SDI Rec Remote Trigger ○ ×
Level Gauge Adjust － －
Level Gauge Reset － －

Lens Configuration PL‑Mt Interface Position ○ ×
PL‑Mt Voltage ○ ×
Focus Distance Format ○ ×
Lens 12pin ○ ×
E‑Mount Shading Comp. ○ ×
E‑Mt Chro. Aber. Comp. ○ ×

Auto Pixel Restore Auto Pixel Restoration － －
Reset － －

Authentication User Name × ×
Password × ×

Network Setting ○ ×
LAN ○ ×
Wireless ○1) ×

Alerts & Tally Rec Light ○ ×
Rec Start/Stop Beep ○ ×
Media Near Full Alarm ○ ×
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項目 細目 保存先ファイル
All Scene

Batt./Voltage Alarm Near End:Info Battery ○ ×
End:Info Battery ○ ×
Near End:Sony Battery ○ ×
End:Sony Battery ○ ×
Near End:Other Battery ○ ×
End:Other Battery ○ ×
Detected Battery － －
DC Low Voltage1 ○ ×
DC Low Voltage2 ○ ×
DC(24V) Low Voltage1 ○ ×
DC(24V) Low Voltage2 ○ ×

Panel Control Brightness level ○ ×
Lock Operator Side ○ ×
Lock Assistant Side ○ ×

項目 細目 保存先ファイル
All Scene

False Color Level ○ ×
Red ○ ×
Red Upper Limit ○ ×
Red Lower Limit ○ ×
Yellow ○ ×
Yellow Upper Limit ○ ×
Yellow Lower Limit ○ ×
Orange ○ ×
Orange Upper Limit ○ ×
Orange Lower Limit ○ ×
Pink ○ ×
Pink Upper Limit ○ ×
Pink Lower Limit ○ ×
Light Pink ○ ×
Light Pink Upper Limit ○ ×
Light Pink Lower Limit ○ ×
Cyan ○ ×
Cyan Upper Limit ○ ×
Cyan Lower Limit ○ ×
Green ○ ×
Green Upper Limit ○ ×
Green Lower Limit ○ ×
Light Blue ○ ×
Light Blue Upper Limit ○ ×
Light Blue Lower Limit ○ ×
Blue ○ ×
Blue Upper Limit ○ ×
Blue Lower Limit ○ ×
Purple ○ ×
Purple Upper Limit ○ ×
Purple Lower Limit ○ ×
Reset － －
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項目 細目 保存先ファイル
All Scene

Test Signals Color Bars ○ ×
Color Bar Type ○ ×
1kHz Tone on Color Bars ○ ×
Test Saw ○ ×
Test Saw Type ○ ×

Special Configuration RM/RCP Paint Control ○ ×
NR(4K 17:9/16:9) ○ ○
SD HDMI ○ ×
360˚ Shutter Setting ○ ×

1) 以下の項目は保存されません。
• Scan Networks
• SSID
• Password
• WPS
• MAC Address
• Regenerate Password

Maintenanceメニュー

項目 細目 保存先ファイル
All Scene

Language Select ○ ×
Clock Set Time Zone ○ ×

Date Mode ○ ×
Date － －
Time － －

Hours Meter Hours (System) － －
Hours (Resettable) － －
Reset － －

Reset to Default Reset － －
Network Reset Reset － －
License Options Install: xxx － －

Anamorphic － －
Full‑Frame － －
Unique Device ID － －

Firmware Version － －
Firmware Update － －

[ご注意]
Technicalメニュー > Special Configuration > RM/RCP Paint Control（93ページ）がOnに設定されている場合は、
以下のリモートコントロールユニットの操作項目（119ページ）もAllファイルに保存されます。
• Black
• Flare
• Gamma 1)

• Black Gamma 1)

• Gain
1) S‑Log3のときを除く。



150 8章　付録

記録・出力メタデータ一覧
表凡例
Opt: 情報が取得できた場合のみ記述
○：記述する
―：記述しない

項目 RAW Viewerでの表記例 RAW/X‑OCN MXF RAW/X‑OCN XML ProRes MXF ProRes XML HD‑SDI
Creation Date 2021‑10‑29 11:04:05 ○ ○ ○ ○ －
Last Update 2021‑10‑30 11:04:05 － ○ ○ ○ －
UMID 060A2B340101010501010D4313000000070BF4

1D2F494EB7A16DD045A68CDF2E
○ ○ ○ ○ －

Start 03:36:29:20 ○ ○ ○ ○ －
End 03:36:32:19 ○ ○ ○ ○ －
Duration 00:00:03:00 ○ ○ ○ ○ －
Poster Frame － － － － －
Recording Mode － ○ － ○ －
Drop Frame NDF ○ ○ ○ ○ －
Camera VENICE/CineAltaV ○ ○ ○ ○ －
Video Codec X‑OCN XT ○ ○ ○ ○ －
Resolution 6048x4032 ○ ○ ○ ○ －
Aspect Ratio 3:2 ○ ○ ○ ○ －
Format FPS 23.98p ○ ○ ○ ○ －
Capture FPS 23.98p ○ ○ ○ ○ －
Pixel Aspect 1:1 － ○ － － －
Flip normal － ○ － － －
Number of Audio Channels 4 ○ ○ ○ ○ －
Audio Codec LPCM ○ ○ ○ ○ －
Audio Bit Depth 24 ○ ○ ○ ○ －
Audio Sampling Rate 48000 ○ ○ ○ ○ －
Auto Exposure Mode ManualExposureMode ○ － ○ － ○
Exposure Index 500 ○ ○ ○ ○ ○
Auto Focus Sensing Area Setting ManualFocusMode Opt － Opt － Opt
ND Filter Wheel 1/4 ○ ○ ○ ○ ○
Image Sensor Dimension Effective Width 35925um ○ － ○ － ○
Image Sensor Dimension Effective Height 23950um ○ － ○ － ○
Image Sensor Readout Mode ProgressiveFrame ○ ○ ○ ○ ○
Shutter Speed Angle 172.50deg ○ ○ ○ ○ ○
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項目 RAW Viewerでの表記例 RAW/X‑OCN MXF RAW/X‑OCN XML ProRes MXF ProRes XML HD‑SDI
Shutter Speed Time 1/50sec ○ － ○ － ○
Camera Master Gain Adjustment 0.00dB ○ － ○ － ○
ISO Sensitivity 500 ○ ○ ○ ○ ○
Electrical Extender Magnification 100% ○ － ○ － ○
Auto White Balance Mode PresetWhiteBalanceSetup ○ － ○ － ○
White Balance 5500 ○ ○ ○ ○ ○
Tint Correction 0.00000 ○ － ○ ○ ○
Camera Master Black Level 3.0% － － ○ － ○
Capture Gamma Equation scene‑linear ○ ○ ○ ○ ○
Gamma for CDL rec709 ○ ○ ○ ○ ○
Color Primaries (Capture Color Primaries) － － ○ ○ ○
Camera Attributes MPC‑36289999999Version5.00 ○ ○ ○ ○ ○
Effective Marker Aspect Ratio 6048:3202 ○ ○ ○ ○ ○
User Frame Line 1 1920×1080+0+0 ○ － ○ － ○
User Frame Line 2 1920×1080+0+0 ○ － ○ － ○
Active Area Aspect Ratio 6048:4032 ○ ○ ○ ○ ○
Pixel Aspect Ratio 1:1 ○ ○ ○ ○ ○
Image Orientation normal ○ － ○ ○ ○
Raw Black Code 512 ○ ○ － － －
Raw Gray Code 1504 ○ ○ － － －
Raw White Code 5472 ○ ○ － － －
Gamma for Look s‑log3‑cine ○ ○ ○ ○ ○
Color for Look s‑gamut3‑cine ○ ○ ○ ○ ○
Pre‑CDL Transform LUT:SL3SG3Ctos709.cube ○ ○ ○ ○ ○
Post‑CDL Transform none ○ ○ ○ ○ ○
Look Process Baked false ○ ○ ○ ○ ○
Monitoring Characteristics rec709 ○ ○ ○ ○ ○
Monitoring Base Curve rec709 ○ ○ ○ ○ ○
Monitoring Color Primaries rec709 ○ ○ ○ ○ ○
Monitoring Coding Equations rec709 ○ ○ ○ ○ ○
Monitoring Descriptions LUT:SL3SG3Ctos709.cube ○ ○ ○ ○ ○
Camera Tilt Angle 2.70000 ○ － ○ － ○
Camera Roll Angle 1.30000 ○ － ○ － ○
Focus Distance 2296mm Opt － Opt － Opt
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項目 RAW Viewerでの表記例 RAW/X‑OCN MXF RAW/X‑OCN XML ProRes MXF ProRes XML HD‑SDI
Aperture Value 3.14 Opt － Opt － Opt
Aperture Ring T Stop Position 2.8 + 3/10 Opt － Opt － Opt
Current Focal Length 0mm Opt － Opt － Opt
Hyperfocal Distance 219224mm Opt － Opt － Opt
Near Focus Distance 2273mm Opt － Opt － Opt
Far Focus Distance 2319mm Opt － Opt － Opt
Horizontal Field of View 27.9deg Opt － Opt － Opt
Entrance Pupil Position +51mm Opt － Opt － Opt
Normalised Zoom Value 0.000 Opt － Opt － Opt
Lens Serial Number xxxxxxxx Opt － Opt － Opt
Iris F‑Number 2.87 Opt － Opt － Opt
Iris T‑Number 3.1 Opt － Opt － Opt
Iris Ring Position Opt － Opt － Opt
Focus Position from Image Plane 2.296m Opt － Opt － Opt
Focus Ring Position Opt － Opt － Opt
Macro Setting OFF Opt － Opt － Opt
Lens Zoom 35mm Still Camera Equivalent 85mm Opt － Opt － Opt
Lens Zoom Actual Focal Length 85mm Opt － Opt － Opt
Zoom Ring Position Opt － Opt － Opt
Anamorphic Lens Squeeze Ratio Opt － Opt － Opt
Optical Extender Magnification 100% Opt － Opt － Opt
Lens Attributes xxxxxxxx Opt Opt Opt Opt Opt
Cooke /i technology Opt － Opt － Opt
Cooke /i2 technology Opt － Opt － Opt
Cooke /i3 technology Opt － Opt － Opt
Zeiss eXtended metadata Opt － Opt － Opt
Description － － － － －
Circle － － － － －
Project － － － － －
Director Name － － － － －
Director of Photography Name － － － － －
Production － － － － －
Camera Index － ○ － ○ －
Reel － ○ － ○ －
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項目 RAW Viewerでの表記例 RAW/X‑OCN MXF RAW/X‑OCN XML ProRes MXF ProRes XML HD‑SDI
Scene － － － － －
Cut － － － － －
Take － － － － －
Shot － ○ － ○ －
Mark In － － － － －
Mark Out － － － － －



154 8章　付録

ライセンスについて
GPL/LGPL適用ソフトウェア
の入手について

本製品はGPL/LGPL適用のソフトウェアを使用
しており、お客様には、これらのソフトウェアの
ソースコードの入手、改変、再配布の権利がある
ことをお知らせします。
これらのソースコードはインターネットのサーバー
からダウンロードすることが可能です。以下の
URLにアクセスすれば、具体的なダウンロードの
方法がわかるようになっています。
http://www.sony.net/Products/Linux/
common/search.html

なお、ソースコードの中身についてのお問い合わ
せはご遠慮ください。

ライセンスの内容に関しては、本機をネット
ワークに接続して、Webリモコン画面のOSS 
Information画面（105ページ）をご覧くださ
い。

オープンソースソフトウェアの
ライセンスについて

本製品には、弊社がその著作権者とのライセン
ス契約に基づき使用しているソフトウェアが搭載
されています。
当該ソフトウェアの著作権者の要求に基づき、弊
社はこれらの内容をお客様に通知する義務があ
ります。
ライセンスの内容に関しては、本機をネット
ワークに接続して、Webリモコン画面のOSS 
Information画面（105ページ）をご覧くださ
い。
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保証書とアフターサービス
保証書

• この製品には保証書が添付されていますので、
お買い上げの際お受け取りください。

• 所定の事項の記入および記載内容をお確かめ
のうえ、大切に保存してください。

アフターサービス

調子が悪いときはまずチェックを

この説明書をもう一度ご覧になってお調べくださ
い。

それでも具合が悪いときは

お買い上げ店、または添付の「ソニー業務用商品
相談窓口のご案内」にあるお近くのソニーのサー
ビス窓口にご相談ください。

保証期間中の修理は

保証書の記載内容に基づいて修理させていただ
きます。詳しくは保証書をご覧ください。

保証期間経過後の修理は

修理によって機能が維持できる場合、ご要望に
より有料修理させていただきます。
保証期間中の修理など、アフターサービスにつ
いてご不明な点は、お買い上げ店、またはソニー
のサービス窓口にお問い合わせください。
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主な仕様
一般仕様

質量 MPC‑3628：約4.3 kg
  MPC‑3626：約4.2 kg 

（ハンドル、VFアタッチメントを除
く）

外形寸法 158ページ参照
電源電圧 DC 12 V（11 V ～ 17 V）
  DC 24 V（22 V ～ 32 V）
消費電力 MPC‑3628： 

本体標準消費電力：約76 W（8.6K 
3:2、24 FPS、X‑OCN XT記録時、
ビューファインダーおよび周辺機器
を含まず） 
本体最大消費電力：約100 W（8.2K 
17:9、60 FPS、X‑OCN ST記録時、
40 ℃環境、32 V DC入力、ビュー
ファインダーおよび周辺機器を含ま
ず） 
最大許容入力電力：約220 W（22 V
～32 V DC入力、ビューファインダー
および周辺機器を含む）

  MPC‑3626： 
本体標準消費電力：約73 W（6K 3:2、
24 FPS、X‑OCN XT記録時、ビュー
ファインダーおよび周辺機器を含ま
ず） 
本体最大消費電力：約94 W（6K 
3:2、60 FPS、X‑OCN ST記録時、
40 ℃環境、32 V DC入力、ビュー
ファインダーおよび周辺機器を含ま
ず） 
最大許容入力電力：約220 W（22 V
～32 V DC入力、ビューファインダー
および周辺機器を含む）

動作温度 0 ℃～ 40 ℃
保存温度 －20 ℃～＋60 ℃
連続操作時間
  約35分（BP‑GL95B使用時）

記録フォーマット（ビデオ）
 X‑OCN XT
 X‑OCN ST
 X‑OCN LT
 ProRes 4444 4K
 ProRes 4444 QFHD
 ProRes 422 HQ 4K
 ProRes 422 HQ QFHD
記録フォーマット（オーディオ）
 LPCM 8CH（記録再生2CH）、24‑bit、48 kHz
記録プロジェクトフレームレート
 X‑OCN XT/ST/LT（MPC‑3628）：
  8.6K 3:2
   29.97P/25P/24P/23.98P
  8.2K 17:9/5.8K 17:9
   59.94P/50P/47.95P/29.97P/ 

25P/24P/23.98P
  7.6K 16:9/5.4K 16:9
   59.94P/50P/29.97P/25P/24P/ 

23.98P
  5.8K 6:5
   47.95P/29.97P/25P/24P/23.98P
 X‑OCN XT/ST/LT（MPC‑3626）：
  6K 3:2/6K 1.85:1/6K 17:9/6K 

2.39:1/4K 6:5/4K 4:3/4K 
17:9/4K 2.39:1

   59.94P/50P/47.95P/29.97P/ 
25P/24P/23.98P

  5.7K 16:9/3.8K 16:9
   59.94P/50P/29.97P/25P/24P/ 

23.98P
  4K 4:3 Surround/4K 17:9 

Surround/3.8K 16:9 Surround
   29.97P/25P/24P/23.98P
 ProRes 4444
  4K:4096×2160
   59.94P/50P/29.97P/25P/24P/ 

23.98P
  QFHD:3840×2160
   59.94P/50P/29.97P/25P/24P/ 

23.98P

 ProRes 422 HQ
  4K:4096×2160
   59.94P/50P/29.97P/25P/24P/ 

23.98P
  QFHD:3840×2160
   59.94P/50P/29.97P/25P/24P/ 

23.98P
記録・再生時間
  138ページ参照

カメラ部

撮像素子 35mmFull Size相当単板CMOSイメー
ジセンサー

画素数 MPC‑3628：50.0M（total）
  MPC‑3626：24.8M（total）
内蔵フィルター

NDフィルター A
Clear 0.3 

(1/2)
0.6 

(1/4)
NDフィル
ター B

Clear Clear 0.3  
(1/2)

0.6 
(1/4)

0.9 
(1/8)

0.9 
(1/8)

1.2 
(1/16)

1.5 
(1/32)

1.8 
(1/64)

1.8 
(1/64)

2.1 
(1/128)

2.4 
(1/256)

ISO感度 MPC‑3628：
   ISO 800
   ISO 3200
  MPC‑3626：
   ISO 500
   ISO 2500

レンズマウント
  PLマウント（レンズマウントアダプター使

用）
  Eマウント（レンズマウントアダプター未

使用時）
フランジバック
  PLマウント：52 mm
  Eマウント：18 mm
ラチチュード
  MPC‑3628：16 stop
  MPC‑3626：15+ stop

入出力

オーディオ入力
  CH‑1/CH‑2：XLR型5ピン（1）、凹

型、LINE / AES/EBU / MIC / 
MIC+48V切り換え可能

DC入力 XLR型、4ピン（1）、凸、11 V ～ 17 Vま
たは22 V ～ 32 V DC

DC出力（12 V）
  Lemo 2ピン（1）、11 V ～ 17 V DC 

（出力電圧：入力電圧と同じ、出力
最大電流：1.0 A）、22 V ～ 32 V 
DC（出力電圧：16.8 V、出力最大電
流：1.0 A）、バッテリーアダプター
使用時

[ご注意]
12V OUT端子には、消費電流が1.0 A以下の機器を接続し
てください。

DC出力（24 V）
  Fischer 3ピン（2）、11 V ～ 17 V DC（出

力電圧：24 V、出力最大電流： 
1.0 A）、22 V ～ 32 V DC（出力電圧：
入力電圧と同じ、出力最大電流： 
2.0 A）
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[ご注意]
24V OUT端子には、11 V ～ 17 V入力時は消費電流が1.0 A
以下の機器を、22 V ～ 32 V入力時は消費電流が2.0 A以
下の機器を接続してください。

SDI出力 BNC型（4）
  3G‑SDI：SMPTE ST424/425  

Level B‑DL/DS
  HD SDI：SMPTE ST292 準拠
AUX BNC型（1）
ビューファインダー出力
  LEMO 26ピン（1）
ネットワーク
  RJ45型（1）
リモートコントロール
  8ピン（1）
MONITOR出力
  BNC型（1）
  HD SDI：SMPTE ST292 準拠
タイムコード入力
  TC IN：BNC型（1）
GENLOCK入力
  BNC型（1）
HDMI出力
  Type A型（1）
外部機器接続端子
  USB host：Type A（1）
ヘッドホン出力
  ステレオミニジャック（1）
スピーカー出力
  モノラル

メディアスロット部

タイプ AXS‑A card（2）
  SD card（1）

付属品

VFアタッチメント（1）
ハンドル（1）
VFケーブル（1）(A‑2203‑745‑A)
シム（円弧型）（1）(4‑730‑328‑11)
シム（1/3円弧型）（15）(4‑730‑328‑21)
Eマウントレンズキャップ（1）
PLマウントレンズキャップ（1）
6Kイメージャーブロック用カバー（1）(A‑5040‑

737‑A)（MPC‑3628のみ）
ご使用になる前に（1）

関連アクセサリー

0.7型ビューファインダー
  DVF‑EL200、DVF‑L700
カメラエクステンションシステム
  CBK‑3610XS
ワイヤレスLANアダプター
  CBK‑WA02
リモートコントロールユニット
  RM‑B170/B750
  RCP‑1000/1500/1530/3500
  RCP‑1001/1501/3100/3501
カードリーダー
  AXS‑AR3
ショルダーアダプター（VシューでVCT‑14に装着する

アダプター）
  VCT‑FSA5
Eマウントレンズ

SELP28135G、SEL1224GM、
SEL1635GM、SEL2470GM、
SEL70200GM、SEL100400GM、
SEL24F14GM、SEL35F14GM、
SEL50F12GM、SEL85F14GM、
SEL100F28GM

バッテリーパック
  BP‑GL95B
マイク ECM‑680S、ECM‑678*、ECM‑674*

* XLR 3ピン→5ピン変換ケーブル
EC‑0.5X3F5Mが必要

2連バッテリーアダプター
  BKW‑L200（バッテリー接続アダプター

を介して接続）
SDI/HDMIモニター
  BVMシリーズ、PVMシリーズ、LMDシ

リーズ

仕様および外観は、改良のため予告なく変更す
ることがありますが、ご了承ください。
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外形寸法
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商標について

• HDMI、High‑Definition Multimedia 
Interface、およびHDMIロゴ は、米国お
よびその他の国におけるHDMI Licensing 
Administrator, Inc.の商標または、登録商標
です。

• その他、本書で登場するシステム名、製品名は、
一般に各開発メーカーの登録商標あるいは商
標です。なお、本文中で®、™マークは明記し
ておりません。


